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 The three-dimensional workspace
3D Documents

TriSpectives lets you work in a three-dimensional space to create realistic, complex images. 
Build 3D models using the same skills you use to manipulate objects in the physical 
world¾stack objects on top of one another, turn them, and drag them into place. 
For example, suppose you want to build a simple architectural model of a column. In 
TriSpectives, it’s like working with a set of building blocks. You start by selecting the basic 
geometric shape from a TriSpectives catalog of IntelliShapes:

IntelliShape 
Then, using the mouse, you drag a second shape from a catalog and drop it on the first one.

Model with two shapes
It’s easy to change the form of an IntelliShape with a few mouse clicks. For example, you can
narrow and flatten the cylinder on top of the polygon to make it look like it belongs on a 
column.



Polygon with reshaped cylinder
Add other IntelliShapes to complete the column:

Model column
Once you have all the pieces in place, you can add finishing touches to your model. To make 
a realistic looking column, you can smooth the edges and add a marble texture. Here are the
stately results:



Finished column
By combining the basic geometric solids, holes, and other IntelliShapes, you can create 
complex and sophisticated models.
The advantage of working in a 3D workspace is that you can position one object 
independently of the others in 3D space. If you add lighting effects, for example, the objects 
cast shadows on each other. Working with models on the 3D page is just like positioning real 
objects on a tabletop.



 TriSpectives and the outside world
You can use the models you create with TriSpectives in reports, spreadsheets, Email 
messages, and many other kinds of documents. It’s especially easy to share a model with 
another program that supports OLE (Object Linking and Embedding) 2.0.
For example, you might want to illustrate a product specification sheet with a model of the 
product. If your word processor supports OLE 2.0, create the specification sheet as a 
document in your word processor. Then drag the model from TriSpectives and drop it into the
word processing document.
You can also incorporate graphic images from other software in TriSpectives documents. 
TriSpectives can read files from popular CAD (Computer Assisted Design) programs, drawing 
packages, and many other applications.
See also:
3D Studio Import dialog box
AutoCAD DXF Read dialog box 
AutoCAD DXF Write dialog box 
Export 2D Geometry dialog box 
Export Animation dialog box 
Export AVI dialog box 
Export dialog 
Export Image dialog box 
Export JPEG dialog box 
Export Model dialog box 
Exported Image Size dialog box 
Insert Model dialog box 
Raw Triangle Read dialog box 
Stereolithography Read dialog box 
VRML Import 
Wavefront OBJ Import 



 The main window
The main window includes the following features:
· 3D document: Like your word processor, TriSpectives creates documents. A typical 

TriSpectives document may include a 3D model. A document can also include text, 2D 
drawings, and other elements.
There are two kinds of 3D documents: scenes, where you build models; and pages, a 
display area where you create finished illustrations. You can share TriSpectives 
documents with other people in your workgroup.
You can also incorporate 3D documents in reports, spreadsheets, Email messages, and 
other kinds of documents. You can share a TriSpectives document with any other 
program that supports OLE (Object Linking and Embedding) 2.0.

· Catalogs: Collections of resources such as shapes, models, and surface finishes. See 
Using catalogs for more information.

· Tabs: To see a document or catalog, choose its tab.
· Toolbars: Toolbars contain buttons which provide shortcuts to the features in 

TriSpectives. See Toolbars for more information.



 Catalogs
A catalog is a collection of resources, such as shapes, models, colors, and textures, that you 
can use in your 3D projects.
Using catalogs 
The TriSpectives Catalogs 
How to create and edit catalogs 



Using catalogs                

 
Use the items in the catalogs to create your 3D projects.
To build a model, for example, select shapes from the Shapes catalog. Then add other 
shapes to create the basic form. Add textures and colors from other catalogs, for example, 
to refine your model. 
You can create custom catalogs to store the shapes and models you want to reuse across a 
number of projects. You can also create catalog sets to store combinations of catalogs for 
convenience.



The TriSpectives Catalogs
TriSpectives has many catalogs. Here are some of the most common ones:
· Showcase catalog: Look in this catalog for completed models that show off what you 

can do with TriSpectives.
· Shapes catalog: This catalog contains IntelliShapes, 3D solids such as a cube and 

sphere. Combine shapes to build models. See Shapes for more information.
· Animation: This contains motion effects. Drag one from the catalog and drop it on your 

model. Then use the Timeline tools to make your model move. The Animation catalog 
contains basic effects like spinning and flying into the scene. You can create your own 
animation effects using the SmartMotion Editor. See Animation for more information.

· Backdrops catalog: Use these entries to add background images to your scenes or 
pages.

· Collage catalog: This catalog contains sample models for you to build on.
· Colors catalog: Use these entries to color the surfaces of your shapes and models.
· Decals catalog: These items are like stickers—they only cover part of a model’s surface.

Use decals for corporate logos, flags, and other images.
· Dims catalog: Use these entries to adjust the dimensions of your shapes and models.
· Extrudes catalog: This catalog contains 3D shapes, such as I Beam, Crescent, and 

Hollow Pipe, that have been extruded from 2D cross-sections.
· Surfaces catalog: Use these entries to make surfaces look like clear glass, orange 

plastic, or other materials.
· Text catalog: Use these entries to add text to your images.
TriSpectives also includes specialty catalogs, such as Architecture, which contains 
architectural models, and Masonry, which contains a variety of masonry textures.



 WorkBooks
A WorkBook is your portfolio for a particular project. Use it to store collections of 3D models, 
2D drawings, and other graphics you create with TriSpectives.
How to create a WorkBook 
How to open a WorkBook 
How to save a WorkBook 



 How to create a WorkBook
You can create a WorkBook when you start TriSpectives, or at any other time.
1. When you start TriSpectives, you may see the Welcome dialog box. Choose the Create a 

New WorkBook option and then choose OK.
You can also choose New from the File menu to create a WorkBook.

2. Select the type of document you want to work with:
· 3D Page: A flat background where you can draw 2D graphics or place 3D models. 

Use the page to create illustrations that combine models, text, and other elements.
· 3D Scene: A view into 3D space where you can build models.

3. If you want to select a set of catalogs to use with the new WorkBook, choose the Next 
button, and then select a set of catalogs.

4. Choose Finish.
5. On the page or scene, create the image you want. See Creating a scene or 3D page for 

an overview.
6. From the File menu, choose Save As. Choose the folder in which you want to save this 

WorkBook, then enter a file name and choose the Save button.



 How to open a WorkBook      

1. When you start TriSpectives, you may see the Welcome dialog box. Choose the Open an 
existing WorkBook option, and then choose OK.
You can also choose Open from the File menu to open a WorkBook.

2. Choose the folder which contains the WorkBook you want. (WorkBooks have the 
extension .tsb.) Highlight the WorkBook and select the Open button, or double-click it. 
You can also type the name in the file name box and then select the Open button.



 How to save a WorkBook
Save your work periodically and when you’re finished with your current TriSpectives session.
· From the File menu, choose Save to save your WorkBook with its current name and 

location. Choose Save As to save it with a different name or location.
Saving a WorkBook saves the graphics on every page and scene. WorkBook files have 
the extension .tsb.



 3D documents
In TriSpectives, you work with two types of 3D documents: scenes and 3D pages. Work in a 
scene to build and edit models, or to construct scenes or worlds that you walk around in. 
Work in a 3D page to create an illustration or diagram that combines 3D models, 2D shapes, 
images, and other elements. 
For example, to create a travel poster, create a model of a train in a scene, then work in a 
page to place it against a background and add appropriate text by dragging and dropping.
A WorkBook may contain a number of 3D documents. You can customize the name, color or 
texture, rendering style, and other properties by using the Page Properties sheet or the 
Scene Properties sheet. (To see these property sheets, right-click the scene, page, or 
document tab, and then choose Page Properties, Scene Properties, or Properties from the 
pop-up menu.)

See also:
How to name your documents
Creating a scene or page 
Scenes on the page 



 How to name your documents
TriSpectives automatically assigns names such as Doc-1 and Doc-2 to the pages and scenes 
in your WorkBook. You can change these names to use more descriptive ones.
To name a document in a WorkBook:
1. Right-click the Doc tab whose name you want to change.
2. From the pop-up menu, choose Rename.
3. Type a name for the document, and then choose OK.



Creating a scene or 3D page       
Scenes and 3D pages are the two basic types of documents you can create in TriSpectives. 

Scenes
A scene is like a window into a 3D world. Use scenes to build and edit models. While you’re 
working in a scene, you can move your point of view around to see the model from different 
angles. Scenes are also good for assembling several models into an environment you can 
walk around in, like a simulated living room or kitchen.

3D pages
A 3D page is like a piece of paper on which you can combine 3D models, text, 2D drawings, 
and other elements to create an illustration, diagram, or presentation. While you’re working 
in a page, your viewpoint is fixed—a model rests on the 3D page as it would on a piece of 
paper.
See also: Scenes on the page 



Scenes on the page
You can place scenes on a page to create embedded images. Combine these scenes with 
models and other 3D elements to create a collage. You can also stack these scenes in layers.
For example, if you have a scene of a chess piece, place it on top of a scene of a chessboard
to create your final effect of a chess set. 
Double-click an embedded scene to edit its contents in a new document.



 Shapes
Shapes are the basic building blocks of your 3D models. Combine shapes to create models.
How to create a shape 
How to edit a shape 
How to copy a shape 
How to use text shapes 
How to create custom shapes from 2D cross-sections 
Shape sections
Pointers and highlight colors



 How to create a shape
To create a shape:
Drag the shape you want from a catalog to your scene. You can work with the following kinds
of shapes:
· 3D solids from the Shapes catalog, including a cube, sphere, cylinder, slot, etc.
· Holes from the Shapes catalog, such as H Block and H Slot, which allow you to remove 

material from your model.
· Custom shape tools from the 3D Shapes toolbar, such as Extrude and Loft, which allow

you to create any 3D shape you need. To create a custom shape, create a 2D cross-
section using a custom shape tool, then extend it into three dimensions. For more 
information on custom shapes and 2D cross-sections, see How to create custom shapes 
from 2D cross-sections.

· A text shape from the Text catalog, which allows you to include 3D text in your model. 
You can change the color, texture, lighting, and other properties of text as you can any 
other shape. See How to use text shapes for more information.



 How to edit a shape
Modify a shape by using its handles.
To edit a 3D shape:
1. From the Selection toolbar, choose the Edit IntelliShapes tool.
2. Click the shape to select it and see its handles.
3. Drag a handle to change the size or form of the shape. Use the red push-pin handle to 

push and pull the surface to make the shape bigger or smaller. The pointer changes to a 
grabbing hand when you use the red handles.

See also: Editing models, shapes, and surfaces 



 How to copy a shape
Many models contain two or more identical or very similar shapes. Once you create a single 
shape, you can make as many copies as you need.
To copy a shape:
1. If the Selection toolbar is active, click it to make it inactive.
2. Click the shape you want to copy.
3. Right-drag the shape. As you drag, you see an outline of the original shape follow the 

mouse pointer. 
4. Drop the outline in the position where you want to place a copy. You see a pop-up menu 

of relocation options. 
5. Choose Copy Here from the pop-up menu. 
TriSpectives creates a copy of the original shape at the point where you released the mouse.



 How to use text shapes
Text shapes behave like any other 3D shapes: you can move them in space, and apply 
effects such as color, texture, and lighting to them.

To create a text shape: 
1. If the Selection toolbar is active, click it to make it inactive.
2. Select the Text catalog.
3. Drag a text item, such as Text1, from the Text catalog and drop it in the 3D scene. You 

see generic 3D text in an editing window.
4. Type to replace the generic text with the text you want, then click in the scene.
5. To change the appearance of the text, such as its font or font size, select the text. Then 

use a tool on the Text toolbar, such as the Bold or Center text button.
6. Click in the scene.

To edit a text shape: 
Use the following techniques to edit a text shape.
· Change the size of the text box by dragging the handles of the text shape.
· Check the position of the anchor to see where the text joins other shapes.
· To change the font size or alignment of the text, use the Text toolbar.
· Use the Camera tools, especially TriBall, to rotate the text shape.
See also: How to use a text box 



 How to use a text box
TriSpectives has a built-in word processor that lets you add titles and other copy to an 
illustration on the 3D page. Once you edit and format your text, you can check its accuracy 
using the TriSpectives spelling checker.
To add text to a page:
1. From the Insert menu, choose Text Box. The pointer changes to a crosshair.
2. Define the outline of the text box. Click and drag from one corner of the text box to the 

opposing corner. When you release the mouse button, TriSpectives displays an edit box 
with a cursor and sample text.

3. Enter the text you want to display on the page.
4. Click on the page outside the text box.



 How to create custom shapes from 2D cross-sections
To create a custom shape, start by drawing one or more 2D cross-sections. Extend the cross-
sections into the third dimension to create a 3D shape. Using the tools on the 3D Shapes 
toolbar, you can create four kinds of custom shapes: extrude, spin, sweep, and loft.
Extrude shape tool 
Spin shape tool 
Sweep shape tool 
Loft shape tool 

Once you create a custom shape, you can modify its cross-sections:
1. Select the custom shape as an IntelliShape.
2. Right-click it, and then choose Edit Cross-Section or Edit Path from the pop-up menu. If 

you’re working with a loft shape, you can also choose Show Cross-Sections.



Shape sections
Shape sections are the 2D cross-sections that determine the form of every IntelliShape. 
When you create a shape through extrusion or sweeping, for example, you use the 2D 
drawing tools to create a cross-section.
A 3D shape contains at least two cross-sections: 
· Start section: The initial cross-section defined when creating an IntelliShape using a 

shape creation wizard, such as the Extrude Shape wizard. When you use a shape from 
the TriSpectives Shapes catalog, the start section of the shape is also the landing face on
which the anchor is positioned.

· End section: The end cross-section is at the opposite end of the shape after the shape 
has been extended into the third dimension.

Finding the start section
To find the start section, select the shape and look for the position of the anchor. If you have 
moved the anchor, you can still find the start section. Right-click the shape and choose Edit 
Cross-Section from its pop-up menu. TriSpectives highlights the start section.

Open and closed ends
You only need to know the difference between the start and end sections when one end 
must be open or closed. For example, with a cardboard box, you probably want the closed 
end to be the one that contains the anchor.
For symmetrical shelling¾where both sections are either open or closed¾the difference 
between the start and end sections doesn’t matter. In cases where you want one open and 
the other closed, the choice may be arbitrary.



 Models
A model is a collection of shapes, a 3D representation of a real or imaginary subject.

Working with models 
How to work with groups of models
How to select models 
How to select parts of a model 
Viewing models with the camera 
Moving shapes in a model 
Editing models, shapes, and surfaces 
Shapes, models, and collages 
Positioning models and shapes 
How to add color and texture 
Creating a collage with models and scenes 
Lighting effects 
Pointers and highlight colors
Modeling exceptions



Working with models       
A model is a 3D representation of a real or imaginary subject, such as a chess piece or 
pencil. Assemble models by combining IntelliShapes. 
TriSpectives can work with three kinds of models:
· IntelliShape models. This kind of model is a collection of IntelliShapes. For example, 

you could build a model table by combining a slab shape with four cylinders. You can 
modify the size, texture, and other characteristics of each IntelliShape in a model.

· Facet models. These models have a single component. When you change the color, 
size, or other attributes of a facet model, your changes affect the whole object. Facet 
models usually come from another program such as a CAD package.

· Facet representations of IntelliShape models. These are IntelliShape models in a 
simpler, one-piece form. TriSpectives usually displays an IntelliShape model in facet form
when you first drop it in a scene or page. You can leave the model in this form if you 
don’t need to edit the individual shapes. If you want access to the component shapes, 
you need to regenerate the model. When you select a shape, TriSpectives prompts you 
for permission before regenerating.

To learn the basics of building models in TriSpectives, see Chapter 3 of the TriSpectives User 
Guide.

See also: SmartRendering



 How to work with groups of models
Grouping models can help organize a complicated scene. Groups can also save you time—
you can position several models as a unit. For example, you can place a desk, chair, and 
lamp in a single group. Move the group to another spot in an office scene with a single drag. 
You can also apply styles like color or texture to an entire group at once.
Groups can also contain other groups so you can organize your scene into a hierarchy. For 
example, organize several desk groups into an office group. Group the office groups into an 
entire office floor.
To combine models into a group:
1. Select a model.
2. Hold down the Shift key and select other models you want in the group.
3. From the 3D Shapes toolbar, choose the Group tool.
When models are grouped together but not selected, the first mouse click selects the group, 
and the next mouse click selects the model.
To ungroup models:
1. Select the group.
2. From the 3D Shapes toolbar, choose the Ungroup tool.
To open a group for editing:
1. Select the group.
2. Click a model in the group. You can now position, delete, or edit the models within the 

group.



 How to select models
When you first drag a model from a catalog and drop it in a scene, its outlines are 
highlighted and it may be enclosed in a sizebox with red handles. The outlines and sizebox 
mean the model is selected. 

To clear a selection:
1. From the 3D Shapes toolbar, choose the Selection tool.
2. Click anywhere outside of the model, or choose Deselect All from the Edit menu.

To select a model:
1. Make sure the Edit IntelliShapes and Edit Surfaces tools on the Selection toolbar are 

inactive. If either button is depressed, click it.
2. If any object in the 3D scene is highlighted, clear the selection.
3. Click the model.

Once you select a model, you can do the following with it:
· Drag it to a new location.
· Change its size, color, or other properties.
· Rotate it or change its elevation if it’s on a page.
· View it with the camera if it’s in a scene.

See also: How to select parts of a model



 How to select parts of a model
You can edit a model at several levels: the top level is the model itself; below that are the 
shapes that combine to form the model; and the lowest level is the surfaces of the model. 
You can use the mouse to move among levels while you’re working. Every time you click the 
model, you move down one level.
When it’s more convenient to work at one level only, use the Selection tools to limit editing 
to shapes or surfaces only. 
When you’ve grouped models together, the first mouse click selects the group, and the next 
selects the model. See How to work with groups of models.

To select different levels of a model:
1. Make sure nothing is selected in the scene and the Selection tools are inactive.
2. Click once to select a model. The model is outlined in cyan.

Click again to select a shape. (Don’t make the second click too quickly or it’s interpreted 
as a double-click.) The shape is highlighted, showing its sizebox and handles. After the 
second click, clicking somewhere else on the model selects a different shape.
Click a third time on the same place to select a surface, edge, or vertex highlighted in 
green. After the third click, clicking somewhere else on the model selects a different 
surface, edge, or vertex.

To limit selection to shapes only:
1. Choose the Edit IntelliShapes tool from the Selection toolbar.
2. Click any IntelliShape model to select a component shape.

To limit selection to surfaces, edges, and vertices only:
1. Choose the Edit Surfaces tool from the Selection toolbar.
2. Click any model to select an individual surface. If you click close to an edge, you select 

the edge instead of the surface. Click close to a vertex (where two or more edges meet) 
to select the vertex.



Viewing models with the camera
When you’re working in a 3D scene, use the camera to examine a model from any angle or 
distance. Use the Camera tools to manipulate the camera.
The camera changes only your viewpoint, not the position of the model.
See also: Split screen views



Moving shapes in a model
A model is built of one or more component shapes. You can change the structure of a model 
by dragging the individual shapes to new positions with the mouse. For more precise 
positioning, SmartSnap gives you navigation hints as you drag one shape over another.

To move shapes in a model:
1. Select the shape you want to move—click once on the model, then again on the shape. 

See How to select parts of a model for help with selecting shapes.
2. Drag the shape. To use SmartSnap, press the Shift key while dragging. Look for the 

SmartSnap indicators, like the green dot that appears when you drag near the center of 
a surface, or the green line that appears when you drag near an edge.

3. Release the mouse button where you want the shape to appear, then release the Shift 
key.

See also:
Positioning methods 
Using SmartSnap 
Using SmartDimensions 
Annotation dimensions 
SmartRendering 



Using SmartSnap       
TriSpectives can provide visual feedback about your current location. For example, when you
line up one shape with the edge of another, TriSpectives highlights the edge with a green 
line. 
This technique is called SmartSnap. The following instructions show how to use SmartSnap 
to find the correct location for a shape.
SmartSnap works only with regenerated models.
For an example of working with SmartSnap, see “SmartSnap” in Chapter 3 of the Getting 
Started Guide.
See also: 
Using SmartDimensions 



Using SmartDimensions       
If you’re using TriSpectives Professional, you can use SmartDimensions to position your 
shapes and models.
SmartSnap is helpful when you need to know if two shapes are lined up at an edge, center 
point, or other location. Sometimes, however, you need to choose a position based on 
precise measurements. For example, you might want to place one shape exactly 4.5 inches 
from the edge of another shape.
For precise positioning, use SmartDimensions. These tools help you set the distance or 
angular relationship between the parts of your model.



Annotation dimensions       
An annotation dimension is a line that shows the distance between two locations on your 
model. You can use annotation dimensions for reference during the model-building process 
and then delete them when you create the final image for output.
In most cases, however, annotation dimensions remain as a design element in the final 
output. They appear most often in technical illustrations. These drawings provide detailed 
information about an object including its proportions. 
TriSpectives has three kinds of annotation dimensions:
· Linear. This tool measures the distance between any two points in the display.
· Radial. This tool measures the radius of a curve.
· Angular. This tool measures the angle between a point and the plane defined by one 

surface of a model.
These three tools appear in the Dims catalog.



SmartRendering
Rendering is a term from computer graphics that refers to the process of displaying a 3D 
image on a flat screen. During the rendering process, TriSpectives determines how to display
the shapes, textures, and other elements in your model in the most convincing, realistic way.
The process can take a lot of time and processor power. In particular, when you drag or 
rotate a model, the display may take a moment to catch up with the mouse. The lag 
becomes more noticeable with complex models and slow processors.
To keep your work moving as quickly as possible, TriSpectives uses SmartRendering. This 
technique determines the appropriate rendering style as you work.
For example, suppose you’re working with a complex model with a lot of shapes and 
textures. When the model is stationary, you can see all its details. However, if you move or 
rotate the model, TriSpectives may revert to a simpler form of rendering. It can turn off 
textures, shading, and other features to keep the display moving.
To enable SmartRendering:
1. Right-click in the scene or page, or select Scene or Page from the Format menu to see 

the pop-up menu.
2. Choose Scene Properties or Page Properties on the menu.
3. Select the Rendering Tab.
4. Check the Allow Simplification box. 
You can also choose rendering styles manually. See The Scene Properties sheet or The Page 
Properties sheet for more information.



Editing models, shapes, and surfaces
A model is an object, such as a chess piece or table—an independent unit in everyday life. 
You can break down most models geometrically into simpler building blocks called shapes. 
For example, you can make a table by joining a flat rectangle to the top of four cylinders. 
At a more detailed level, you can edit the individual surfaces of a model. For example, you 
can give the top surface of a table a more polished finish than the surfaces under the table.
You can edit all parts of a model:
· The model as a whole
· A single shape in a model
· A surface of a model



Shapes, models, and collages
By the time you’re ready to make a collage, your shapes and models should be finished. Edit
them first in the 3D scene. When you add items and move them, you’re editing a collage.
If you need to edit an item in a collage (to change its shape or texture, for example), you 
work in a scene. Then construct the complete collage on a page.
See also:
Creating a collage with models and scenes 



Positioning models and shapes
TriSpectives provides visual clues to position shapes, and methods for precisely measuring 
the position of models and shapes.
Positioning methods 
Measuring position 



Positioning methods
· SmartSnap: TriSpectives provides visual clues about where to position your shapes. For 

example, if you want to drop a slot in the center of a circle, SmartSnap displays a green 
dot when you're pointing to the center of the circle.

 
· SmartDimension: A measuring line that extends between two points, edges, or planes 

on a model. You can place the ends of the line anywhere you like. If you’re using 
TriSpectives Professional, you can use SmartDimensions to position your shapes and 
models.

 
Use Smart Dimensions to measure or set the distance between two IntelliShapes, or to 
measure angular relationships.
· TriBall: Use the TriBall tool to precisely position shapes.

 



Measuring position
Though you can position most models and shapes visually, you probably occasionally need 
to place a model or shape at an exact location. For example, you may need to locate a light 
fixture six feet above the floor, at a point on a wall eight feet from the corner of a room. To 
do so, you can measure the position of shapes and models.
Measuring the position of a model:
TriSpectives measures the position of a model from the center of the scene. It measures 
distances along three directions: the length (L), width (W), and height (H) of the scene. This 
is like placing an object in a room by measuring the distance along two walls and the height 
above the floor.
Measuring the position of a shape within a model:
Each model in a scene is made up of individual shapes. (See Editing models, shapes, and 
surfaces.) TriSpectives measures the position of the shapes in a model from the corner of the
model’s sizebox.
Measuring the position of a model within a group:
When you group models together, TriSpectives measures the model’s position from the 
corner of the group’s sizebox. See How to work with groups of models for more information.
Using the anchor point:
To measure the location of an extended object like a chair or lamp, TriSpectives needs a 
particular point of reference on the object. For example, to locate a lamp, you could measure
from the corner of the room to the center of the base of the lamp. TriSpectives uses the 
anchor point as this point of reference.

See also:
Positioning methods 



 How to add color and texture
To apply a color or texture to a model, shape, or surface:
1. Select the model, shape, or surface. Use the buttons on the Selection toolbar or click 

once for a model, twice for a shape, or three times for a surface.
2. Drag a color from the Colors catalog, or a texture from any catalog containing textures, 

and drop it on the selected item.
See also:
How to change the scale of a texture 

Style Properties sheet



 Creating a collage with models and scenes      
 

A collage is a collection of 3D and 2D elements, such as models, text, and background 
textures. You can create a collage by adding models, text, and other elements to a page. 
Many collages contain both models and scenes. You can also embed scenes or even other 
pages in a page. 
Use models when you want to position objects independently of each other. Because models
cast shadows, use them especially when you want to work with lighting effects. Layered 
scenes, on the other hand, are easier to position. You can also edit the contents of a scene 
without leaving the page. 



Lighting effects       
Choose the number of light sources you want illuminating your model, as well as their color 
and intensity. You can also adjust the way your model reflects light.
See also: How to cast shadows



Pointers and highlight colors
TriSpectives uses a number of visual cues to inform you about the status of a document and 
its content. For instance, when you drag an object from a catalog, the shape of the mouse 
pointer shows what the results will be when you drop the object. 

Pointers
Model pointer. The object you drop becomes a separate model. If you’re working with 
colors or textures, the item you drop covers an entire model. This pointer appears by default
when you drop the initial object in a blank scene. You can work with models by deactivating 
the Edit IntelliShapes and Edit Surfaces tools on the Selection Toolbar.
IntelliShape pointer. The object you drop joins with the object you drop it on to form a 
model. If you drop the object by itself, however, you get an IntelliShape with a sizebox and 
handles. This pointer appears if the current selection in the scene is an IntelliShape. It also 
appears when the Edit IntelliShapes tool is active.
Surface pointer. The object you drop becomes a separate model. For textures and colors, 
the item you drop covers one surface of a model without affecting the others. This pointer 
appears if the current selection in the scene is a surface or when the Edit Surfaces tool is 
active.

Highlight colors
When you select a model, shape, or other object, TriSpectives highlights it with a colored 
outline. By default, TriSpectives uses different colors for different kinds of objects.
IntelliShapes. When you select an IntelliShape, TriSpectives highlights it in yellow and 
shows a sizebox with red handles that let you change the dimensions of the shape. 
IntelliShape models. When you select a model with IntelliShape components, TriSpectives 
highlights it in cyan (blue). You also see the model’s anchor and two orientation lines. Note 
that many IntelliShape models first appear in facet form.
Facet models. When you select a facet model, TriSpectives highlights it in white. You also 
see a sizebox with handles.
Facet representations of IntelliShape models. When you select this kind of model, 
TriSpectives highlights it in white. Unlike a true facet model, this kind doesn’t have a sizebox.
Surfaces, edges, and vertices. When you select one of these items, TriSpectives 
highlights it in green.



Modeling exceptions
Many of these modeling exceptions apply to shelling and beveling. See Shell tab and Bevel 
tab for more information.

Shelling Loft IntelliShapes
Depending on the form and position of the cross-sections of the loft, you may not always be 
able to shell an IntelliShape created through lofting. 

Blending Spin IntelliShapes
For spin IntelliShapes whose cross-sections are touching the axis of rotation, blending end 
section edges also blends the start section edges in the same way and vice versa. The shape
properties sheet may not reflect both as blended, but TriSpectives does perform the 
expanded bevel. If both end section edges and start section edges have a blend, then 
TriSpectives blends using the largest of the two radius values. See Shape sections for more 
information on start and end sections.

Shelling order
A model you create through shelling depends on the order in which you drop one shape on 
another and shell. For example, let’s say you drop a cube on the surface of a pie-shape, and 
shell the pie-shape so that the cube is left floating in space. If you cruise the cube on the 
shelled surface of the pie-shape, the cube may disappear when it’s in the shelled hollow 
space of the pie-shape. If this happens, follow the steps below:
1. Select the cube and resize it using its sizebox handles so that it appears as a solid 

outside of the pie-shape. 
2. Right-click the cube and choose Apply Last from the pop-up menu. The cube now 

appears inside the pie-shape’s hollow space.
3. If you like, you can resize the cube back to its original size.



 Animation
Once you build a model, you can make it move using the animation features in TriSpectives. 
For example, you might create a model car with a hood that pops open.
SmartMotions. For simple animation like spinning and bouncing, use these pre-defined 
effects.
The SmartMotion Editor. For more complex animation, use this tool. It works like a multi-
track tape recorder in a recording studio.
The Group Segment. Within the SmartMotion Editor, the animated sequence for each 
model is grouped with one or more motion segments to create a Group Segment.
The Timeline Toolbar. When you’ve created an animated sequence, use the Timeline tools 
to play it.



 How to use SmartMotions
SmartMotions are the easiest way to animate a model. 
To create animation with SmartMotions:
1. Drag a SmartMotion icon from the Animation catalog and drop it on a model in the 3D 

scene.
2. Choose the On tool on the Timeline toolbar.
3. Choose the Play tool on the Timeline toolbar.
TriSpectives plays the animated sequence from beginning to end.
In step 1, you can drop the SmartMotion on the blank area of the 3D scene. The result is that
TriSpectives animates all models in the scene. They all perform the same motion.
The SmartMotions in the Animation catalog include LengthSpin, WidthSpin, HeightSpin, 
LengthMove, WidthMove, HeightMove, FlyForward, FlyBack, FlyIn, and Bounce. LengthSpin, 
for example, rotates about the length axis. LengthMove, however, moves along the length 
axis direction. To predict how these animation effects work, you should understand what the 
directions Length, Width, and Height mean for a scene and a model.

Determining the directions of SmartMotions for an entire scene
If you have dropped the SmartMotion on the scene background to animate all the models in 
the scene, then the Length, Height, and Width directions are determined by the L, W, and H 
directions of the scene grid. 
To see the directions on the scene grid:
1. Right-click the scene background.
2. From the pop-up menu, choose Scene Properties.
3. Choose the Show tab.
4. Check the Scene grid box.
5. Choose OK to return to the scene.

The scene grid appears, with axes labeled for L, W, and H.

Determining the directions of SmartMotions for a model
If you have dropped the SmartMotion onto a model, then the Length, Height, and Width 
directions are determined by the forward, sideways, and up directions of the anchor point of 
the model. 
To see the anchor point directions:
· Select the model by clicking it while in Model mode.

The anchor point appears as a red ball with two yellow lines. The short line is in the 
forward direction and the long line is in the up direction. The sideways line is 
perpendicular to these.

Tochange the directions of animation motion for a model:
1. Right-click the model’s anchor point.
2. From the pop-up menu, choose Spin Anchor to rotate the anchor point about the up axis 

at a specified angle.
3. Choose Flip Anchor to rotate the anchor point about the forward axis by a specified 



angle.
The directions of animation of the model change to follow the new orientation of the 
anchor point of the model.

Creating compound or more elaborate animations
You can combine two or more SmartMotions for compound animation. For example, you 
could drop the Grow and WidthSpin items on a model to make it get bigger as it spins.

To make more precise or elaborate animations, use the SmartMotion Editor and use Group 
Segments.



 How to use the SmartMotion Editor
Use the SmartMotion Editor to create sophisticated, multi-layered animation. It lets you 
combine and coordinate individual animated sequences to produce lifelike movement.
· From the View menu, choose SmartMotion Editor.
The SmartMotion Editor window includes these features:
Ruler. This tool measures the number of frames in the animated sequence.
To change the number of frames per second, right-click in the SmartMotion Editor window 
and choose Properties from the pop-up menu. Then change the number in the Frame Rate 
(per sec) field.
Slider. When you play an animated sequence, this marker moves from left to right, 
indicating the frame since the start. You can also drag it to move to a particular point in the 
animation to see the positioning of objects.
Group segment. This rectangle represents an animated sequence. Each Group Segment 
consists of a model segment and one or more motion segments.



 How to use the Group Segment
A Group Segment is a rectangle appearing in the SmartMotion Editor. Each Group Segment 
represents an animated sequence consisting of a model segment and one or more motion 
segments.
To use the Group Segment:
1. To adjust the duration of an animated sequence, drag one end of the Group Segment. 

For example, you can extend the animated sequence to 30 frames by dragging the right 
edge of the Group Segment and dropping it under the 30 on the ruler.

2. To change the starting time of an animated sequence, drag the Group Segment until its 
left end is under the appropriate mark on the ruler. 

To see the contents of a Group Segment: 
· Double-click the Group Segment to expand it. 

You can also right-click the Group Segment to see its pop-up menu, and then choose 
Expand.

You can position and size the individual motion segments just as you can with the Group 
segment as a whole. For example, suppose you want the Grow motion segment to begin 
immediately after the Spin motion segment. The Spin motion segment starts at the 
beginning of the animated sequence and goes for 20 frames. Drag the Grow motion 
segment to the right and drop it when its left edge is under the 20 mark on the ruler. 
The expanded view also gives you access to property sheets for every item in the track. The 
Segment Properties sheet is especially powerful. It has many parameters to control time and
movement.
To add new segments to a track, drag them from the Animation catalog and drop them on an
expanded track. To save a track for other animations, drag it from the editor to a catalog.



 Menu commands
Toolbars Pop-up menus 

File menu 
Edit menu 
View menu 
Insert menu 
Format menu 
Tools menu 
Shape menu 
Catalogs menu 
Window menu 
Help menu 



 File menu
Choose: To do this:
New Use the WorkBook Wizard to create a WorkBook.
Open Use the Open dialog box to open an existing WorkBook.
Close Close an open WorkBook. If you’ve made changes in the WorkBook, you

have a chance to save your changes before closing.
Save Save the current WorkBook with the same file name.
Save As Use the Save As dialog box to save a new WorkBook or to save the 

current WorkBook with a different file name.
Save All Save all open WorkBooks using their current file names.
Print Preview Display the WorkBook pages as they would appear printed.
Print Use the Print dialog box to print the WorkBook and select printer 

settings.
Export Animation Use the Export Animation dialog box to export animation to a file.
Export Image Use the Export Image File dialog box to export image files for use in 

another application. 
Export Model Use the Export Model File dialog box to export a model to a file.
Export 2D Use the Export 2D Geometry dialog box to export 2D geometry to a 

file.
Send Use the Choose Profile dialog box to send the current document to 

another user on a network.
Exit Exit TriSpectives. If you’re using an unsaved WorkBook, you can save it 

before exiting.



 Edit menu
Choose: To do this:
Undo Reverse your last editing task.
Redo Reverse the effects of the Undo command.
Cut Delete a selected object from a document and place it on the 

Clipboard.
Copy Copy a selected object from a document to the Clipboard.
Paste Paste an object from the Clipboard to your document.
Clear Delete selected information.
Select All Select all the objects on the page or scene.
Deselect All Deselect all the selected objects on the page or scene.
Shape Edit Mode Edit all models, IntelliShapes, or only surfaces, edges, and vertices.
Object Insert and embed an object, such as a chart or equation, in your 

WorkBook.



 View menu
Choose: To do this:
Toolbars Use the Toolbars dialog box to show or hide toolbars and change their 

attributes.
Status Bar Show or hide the status bar.
Ruler Show or hide the rulers at the top and side of the 3D page.
SmartMotion Editor Show or hide the SmartMotion Editor when you’re working with 

animation.
Catalog Browser Show or hide the catalogs.
WorkBook Browser Show or hide a list of the contents of the current WorkBooks.
Camera Select a camera option: Orbit, Pan, Zoom, Window Zoom, Fit Scene, 

Look At, Dolly, Walk, Target. See the Camera tools in the Toolbars for 
complete descriptions of these tools.

Page Zoom Use the Zoom dialog box to make the page appear closer or farther 
away.



 Insert menu
Choose: To do this:
Page Use the Insert Page dialog box to add a new page to your WorkBook.
Scene Use the Insert Scene dialog box to add a new scene to your WorkBook.
Model from File Use the Insert Model File dialog box to insert a model file in your 

document.
IntelliShape Create a custom shape, which you make from a 2D cross-section using 

Extrude, Spin, Sweep, or Loft tools.
Attachment Point Define a target point on a shape or model where you can attach other 

objects.
Light Insert a new light source to the scene.
Object Use the Insert Object dialog box to insert a linked object, such as a 

chart or graph, from another application.
Text Box Insert a text box to include 2D text on a scene or page. Use text boxes 

for callouts, ad copy, trademarks, and other text that accompanies 
your graphics.



 Format menu
Choose: To do this:
Page Use the Page Properties sheet to edit the properties of a page.
Scene Use the Scene Properties sheet to edit the properties of a scene.
Shape Use the IntelliShape Properties sheet to change the properties of the 

selected shape. If you select a model, you can change the model 
properties.

Style Use the Style Properties sheet to change the style settings of the 
selected object.



 Tools menu
Choose: To do this:
TriBall Use the TriBall tool to rotate or position the selected shape.
Move From-To Use this tool to position a shape by aligning it with another shape. You 

can use up to three pairs of selections to drag the shape and then 
rotate it.

Move In-Out Use this tool to raise or lower objects relative to the 3D page. 
Move Texture Use this Mapping tool to select a new location for the center of a 

surface texture.
Move Bumps Use this Mapping tool to select a new location for the center of a 

surface bump.
Move Decal Use this Mapping tool to select a new location for the center of a 

surface decal.
Shape Analysis Use the Analysis Properties sheet to compute the volume, mass, and 

other physical shape properties.
Options Set options on the Options dialog box, including those for models, 

directories, and 2D drawings.



Mapping Tools
You can use a texture mapping dialog box, such as the Box Projection dialog box, on the 
Surface Style Properties sheet to precisely size and position textures on a model. To quickly 
and roughly position textures, bumps, and decals, use the Move Texture, Move Bump, or 
Move Decal tool. The Move Decal tool is particularly useful for orienting and positioning a 
decal correctly. 
You can use these three tools in model or surface mode.
To use a mapping tool:
1. Select a model or surface with the surface image you want to move.
2. Select the appropriate tool from the Tools menu. For example, to move a decal, select 

the Move Decal tool. 
When you’re in model mode, you can only work with surface images attached to the 
model. For example, if the model does not have a bump texture, the Move Bumps tool is 
grayed out.

3. When you see an arrow with a checkerboard cursor, move it over the model to highlight 
the selected faces. Click the point where you want to move the image. (To speed up 
rendering, turn off image simplification on the Rendering tab in the Scene Properties 
sheet.)
If you’re in surfaces mode, you move the surface image you originally selected. If you 
click other faces in the same model, TriSpectives uses information from these faces for 
positioning the image on the original face—it does not select the faces for editing.

4. To turn the tool off, select another tool, or clear the tool selection on the Tools menu.



 Shape menu
Choose: To do this:
Group Group together two or more selected shapes or models. Use groups 

when you want to manipulate more than one shape or model as a unit. 
Ungroup Ungroup selected shapes. When you choose this tool, the shapes or 

models in a group regain their status as individual objects.
Bring to Front Bring the selected scene to the front of a stack of layered scenes.
Bring Forward Bring the selected scene one layer toward the front of a stack of 

layered scenes.
Send to Back Send the selected scene to the back of a stack of layered scenes.
Send Backwards Send the selected scene one layer to the back of a stack of layered 

scenes.
Bevel Edges Use the Bevel dialog box to blend or chamfer selected edges.
Move Anchor Change the location of the anchor, the point where an IntelliShape 

joins other IntelliShapes.
Reset Sizebox Reset the sizebox to be the bounding box of the group or model.
Regenerate model Assemble a model from its component IntelliShapes and display all 

underlying IntelliShapes.
Set operation Define whether the selected IntelliShape adds or subtracts material 

when dropped from the catalog onto a model.



 Catalogs menu
Choose: To do this:
New Create a new catalog and add it as the last catalog tab.
Open Use the Open dialog box to open a catalog file.
Close Close the current catalog.
Close All Close all the catalogs.
Save Save changes to the current catalog using the same file name and 

location.
Save As Use the Save As dialog box to save a new catalog or to save changes 

to the current catalog and change the file name or location.
Save All Save all the catalogs.
Catalog Sets Use the Catalog Sets dialog box to organize and edit catalog sets.



 Window menu
Choose: To do this:
New Window Create a new window that views the same WorkBook.
Cascade Arrange windows so they overlap.
Tile Arrange windows side by side.
Arrange Icons Arrange the icons of closed windows.



 Help menu
Choose: To do this:
TriSpectives Help Open the TriSpectives online help system.
Tutorials Start the TriSpectives online tutorials.
Office Compatible Display information about Microsoft Office Compatibility.
About TriSpectives See copyright and version information.



 Pop-up menus
Menu commands 

Most objects in the TriSpectives window have a pop-up menu. Right-click an object to see its 
menu.
2D Drawing Grid pop-up menu 
2D Shape pop-up menu
2D Shape editing pop-up menu
Anchor pop-up menu
Annotation dimension pop-up menu
Attachment point pop-up menu
Catalog pop-up menu 
Document tab pop-up menu 
Edge pop-up menu 
Embedded page pop-up menu 
IntelliShape pop-up menu 
Light pop-up menu 
Loft section pop-up menu 
Loft shape pop-up menu 
Model pop-up menu 
Page pop-up menu 
Right-drag pop-up menu 
Scene pop-up menu 
SmartDimensions pop-up menu 
Surface pop-up menu 
Value pop-up menu 
WorkBook Browser item pop-up menu



 2D Drawing Grid pop-up menu
When you’re working with a 2D cross-section for creating a 3D shape, right-click the 2D 
drawing grid, one of its lines, or another object on the grid to see this pop-up menu.
· Edit Curve. Displays a dialog box for the selected 2D item. Select an item on the grid 

and then choose this option to see the Line, Circle, Circular Arc, Ellipse, or Bezier dialog 
box. Each dialog box has unique options for customizing the appropriate item. 

· Split. Divides the selected 2D item. For instance, if you select a line and then choose 
this option, the result is two lines with a new control point at the cursor point.

· Delete. Deletes the selected 2D item.
· Select Outline. Selects every line, arc, and other 2D object connected to the indicated 

item.
· Snap to. Displays options to help you position the mouse pointer as you drag. You can 

snap to the grid, geometry, angle, or distance when drawing.
· Show drawing feedback. Displays angle and distance measurements as you draw.
· Angle-distance mode. Like the Angle-Distance Drag Mode tool, this option switches 

between the rectilinear and the angle-distance drawing mode. 
· Offset mode. Displays measurement feedback when you drag the endpoints of a line or 

curve.
· Use Outline for Construction Only. Indicates that part of a 2D drawing does not 

extend into 3D. For example, if you draw a symmetry line for use with the Mirror tool, you
don’t want it to be part of the final 3D shape. Mark it for construction only by selecting it 
and then choosing this option.

· Finish Shape. Completes the process of extending a 2D cross-section into a 3D shape 
through extrusion, spinning, sweeping, or lofting.

· Cancel. Calls off the 2D drawing process. The grid disappears and you return to the 
scene or page.

· Grid Settings. Displays the Grid Settings dialog box. You can change the spacing of the 
grid lines or turn the grid off altogether.

· Cross-Section Properties. Displays the Cross-Section Properties sheet. Use this tool to 
modify the anchor, sizebox, and other properties of the 2D cross-section.



 2D Shape pop-up menu
You can use the 2D drawing tools directly on the scene or page to create a 2D IntelliShape. 
To see the pop-up menu for a 2D shape, select it and then right-click it.
· Add SmartDimensions. Attaches a SmartDimension to the 2D shape. TriSpectives 

displays the Add SmartDimensions dialog box. For Professional version users only.
· Delete. Removes the 2D shape from the scene or page.
· 2D Shape Properties. Displays the 2D Shape Properties sheet. Use these options to 

control the anchor, sizebox, position, and other characteristics of the shape.
· Style Properties. Displays the Style Properties sheet. Use these options to control the 

appearance of the shape.



 2D Shape Editing pop-up menu
To see this menu, select a 2D IntelliShape on the scene or page. Click it again and then right-
click it to see its pop-up menu.
· Edit Curve. Displays a dialog box for the selected 2D item. Select an item on the grid 

and then choose this option to see the Line, Circle, Circular Arc, Ellipse, or Bezier dialog 
box. Each dialog box has unique options for customizing the appropriate item. 

· Split. Divides the 2D shape in half. For instance, if you use this option with a line, the 
result is two lines with a new control point in the middle.

· Delete. Removes the shape from the scene or page. 
· Snap to. Displays a sub-menu with options to help you position the mouse pointer as 

you drag. TriSpectives can automatically “snap” the mouse pointer to the grid, 2D lines or
other geometry, distance imcrements, and angle increments.

· Show drawing feedback. Displays angle and distance measurements as you draw.
· Angle-distance mode. Like the Angle-Distance Drag Mode tool, this option switches 

between the rectilinear and the angle-distance drawing mode. 
· Offset mode. Displays measurement feedback when you drag the endpoints of an 

existing line or curve.
· Select Outline. Selects every line, arc, and other 2D object connected to the current 

one.
· Use Outline for Construction Only. Indicates that the 2D shape is for reference or 

construction of other objects only. TriSpectives does not fill the shape with a solid color.
· 2D Shape Properties. Displays the 2D Shape Properties sheet. Use this tool to modify 

the anchor, sizebox, and other properties of the 2D IntelliShape.
· Style Properties. Displays the Style Properties sheet. Use these options to control the 

appearance of the shape.



 Anchor pop-up menu
To move or reorient an anchor point of an IntelliShape, model, or object, right-click the 
anchor’s red dot to see this pop-up menu.
· Move Anchor. Select this option to reposition the anchor. Enter distances you want to 

move the anchor in the forward, sideways, and up directions on the Move Anchor dialog 
box.

· Spin Anchor. Choose this option to rotate the anchor about its up axis. Enter a new 
value in the Angle field on the Spin Anchor dialog box.

· Flip Anchor. Choose this option to rotate the anchor about its forward axis. Enter a new 
angle in the Angle field on the Flip Anchor dialog box. 



 Annotation Dimension pop-up menu
An annotation dimension is a tool for measuring the distance or angle between two locations
in the display. Although you can use annotation dimensions during the model-building 
process, they typically appear as part of the final image in a technical illustration. 
When you use an annotation dimension for display purposes, it’s important to orient it 
correctly. The dimension needs to appear parallel to the viewing plane. If necessary, use the 
Look At tool to view a surface or other feature of the model straight on. After you attach the 
annotation dimension, choose Horizontal or Vertical from its pop-up menu. Use the axis 
that’s parallel to the feature you’re measuring and the viewing plane.
· Horizontal Distance. Choose this option to display a horizontal dimension and measure

the distance between two points on a horizontal line.
· Vertical Distance. Select this option to display a vertical dimension and measure the 

distance between two points on a vertical line.
· Delete. Use this option to remove the dimension from the display.
· Annotation Dimension Properties. Choose this option to see the Annotation 

Properties sheet.



 Attachment point pop-up menu
To move or tilt an attachment point, right-click it to see this pop-up menu.
· Move attachment point. Moves the object. Enter new coordinates on the Move 

Attachment Points dialog box.
· Spin attachment point. Tilts the object. Enter a new value in the Angle field on the 

Spin Attachment points dialog box.
· Flip attachment point. Flips the object. Enter a new value in the Angle field on the Flip 

attachment point dialog box.
· Delete. Removes the attachment point.



 Catalog pop-up menu
To see the catalog pop-up menu, right-click the catalog browser. You can click an icon within 
the browser or the blank area surrounding the icons.
· Large Icons. Displays the items in the catalog as large icons.
· Small Icons. Displays the items in the catalog as small icons.
· List. Lists the items in the catalog in columns.
· Change Icon. Selects a new icon for an item in the catalog. This option is only available 

if you right-click a catalog entry.
· Object. Inserts data from another program as an entry in the current catalog. 

TriSpectives creates the new entry through Object Linking and Embedding (OLE). Select 
an object on the Insert Object dialog box.

· Cut. Deletes the selected entry from the catalog and places it on the Clipboard. Right-
click a catalog entry to see this option.

· Copy. Copies the selected entry from the catalog and places it on the Clipboard. Right-
click a catalog entry to see this option.

· Paste. Pastes the selected entry from the Clipboard to the catalog.
· Delete. Removes the selected entry from the catalog. This option is only available if you 

right-click a catalog entry.



 Document tab pop-up menu
To see the Document pop-up menu, right-click the document’s tab.
· Rename. Lets you change the name on the document’s tab. Enter a new name on the 

Rename dialog box.
· Delete. Removes the current document from your WorkBook.
· Properties. Displays the Scene Properties or Page Properties sheet, depending on the 

contents of the document.



 Edge pop-up menu
To see the Edge pop-up menu, right-click the edge or vertex of an IntelliShape while in Edit 
Surfaces and Edges mode.
This pop-up menu has a single option, Bevel Edges. This option displays the Bevel dialog 
box which lets you round off an edge or vertex.



 Embedded page pop-up menu
Right-click in an embedded page to see its pop-up menu.
· Edit. Displays the full page in a new window. This is the same as double-clicking the 

embedded page.
· Delete. Removes the embedded page from the surrounding scene.
· Embedded Page Properties. Displays the Embedded Page Properties sheet.
· Style Properties. Displays the Style Properties sheet.



 IntelliShape pop-up menu
Right-click an IntelliShape while in Edit IntelliShape mode to see its pop-up menu.
· Edit Cross-section. Displays the 2D cross-section that created the IntelliShape. Use the 

drawing tools to modify the cross-section.
· Add SmartDimensions. Displays the Add SmartDimensions dialog box. Use these tools 

to measure and set distances and angles. 
· Apply Last. Makes the shape the last one applied to its model.
· Delete. Removes the selected shape.
· IntelliShape Properties. Displays the IntelliShape Properties sheet. Use these 

properties to modify the shape through shelling, capping, and other operations.



 Light pop-up menu
Right-click a light source to see its pop-up menu.
· Light On. Switches the light on or off. A check by this option indicates that the light is 

on.
· Cast Shadows. Controls whether or not the light casts shadows on the objects in a 

scene or page. A check by this option indicates that the light produces shadows.
· Delete. Removes the light source.
· Light Properties. Displays the Spot Light Properties sheet. or the Directional Light 

Properties sheet. Use these properties to adjust the color of the light, the softness of its 
shadows, and other settings.



 Loft section pop-up menu
Once you create a custom shape through lofting, you can edit the individual cross-sections 
within the shape. To work with sections, choose Show Cross-sections from the pop-up menu 
for the loft shape itself. Then right-click the button for the section you want to work with.
· Edit On Grid. Displays the 2D cross-section on the drawing grid. Use the 2D drawing 

tools to modify the section and change the form of the resulting 3D shape.
· Insert New. Adds one or more cross-sections to the loft shape. Use the Insert Cross-

sections dialog box to specify the number of new sections and their position.
· Delete. Removes the selected cross-section from the loft shape.
· Cross-section Properties. Displays the Cross-section Properties sheet. 



 Loft shape pop-up menu
After the lofting process produces a custom 3D shape, you often need to modify the results. 
Use the shape’s pop-up menu to edit its cross-sections and other features.
· Show Cross-sections. Reveals the individual 2D sections that created the loft shape. 

Each section has a numbered button. Click the button to see handles that let you modify 
the section. Right-click the button to see the section’s pop-up menu.

· Edit Path. Displays the lofting path on the 2D drawing grid. This is the path that 
connects the cross-sections in the loft shape. Use the 2D drawing tools or drag the curve 
handles to modify the path.

· Edit Match Points. You see the numbered cross-sections. When you select a number, a 
vertex replaces the number. Drag and drop the vertex to a new vertex location on the 
cross-section. Cross-sections must have the same number of curves before you can use 
this option.

· Add SmartDimensions. Displays the Add SmartDimensions dialog box. Use these tools 
to measure and set distances and angles. 

· Apply Last. Make the shape the last one applied to its model.
· Delete. Removes the selected shape.
· IntelliShape Properties. Displays the IntelliShape Properties sheet. Use these 

properties to modify the shape through shelling, capping, and other operations.



 Model pop-up menu
Right-click a model to see its pop-up menu.
· Add SmartDimensions. Displays the Add SmartDimensions dialog box. Use these tools 

to measure and set distances and angles. For Professional version users only.
· Delete. Removes the selected model from the scene or page.
· Analysis. Displays the Analysis property sheet. Use this tool to perform analytical 

measurements including volume, moments of inertia, and others.
· Statistics. Displays information about the internal structure of the model, including the 

number of vertices, faces, and edges.
· Model Properties. Displays the Model Properties sheet, which lets you change the 

model’s sizebox, anchor, and other settings.
· Style Properties. Displays the Style Properties sheet, which lets you change the 

model’s color, transparency, and other settings.



 Page pop-up menu
Right-click the 3D page to see its pop-up menu.
The page menu has one option: Page Properties, which displays the property sheet for the
page. Use these properties to change the size, background, and other features of the page.



 Right-drag pop-up menu
When you drag a shape or model using the right mouse button, this menu appears when you
drop the object. Choose one of the following options for relocating the object.
· Move Here. Move the object from its original location to the point where you dropped it. 

This option produces the same result as dragging with the left mouse button.
· Copy Here. Places a copy of the object where you released the mouse. The original 

object returns to its starting position.
· Link Here. Duplicates the object and links the copy to the original. When you change 

one linked object, you affect both.
· Cancel. Returns to the scene or page leaving no effects from the right-dragging process.



 Scene pop-up menu
Right-click the 3D scene to see its pop-up menu.
· Horizontal Split. Creates two viewing panels separated by a horizontal splitter bar. The 

bar appears where you right-clicked to see the pop-up menu. Use multiple views to see a
model from two or more viewpoints simultaneously.

· Vertical Split. Creates two viewing panels separated by a vertical splitter bar.
· Remove View. Deletes a view created by one of the previous two options. Right-click in 

the view you want to delete and then choose this option.
· Scene Properties. Displays the Scene Properties sheet. Use these properties to change 

the scene’s lighting, background, and other settings.



 SmartDimension pop-up menu
If you’re using TriSpectives Professional, you can use SmartDimensions to position your 
shapes and models. Right-click the value or endpoint of a SmartDimension to see its pop-up 
menu.
· Edit This SmartDimension. Displays the Edit SmartDimension dialog box. You can 

enter a new distance or angle value for the SmartDimension and lock it in place.
· Edit All SmartDimensions. Displays a table that shows the angle or distance values for

all SmartDimensions of the selected shape. This table makes it easy to edit multiple 
values at once.

· Delete SmartDimension. Removes the SmartDimension from the shape.



 Surface pop-up menu
To see the pop-up menu for one surface of an IntelliShape, select the surface and then right-
click it.
· Bevel Edges. Displays the Bevel dialog box which lets you round off the edges of the 

surface.
· Surface Properties. Displays the Surface Style Properties sheet . Use these properties 

to modify the color, bumpiness, transparency, and other features of the surface.



 Value pop-up menu
When you position an object using the TriBall, you see a line or arc that indicates the current 
distance or angle of rotation. The indicator contains a value that changes as you drag. Right-
click this value to edit it.
The value menu has a single option: Edit Value. When you choose this option, you can 
enter a new angle or distance measurement.



 WorkBook Browser Item pop-up menu
This pop-up menu appears when you right-click an item in the hierarchical display of the 
WorkBook Browser. The options on the menu depend on the item you click. For instance, the 
Apply Last option is available if you click a shape, but not if you click a document.
· Select. Makes a shape, model, or other item the current selection. For example, you can 

select a shape by right-clicking its entry in the WorkBook Browser and choosing this 
option. When you return to the scene or page, the shape is highlighted.

· Apply Last. Recreates an IntelliShape as if it were the last one added to a model. 
· Delete. Removes an item from the WorkBook Browser and the display.
· Properties. Shows the appropriate property sheet. For instance, you can display the 

property sheet for a 3D scene by right-clicking its entry in the WorkBook Browser and 
choosing this option.



 Toolbars
The Toolbars dialog lets you choose one or more toolbars to display as you work. Click a 
button on a toolbar to see a description of the tool and how to use it.

 

Standard

2D Drawing

3D Shapes

Camera

Text Tools

Timeline

Selection
You can also check boxes on the Toolbars dialog to show color buttons, large buttons, and 
Tooltips.



 2D Drawing tools
The 2D Drawing tools let you draw lines, circles, and curves, then work with your 2D 
drawings. Click a button to see a description of the tool.



 3D Shapes tools
The 3D Shapes tools let you work with 3D shapes. Use them to create custom 3D shapes 
from 2D graphics. Once you create a 2D image, extend it into the third dimension by 
extruding or lofting, for example. Other tools let you select and manipulate objects.
Click a button to see a description of the tool.



 Camera tools
The Camera tools change the camera’s position and view, not the objects. Use the TriBall 
and other 3D Shape tools to position objects in a scene.
The camera is how you view the world. It has an eye position, a focus point it looks at, a field
of view angle, and an up direction. Edit these properties using the Camera tab on the Scene 
Properties sheet. It’s easier, however, to use the Camera tools to position the view.
Click a button to see a description of the tool.



 Text tools
Use the Text tools to choose a font, font size, and attributes for text. Click a button to see a 
description of the tool.



 Timeline tools
Use the Timeline tools to control the movement of an animated model. Click a button to see 
a description of the tool.



 Selection tools
When you build a model in TriSpectives, you can work with:
· The model as a whole
· Individual shapes within a model
· The surfaces and edges of a shape
Use the Selection tools to select an appropriate level of a model for editing. Click a button to
see a description of the tool.



General tab
Choose the General tab to enter the page name.



Page size and grid tab
Choose this tab to:
· Select the page size, such as 8.5 x 11 inches.
· Turn the grid on and off and set the spacing between grid lines.
· Determine the overall scaling for models and drawings placed on the page.
The 3D page corresponds to the physical piece of paper that comes from your printer. You 
can adjust the page dimensions and place a 2D grid on the page to help position models and
other objects. Then you can also adjust the scale factor that determines how large 2D and 
3D models will appear on the page.
Standard size. Choose from a list of standard page sizes.
Custom size. Choose this option to define a page of any size defined by its width, height, 
and units.
· Width. Enter the horizontal length of the page.
· Height. Enter the vertical length of the page.
· Units. Choose the units you want to use to measure the page, such as centimeters or 

inches.
Modeling scale. Use this field to control the size of 2D shapes and 3D models on the page. 
To change the scale, enter the number of units you want to fit into one unit on the page. For 
example, enter 10 to make shapes and models appear at 1/10 life size. Enter the units you 
want to use on the Units tab.
Show grid. Check this box to display a 2D grid on top of the page.
Horizontal grid spacing. Enter the distance between lines measured in model units along 
the horizontal direction of the page. Since this distance is in model units, the actual 
separation of the grid lines depends on the model scale setting.
Vertical grid spacing. Enter the distance between lines measured in model units along the
vertical direction of the page. Since this distance is in model units, the actual separation of 
the grid lines depends on the model scale setting.



Rendering tab
Wireframe. Choose this option to display the models on the page as wireframe drawings. A 
wireframe is a hollow form with a grid of lines for the surface. Wireframes have no surface 
covering, color, or texture.
Facet shading. Choose this option to display the models as solid objects composed of flat 
surfaces called facets. TriSpectives adds depth to the model by shading the facets¾making a
series of them successively lighter or darker. 
Smooth shading. Select this button to display the models as solid objects with smooth, 
evenly shaded surfaces. Depending on your objective, the effect of smooth shading can be 
much more realistic than facet shading.
Show textures. Check this box if you want surface textures to appear on the models. This 
option only applies to models that have textures, and only when the smooth shading option 
is active.
Realistic shading. Choose this option to display models using more convincing shading 
methods. In particular, surface bumps and true reflections can appear, and highlights and 
spotlights are shown more accurately. When you choose realistic shading, the next three 
options become available.
Shadows. Choose this button if you want the objects on the page to cast shadows when 
light lands on them.
Ray Tracing. Choose this option if you want high-quality rendering that displays reflections 
and refracted light. See also Surface Style Properties sheet, Finish tab, and Transparency tab.
Antialiasing. Choose this option if you want high-quality rendering with smooth edges.
Draw edges. If you want TriSpectives to display colored lines along the edges of a model, 
select this option.
Allow simplification. Choose this option to let TriSpectives select the appropriate drawing 
style for the objects on the page. When you move a model or use the camera tools, 
TriSpectives can turn off some details to keep the display moving quickly. For example, when
you drag a complex model, TriSpectives may temporarily display it as a wireframe drawing. 

 



Show tab
Check the items you want to show on the page: lights, annotation dimensions, attachment 
points. If you’re working in a scene, you can also show the scene grid and scene grid 
dimensions.



General tab
Select the General tab to enter the scene name.



Rendering tab
· Select the style of rendering you want to use: Wireframe, Facet shading, Smooth 

shading, or Show textures.
· If you want to use realistic shading, select that option, then choose the kind of shading 

you want to use: Shadows, Ray Tracing, or Antialiasing.
· If you want to draw model edges, check the Draw edges box.
· If you want to speed up rendering by allowing simplification, check the Allow 

Simplification box.



Show tab
Check the items you want to show in the page: lights, annotation dimensions, attachment 
points. If you’re working in a scene, you can also show the scene grid, and scene grid 
dimensions.



Scene grid
TriSpectives can display a reference grid to help you position objects in the 3D scene.
To display the scene grid:
1. Right click in the scene to see its pop-up menu.
2. Choose Scene Properties from the pop-up menu.
3. Choose the Show tab on the property sheet.
4. Select the Scene Grid option. Then choose OK on the property sheet.

The scene grid includes the letters H, W, and L¾for Height, Width, and Length¾on the 
three axes that originate from the center of the grid.
In some cases, you can position an object just by orienting it along the lines of the grid. 
In other cases, it helps to see precise measurements. 

5. To measure distances on the grid, choose the Scene Grid Dimensions option on the 
Scene Properties sheet. 
The measuring lines show the current distance between the object and the center of the 
grid. Each line measures the distance along one of the dimensions in the coordinate 
system.



Camera tab
The TriSpectives camera represents your eye as you view the 3D scene. You can adjust the 
position of the camera, the angle of its lens, and other features.

Projection options
The Projection options control the appearance of depth.
Perspective. Check this box to display the objects in perspective.
Field of view angle. Enter the viewing angle of the camera lens. For example, 30 degrees 
gives a convincing 3D effect.

Position properties
The Position properties control the physical location of the camera. Enter the location of the 
camera on the length, width, and height axes.

Look at point options
The Look at point options control the orientation of the camera. Enter the location of the 
Look at point on the length, width, and height axes.

Up direction properties
The Up direction properties tell which way is up. Enter a non-zero value for the axis you want
to point up. Enter zero in the other fields.



General tab
Show Welcome dialog on startup. Check this setting if you want to see the Welcome 
dialog box when you launch TriSpectives. The Welcome dialog asks whether you want to 
open an existing WorkBook or create a new one.
Show Edit Cross-Section dialog for extrude, spin, and sweep shapes. If you want this
dialog box to be available when you create one of the above shapes, check this box. If you 
choose to work without this dialog box, you can perform all its functions using the pop-up 
menu for the cross-section.
Mouse pick aperture. Enter the width of the mouse selection area in pixels. Within this 
range the cursor snaps to vertices, center points, etc.
Dimension precision. Enter the number of decimal places you require for on-screen 
measurements. TriSpectives uses this precision for measurements with the TriBall, 
SmartDimensions, the scene grid, and other parts of the display.
Copy image data to WorkBook file on save. Check this option to have TriSpectives save 
texture maps with the WorkBook.



Models tab
IntelliShape Model drop result 
TriSpectives can initially display an IntelliShape model in a simplified form composed of 
facets. These one-piece objects appear faster than full IntelliShape models. To work with the 
individual IntelliShapes, however, you must regenerate the model by selecting a shape 
within it.
Drop as facet model in scene. Select this option if you want IntelliShape models dropped 
in scenes to be facet models. (Don’t select this option if you want models to appear in full 
IntelliShape form.)
Drop as facet model on 3D page. Select this option if you want IntelliShape models 
dropped in 3D pages to be facet models. (Don’t select this option if you want models to 
appear in full IntelliShape form.)

Additional data to save with model 
These options determine the kind of information TriSpectives stores when you save a model. 
If you clear both options, TriSpectives stores only the necessary instructions for recreating a 
model. The resulting file is small, but the process of creating the model takes longer than 
the other two storage options.
Approximate surface description. Choose this option if you want TriSpectives to store a 
simplified version of an IntelliShape model. This one-piece facet model appears faster than 
the full IntelliShape version. To work with the individual IntelliShapes in the model, 
regenerate it first. 
If you try to select an individual IntelliShape in the model to modify the model geometry, 
TriSpectives asks if you want to regenerate the model. Regenerating returns the full 
IntelliShape version.
Exact surface description. Choose this option if you want to store the complete 
IntelliShape model. When you display the model again, you don’t need to regenerate it. 
However, the process of displaying it takes longer than the previous option.

Model regeneration 
Automatic. Select this option if you want TriSpectives to regenerate the model every time 
you change it. For example, when this option is active, TriSpectives immediately regenerates
the model when you drag one of its sizing handles.
Wait until model deselected. Choose this option if you want TriSpectives to regenerate a 
model when you’re done working with it. Click outside the model to see it change. This 
option is useful if you want to make a series of changes without regenerating the model 
after each change.
Load modeling engine on start up. Choose this option if you want TriSpectives to load its
modeling engine when the program starts. If you don’t need to work with IntelliShape 
models, you can clear this option to make the program start faster.
Draw model edges. Select this option if you want to draw models in new pages and scenes
with colored lines along their edges. This option does not affect existing pages or scenes. To 
change the edge color of existing models, use the Color tab on the Options dialog box.



Directories tab
Working Directory. If you want TriSpectives to use a particular directory as a default 
location, enter it in this field. Unless you specify otherwise, TriSpectives uses this directory to
store and retrieve WorkBooks and other files.
Image File Directories. TriSpectives searches the directories in this list for textures and 
other image files. 
Add. If you want to add an entry to the list of image file directories, choose this button. 
TriSpectives displays the Add Directory dialog box.
Remove. If you want to remove an entry from the list of image file directories, select it and 
choose this option.
Move Up. Choose this button to move the selected entry up one level in the list of 
directories. Since TriSpectives searches the directories in the order they appear in the list, 
this option changes the search order.
Move Down. Choose this button to move the selected entry down one level in the list of 
directories. Like the Move Up button, this option influences the search order.



2D Drawing tab
These options control a number of features for working in 2D including the drawing process 
itself and the appearance of the 2D display. Use 2D drawing to create the cross-sections that
define 3D shapes such as Extrude or Spin shapes, and standalone 2D shapes such as circles 
and polygons.

Default 2D grid resolution
These properties specify the horizontal and vertical increments of the drawing grid for newly
created cross-section based shapes. These settings do not affect existing shapes. The 
measurements are specified in the units you selected on the Units tab of the Options dialog 
box.
Horizontal. Enter the length of each increment on the horizontal axis. For example, if you 
enter 5 and choose Centimeters on the Units tab, each horizontal increment is five 
centimeters long.
Vertical. Enter the length of each increment on the vertical axis. For example, if you enter 1
and choose Inches on the Units tab, each vertical increment is one inch long.

Snap to
These options assist you when you create 2D drawings. As you draw, TriSpectives can 
automatically align the mouse pointer with the grid and other 2D features. The effect is that 
the pointer jumps or “snaps” to these features.
Grid. Check this box if you want the pointer to snap to intersecting lines on the grid. The 
pointer snaps whenever a grid intersection is within the mouse pick aperture specified on 
the General tab of the Options dialog box.
Geometry. Check this box if you want the pointer to snap to the lines, arcs, end points, and 
other features of the 2D drawing. The pointer snaps whenever a grid intersection is within 
the mouse pick aperture specified on the General tab of the Options dialog box.
Angles. Check this box for assistance with selecting an angle in the Angle-distance drag 
mode. As you drag, the angle line jumps by an increment specified in the next field. For 
more information, see the Drag mode options below. 
Increment. Use this field to specify the arc of a circle in degrees or radians. The units 
depend on the current setting on the Units tab. When you draw in Angle-distance drag 
mode, the pointer snaps to the next angle evenly divisible by this increment.
Distance. Check this box if you want the pointer to snap to evenly spaced increments on a 
line. Enter the increment in the next field. This option applies in both the Rectilinear and 
Angle-distance drag modes.
Increment. Enter the length of a line segment . The units depend on the current setting on 
the Units tab. As you drag, the pointer snaps to points along the line separated by this 
increment.

2D Drawing tool behavior
Create independent 2D shapes. Select this option if you want each line and curve in the 
scene or page to produce an independent 2D IntelliShape.
Collect lines and curves into single 2D shape. Use this option if you want all the line 
segemnts you create at one time to build a single 2D IntelliShape.

Measure from



These options set the starting point for measurement when you draw a 2D object. They only 
have effect when you check the Show snap and Measurement feedback options.
Start of drag. Select this option to measure from the point where you began dragging the 
mouse.
Other endpoint of curve. Select this option to measure from the opposite end of the 2D 
item you’re editing.
Shape origin. Select this option to measure from the point where you began drawing the 
2D shape, or from the center of the 2D cross-section.

Drag mode
Use these options as an alternative to the Angle-Distance Drag Mode button on the 2D 
Drawing toolbar. The two options correspond to the active and inactive settings of the tool. 
Your choice determines the method you use to draw lines, arcs, and Bezier curves.
Rectilinear. Choose this option to draw lines and other objects by choosing horizontal and 
vertical coordinates with the mouse.
Angle-distance. Choose this option to draw with a two-step technique of choosing an angle
and a distance. To draw a line, click to mark the starting point of the line and drag to set its 
angle. Then click and drag a second time to define the length of the line. The resulting line 
connects the point where you first clicked the mouse and the point where you released it at 
the end of the process.

Other options
Show snap and measurement feedback. Check this box if you want visual cues to assist 
with the drawing process. TriSpectives displays distance and angle values. It also highlights 
lines, end points, and other features of your drawing when the mouse pointer snaps to one 
of them.
Allow Offset Positioning. Use this option to position a point (a line start or end) relative to 
an existing line. To do so, point at the line, then drag away from it for the required distance. 
When you release the mouse button, the point lies on a line at the distance you indicated 
parallel to the selected line. You can then select another line for a second offset which 
completely constrains the point’s location.



Scene grid tab
Choose this tab to enter the dimensions for the scene grid and the line spacing used in the 
grid.
Size. Enter the length and width of the scene grid in the current measurement units, such as
centimeters.
Line separation. Enter the length and width of the space separating the lines of the grid in 
the current measurement units.



Units tab
Select the type of units and the corresponding abbreviation you want to use to measure 
length and angles.
Length. Choose a unit from the drop-down list such as inches or centimeters. The 
abbreviation for the unit you choose appears beneath the list.
Angles. Choose Degrees or Radians from the drop-down list. The abbreviation appears 
beneath the list.



Color tab
Choose this tab to set color for elements such as IntelliShape highlighting, models, and lines.
Use this tab to choose a color for most of the elements in the TriSpectives display.
Set color for. Choose an item to change its color.
Note: TriSpectives lets you use different colors for three kinds of models. IntelliShape 
models are composites that contain individual IntelliShapes. A facet model is a one-piece 
structure with no components. When you first drag an IntelliShape model in a page or scene,
TriSpectives can display it as an unevaluated facet model for better performance.
Color. Select a color box to assign the color to the current item in the list.



New button
Choose this button to create a new WorkBook.



Open button
Choose this button to open an existing WorkBook.



Save button
Choose this button to save the current WorkBook with the same file name.



Print button
Choose this button to print the current document (the one in the 3D scene or page of the 
main window) and to select printer settings.



Print Preview button
Choose this button to display the WorkBook pages as they would appear printed.



Cut button
Choose this button to delete the current selection from a document and place it on the 
Clipboard.



Copy button
Choose this button to copy the current selection from a document to the Clipboard.



Paste button
Choose this button to paste information from the Clipboard to your document.



Undo button
Choose this button to reverse your last editing task.



Redo button
Choose this button to redo your last editing task.



Zoom control
Choose or enter the percentage you want to magnify or shrink your view of the page. For 
example, choose 200% to magnify or 75% to shrink the images on the page. 



Help button
Choose this button to use the online help.



Line tool
To draw a straight line, click the Line tool, and then drag on the page.
The drawing method depends on the setting of the Angle-Distance Drag Mode tool. In 
rectilinear mode, click at one end of the line and drag to the other end.



Circle tool
To draw a circle or ellipse, choose the Circle tool and then drag on the page.
Click at the center of the circle and drag along its radius to the perimeter. The resulting 
circle has two handles. One lets you change the diameter of the circle. The other lets you 
modify the circle to make an oval.



Arc tool
To draw an arc, click the Arc tool and then drag on the page.
The drawing method depends on the setting of the Angle-Distance Drag Mode tool. In 
rectilinear mode, click at one end of the arc and drag to the other end.



Bezier curve tool
To draw a continuous Bezier curve, click this tool where you want the curve to start, and 
then add the points through which you want the curve to pass. To end the curve, double-
click, click the tool again, select another tool, or press Delete.
The drawing method depends on the setting of the Angle-Distance Drag Mode tool. In 
rectilinear mode, each click extends the curve continuously.
The handles let you change the direction of the curve as it passes through the points.



Fillet tool
Use the Fillet tool to round off the edges where two 2D lines meet. Click the corner and drag 
toward the middle of the cross-section. The farther you drag, the more rounded the corner 
becomes.



Mirror curve tool
Use the Mirror curve tool to create mirror images of 2D shapes.
Draw the elements of the cross-section including a line for the axis of symmetry (the mirror 
line). Select all the elements you want in the cross-section. Then select the Mirror tool and 
click the axis. TriSpectives duplicates the elements of the cross-section symmetrically 
around the axis.



Project Edges to Drawing Grid tool
Use this tool to create 2D items which are the projections of the edges of a 3D face. Choose 
the tool, and then click a surface of the shape.
By default, TriSpectives considers the new 2D items as construction geometry. To have 
TriSpectives consider them real geometry, hold down the Ctrl key when clicking the shape.



Angle-Distance Drag Mode tool
This tool lets you select one of two drawing methods. 
· Rectilinear: The mouse pointer defines a pair of X and Y coordinates, which TriSpectives

displays as you drag. 
· Angle-Distance: The pointer defines different measurements at different parts of the 

drawing process. To draw a line in angle mode, you click to mark the starting point of the 
line and drag to set its angle. Then you click and drag a second time to define the length 
of the line. The resulting line connects the point where you first clicked the mouse and 
the point where you released it at the end of the process. 

The Arc and Bezier tools use corresponding methods for drawing in angle mode.



Select tool
Use this tool to select a 3D shape. You’ll probably use this tool quite often while creating 
images.



 Extrude shape tool      
 

Use this tool to create a custom shape by sweeping a 2D cross-section upwards into 3D. For 
example, extruding a square cross-section creates a cube.



 How to use the Extrude shape tool
To create the 2D cross-section:
1. From the 3D Shapes toolbar, choose the Extrude Shape tool. 
2. Click in the scene where you want to place the extrude shape. You see the Extrude Shape

wizard. Select the options you want, and then choose Finish.
3. You see a 2D drawing grid and the Edit Cross-Section dialog box. (Don’t click the Finish 

Shape button until you’re done drawing the cross-section.)

 
4. Use the camera tools to adjust your view of the grid. For example, to see the grid 
head-on, choose the Look At tool from the Camera toolbar, and then click the front of the 
grid.
5. From the 2D Drawing toolbar, choose a tool, such as the Line tool.
6. Use the drawing pointer to draw the outline of a 2D shape, such as a triangle, on the 

grid. You can add a single outline with several 2D drawing tools, such as the arc and 
Bezier. You can use more than one outline in a cross-section.

 
To extrude the shape into 3D:
· After you draw the cross-section, click the Finish Shape button the Edit Cross-Section 

dialog box.

 



 Spin shape tool      
 

Use this tool to create a custom 3D shape by spinning a 2D cross-section around an axis. 
The process is something like using a lathe to create a bowl.



 How to use the Spin shape tool
To create the 2D cross-section:
1. From the 3D Shapes toolbar, choose the Spin Shape tool. 
2. Click in the scene where you want to place the spin shape. You see the Spin Shape 

wizard. Select the options you want, and then choose Finish.
3. You see a 2D drawing grid and the Edit Cross-Section dialog box. (Don’t click the Finish 

Shape button until you’re done drawing the cross-section.)

 
4. Use the camera tools to adjust your view of the grid. For example, to see the grid 
head-on, choose the Look At tool from the Camera toolbar, and then click the front of the 
grid.
5. From the 2D Drawing toolbar, choose a tool, such as the Line tool.
6. Use the drawing pointer to draw the outline of a 2D shape, such as a triangle, on the 

grid. You can add a single outline with several 2D drawing tools, such as the arc and 
Bezier. You can use more than one outline in a cross-section.

 
To spin the shape into 3D:
· After you draw the cross-section, click the Finish Shape button the Edit Cross-Section 

dialog box.

 



 Sweep shape tool      
 

Use this tool to create a custom 3D shape by sweeping a 2D cross-section along a path in 
space. The path is a combination of curves such as lines, arcs, and Beziers, that you create 
with the 2D Drawing tools.



How to use the Sweep shape tool
To create the 2D cross-section:
1. From the 3D Shapes toolbar, choose the Sweep Shape tool. 
2. Click in the scene where you want to place the sweep shape. You see the Sweep Shape 

wizard. Select the options you want, and then choose Finish.
3. You see a 2D drawing grid and the Edit Cross-Section dialog box. (Don’t click the Finish 

Shape button until you’re done drawing the cross-section.)

 
4. Use the camera tools to adjust your view of the grid. For example, to see the grid 
head-on, choose the Look At tool from the Camera toolbar, and then click the front of the 
grid.
5. From the 2D Drawing toolbar, choose a tool, such as the Line tool.
6. Use the drawing pointer to draw the outline of a 2D shape, such as a triangle, on the 

grid. You can add a single outline with several 2D drawing tools, such as the arc and 
Bezier. You can use more than one outline in a cross-section.

 
To create the path:
1. After you draw the cross-section, click the Finish Shape button the Edit Cross-Section 

dialog box. You see another grid showing the initial path you selected in the wizard.
2. Modify the initial path using the 2D Drawing tools.
To spin the shape into 3D:
· After you draw the cross-section, click the Finish Shape button the Edit Cross-Section 

dialog box.

 



 Loft shape tool      
 

Use this tool to create a freeform custom 3D shape defined by several cross-sections.
To create a loft, you draw as many cross-sections as necessary and place them along a 
straight or curved path. The surfaces of the final 3D shape smoothly connect the cross-
sections.



How to use the Loft shape tool
To start the loft shape:
1. From the 3D Shapes toolbar, choose the Loft Shape tool. 
2. Click in the scene where you want to place the loft shape. You see the Loft Shape wizard. 

Select the options you want, and then choose Finish.
If you choose one of the predefined cross-section options, you’re finished creating a loft 
shape. If you choose the custom option, your next step is to draw the cross-section.

To create the 2D cross-section:
1. You see a 2D drawing grid and the Edit Cross-Section dialog box. (Don’t click the Finish 

Shape button until you’re done drawing the cross-section.)

 
2. Use the camera tools to adjust your view of the grid. For example, to see the grid 
head-on, choose the Look At tool from the Camera toolbar, and then click the front of the 
grid.
3. From the 2D Drawing toolbar, choose a tool, such as the Line tool.
4. Use the drawing pointer to draw the outline of a 2D shape, such as a triangle, on the 

grid. You can add a single outline with several 2D drawing tools, such as the arc and 
Bezier. You can use more than one outline in a cross-section.

 
5. When you’re finished with this cross-section, select the Next button on the Edit Loft 
Cross-Sections dialog box. Repeat steps 1-5 until you complete all cross-sections. 
To construct the loft shape:
After you draw the cross-section, click the Finish Shape button the Edit Loft Cross-Section 
dialog box.



 TriBall tool      

Use this tool to rotate and position a model. This is one of the most useful tools in 
TriSpectives because it lets you move a shape in any direction and rotate it around any axis.



Move in-out tool
Use this tool to raise and lower an object.



Move from-to tool      
Use this tool to position a shape by aligning it with another shape. You can use up to three 
pairs of selections to drag the shape and then rotate it.
Choose this option, then click a point on one shape and drag. The first drag moves the first 
point on the selected shape to the second point. The second drag rotates the selected shape
around the first drop point. The third rotates the selected shape around the axis defined by 
the first two drop points.



Group tool
Use this tool to group selected models together.
To select which models go into the group, hold down the Shift key and click each model. 
Then choose the Group tool. 
Grouping models can help organize a complicated scene, and save you time by letting you 
position several models as a unit. You can also apply styles like color or texture to the entire 
group at once.



Ungroup tool
Use this tool to separate grouped shapes. When you choose the tool, the shapes in a group 
regain their status as individual objects.



Pan camera tool
Use this tool to move your view perpendicular to where the camera is looking. The object 
you’re viewing normally stays under the cursor as you pan. If it doesn’t, use the Target 
Camera tool to refocus your camera.



Orbit camera tool
Use this tool to move the camera eye around the focus point. 
Click and drag the mouse in a scene to rotate the camera eye around the focus point. 
· Drag through the center of the scene to move the view in the corresponding direction. 
· Drag along the edges of the screen—for example, start at the upper left corner of the 

screen and drag to the lower left—to rotate the view and change which way is up. Your 
starting and ending points are important, not the drag path.



Dolly camera tool
Use this tool to move directly along the direction of the view, toward and away from the 
object you’re viewing. The point you focus on also moves, so if you later want to orbit an 
object in the view, use the Target camera tool.



Walk camera tool
Use this tool to walk around inside architectural models. When you first click the Walk 
camera tool in a scene, it chooses the best up direction for the view. 
The Walk tool works by choosing a plane to be the floor, and moving forward and back and 
turning in relation to this floor. To tilt your head, hold down the Shift key and then click and 
drag up or down. The effect is that while you’re in an architectural space, you can look up or 
down while moving along the floor.

 
Flying. Hold down the Ctrl key and select the Walk Camera tool to fly. Move the mouse 
around a view to see different cursors. Click and hold the mouse button to move or turn in 
the direction of the cursor. Release the button to stop moving. 



Zoom camera tool
Use this tool to move the camera lens in or out as you move the mouse up and down in the 
view. You can also change the field of view by using the Camera tab in the Scene Properties 
sheet. 

 



Window zoom tool
Use this tool to zoom in on any feature you can see in the scene. Select the Window zoom 
tool, then drag to define a viewing area. When you release the mouse button, what you 
defined in the viewing area is zoomed to fill the scene.



Fit scene tool
If you get lost, use this tool to view everything in a scene. You can also use the Fit scene tool
to quickly view inserted models, since these models are often on a scale different from the 
scene’s. 
You can also use the Fit scene tool to see all the light sources in a scene. See the Show tab 
on the Scene Properties sheet to check the Lights box.



Look at tool
Use this tool to quickly move to a new view of an object. Click a surface to look directly at 
the surface—you see that surface head-on in the new view.



Target camera tool
Use this tool to reposition the camera’s target point so you can center a point on a model 
within a scene. To center on a particular surface, click the Target Camera tool and then click 
the point on the model you want to center.
The Orbit camera tool uses the point you click as its focus. The distance from the camera to 
this point affects the sensitivity of the Dolly camera and Walk camera tools. If you’re moving 
too quickly with these tools, target a point near by.



Font list
Click the drop-down arrow to select a font from the list of available fonts.



Font size list
Click the drop-down arrow to select a font size, or enter one in the font sizebox.



Bold button
Choose this button to make the selected text bold.



Italic button
Choose this button to make the selected text italic.



Left-justify button
Choose this button to make the selected text align with the left margin.



Center text button
Choose this button to center the selected text.



Right-justify button
Choose this button to make the selected text align with the right margin.



Grow font button
Choose this button to increase the size of the selected text by one point.



Shrink font button
Choose this button to decrease the size of the selected text by one point.



On button
Use this tool to activate the others on the Timeline toolbar. It’s like turning on the power 
switch on a VCR.



Play button
Use this tool to start an animated sequence.



Rewind button
Click this button to rewind the animation.



Timeline
Use this tool to follow and control the progress of an animated sequence. When you click 
Play, the slider tracks the position of the current frame in the animation. Drag the slider to 
move forward or backward.



Workbook Browser
Use this tool to display the WorkBook Browser. The Browser displays the documents, models,
and shapes in the current WorkBook as a tree. When you select an item in the Browser, you 
select the corresponding object in the WorkBook.



Edit surfaces and edges tool
Use this tool with the Select tool to select surfaces, edges, and vertices. 



Edit IntelliShapes tool
Use this tool to select and work with the IntelliShapes in a model. When this tool is active, 
the Select tool chooses shapes instead of models or surfaces.



Stop button
Use this button to stop playing the animation.



Page and scene tip
In general, you begin the modeling process in a scene. When you’re ready to create a final 
image for output, work on a page.



Catalog tip
Use catalogs to store reusable parts. Use WorkBooks for shapes or models that belong to a 
particular project.
For example, if you create variations on a shape, store all the variations in a new catalog.



Toolbars tip
You can move a toolbar anywhere in the TriSpectives window. Click its background, then drag
it to a new location. Drop it near an edge of the window, and it appears as a horizontal or 
vertical strip. Drop it over a page or scene, and it appears as a floating palette.



Look At tool tip
Use the Look At tool when you're positioning the parts of a model, especially those that have
large flat surfaces. For example, if you want to look directly at the wall of a building you're 
designing, click that surface with the Look At tool.



Window Zoom tool tip
Use the Window Zoom tool when you want to work with a particular detail in a model.



Split screen views
Besides using the camera tools to examine your models, you can also divide the scene into 
two or more panels. Then you can see a model from different angles at the same time.

To split the scene into two panels:
1. Right-click the gray area of the scene to see the Scene pop-up menu.
2. From the pop-up menu, choose Vertical Split or Horizontal Split.
3. If you like, resize the panels by dragging the splitter bar. 

TriSpectives changes the perspective in each view to match its size. The larger panel 
zooms to show a larger model, while a smaller panel shows a smaller model.

To return to a single view:
1. Right-click in the panel you want to close.
2. From the pop-up menu, choose Remove View.
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3D Models
A model is a collection of shapes, a 3D representation of a real or imaginary subject.



Bezier curve
A curve, named after Pierre Bezier, mathematically defined by its control points—the points 
at each end of the lines tangent to the curve.



Alignment
How objects align on the page or scene, either to one another, or to the grid.



Attribute
Characteristic of an object, such as the color of a shape or the style of text.



Chamfer
To chamfer an edge, TriSpectives cuts off a diagonal section. The result is two edges that 
aren’t as sharply angled as the original.



Collage
A collage is a collection of 3D and 2D elements, such as models, text, and background 
textures.



Cross-section
A cross-section is a 2D figure that TriSpectives uses to generate the form of an IntelliShape. 



Extrude
To add depth to a 2D shape or cross-section. Extrude a cross-section to create a 3D shape.



Handles
Each IntelliShape has handles so you can expand or contract the shape. A handle is usually 
red and looks like a push-pin.



IntelliShapes
IntelliShapes are the 3D forms that you combine to create models. TriSpectives uses their 
intelligence to simplify the model building process. When you join two shapes, TriSpectives 
knows how they fit together and positions them in the best way. When you edit a model by 
moving one of its shapes, TriSpectives knows where the shape can go and where it can’t. 
An IntelliShape model is a model with intelligent component shapes.



Loft
Create a freeform 3D shape using multiple cross-sections. When you create a custom shape 
by extruding, spinning, or sweeping, you use a single 2D cross-section. With lofting, you can 
define as many cross-sections as necessary. You place these cross-sections along a straight 
or curved path and TriSpectives blends them to create the final shape.



Models
An IntelliShape model is one with intelligent component shapes, such as those in the 
Showcase catalog.
A facet model is from a CAD program or other source.



Page
A flat background where you can draw 2D graphics or place 3D models. Use the page to 
create illustrations that combine models, text, and other elements.



Render
To convert your 3D images into 2D drawings that reflect the properties of the 3D image. 



Rotate
To revolve an object around a fixed point.



Scale
To change the size of an object vertically, horizontally, or both.



Scene
A view into 3D space where you can build models.



SmartDimension
A SmartDimension is a measuring line that extends between two points, edges, or planes on 
a model. You can place the ends of the line anywhere you like. 
Use Smart Dimensions to measure or set the distance between two IntelliShapes, or to 
measure angular relationships.



SmartSnap
A positioning method where TriSpectives provides visual clues about where to position your 
shapes. For example, if you want to drop a slot in the center of a circle, SmartSnap displays 
a green dot when you're pointing to the center of the circle. SmartSnap only works with 
regenerated models.



Spin
Spin a cross-section around an axis to create a 3D shape.



Spline
A flexible curve with four control points.



Sweep
Sweeping involves extending a 2D cross-section into the third dimension along a path. The 
path can be a line, a series of line segments, a curve, or anything else you can create with 
the 2D drawing tools.



Taper
Tapering gradually converges or diverges the surface of a shape along a direction toward a 
point or edge in space.



 Contacting Customer Support
To contact our free Customer Support hotline, please call a number below.
US: 1-800-469-6514
Outside US: (716) 871-6675
For other technical support options, refer to the support card insert in the TriSpectives box or
visit our Web site at http://www.eye.com/
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· Adobe Illustrator and Postscript are trademarks of Adobe Systems Inc.
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Look in/Drives
Use this drop-down list to select a folder or disk drive on your system or network. Click the 
arrow button to see the available locations in a tree structure. When you select a location, its
contents appear in the list below.



File and folder list/Directories
Double-click an item in this list to select it. When you select a folder or directory, you move 
into it and its contents appear in the list.



File name
Enter the name of the file you want, or choose a file from the list. 



Files of type
Use this drop-down list to select a category of files. When you click the button, TriSpectives 
displays a list of file types with the extension for each one. Choose an entry in the list to 
display only files of that type.



Printer Name
Choose a printer from this drop-down list. The list contains all the printers installed in 
Microsoft Windows.



Properties
Choose this button to see the standard Microsoft Windows property sheet for your printer.



Print to file
Check this box if you want to send the output to a file instead of a printer. TriSpectives 
displays the Print to File dialog box to prompt you for a destination.



Print range
Enter which pages you want to print: All, or only selected pages.



Number of copies
Enter the number of printed copies you want, or click the arrow buttons to increase or 
decrease the value.



Create New
Choose this option if you want to insert an object with new data into your document. You can
insert any object in the Object Type list. 



Object type
Choose an object type from this list. Each entry shows the name of a program and one of the
kinds of data it can create. Select an entry to launch the program and create new data.



Create from file
Use this option if you want to embed existing data into a TriSpectives document. When you 
select this option, the Browse and Link options become available.



Browse
Choose this button to select a file with the data you want to embed in your TriSpectives 
document.



Link
Check this box to establish a link between the embedded object in TriSpectives and the 
original file. When the two are linked, changes to the original file appear within TriSpectives.



Display as icon
Check this box to display the embedded object as an icon. Otherwise, it appears in its native
format.



TriBall
A universal positioning tool for moving and rotating shapes and models.



Blend
To blend an edge, TriSpectives rounds it into a smooth curve.



Shelling
Shelling is the process of hollowing out an IntelliShape. For example, let’s say you make a 
model of a cardboard box by starting with a solid block shape. You could shell the block to 
remove all its material with the exception of five thin walls. 



Move shape tip
If the grid isn’t positioned exactly where you want it, you can use the TriBall tool to move it.



Drawing tip
· The first point of an outline should hook up to the last point.
· Outlines should not touch or overlap.



Finish Shape tip
You can also right-click in the scene, then select the Finish Shape command from the pop-up 
menu. To prevent the Edit Cross-Section dialog box from appearing in the future, choose 
Options from the Tools menu, and clear the Show Edit Cross-Section box.



Allow simplification tip
To interrupt a more elaborate rendering (such as a ray trace) and continue to work, press the
Esc key when simplification is on.



Walk camera tool tip
The amount you turn when you drag left and right is related to your field of view. If you want
to turn faster, widen your field of view by using Zoom to zoom out, then walk.



Zoom camera tip
To position the camera for a final image, use the Dolly camera tool and keep the field of view
around 20-30 degrees. This heightens the illusion of three dimensions by using the effect of 
perspective.



Capping
Capping provides a spherical cap at the end section of a sweep or loft shape.



Matching
Matching lets the start or end section of an IntelliShape complete coincide with the surface 
of a face of an existing model.
 



 Dialog boxes, property sheets, and wizards
Select a key that starts with the first character of the name of the dialog box, property 
sheet, or wizard you want.

                    

                    

                    

                    

                    

                    

                     

                    

                     

                    

                  

                    

                    

                    



 2D Shape Properties sheet
You create 2D shapes using the drawing tools directly on a scene or page. A 2D shape is one 
graphic element in a document. Once you create a 2D shape, you can modify it using the 
controls on this property sheet.
General tab 
Outline tab 
Sizebox tab 
Anchor tab 
Position tab 
Interaction tab 

See also: IntelliShape Properties sheet 



 3D Studio Export dialog box
When you export to a 3DS format, TriSpectives tessellates all polygons into triangles, and 
creates smoothing groups as possible. Simple keyframing data is attached to the exported 
objects.



3D Studio Import
You can import files with .3DS and .PRJ extensions. If you import .3DS files, single meshes 
with multiple materials use the first material TriSpectives encounters to color the mesh.



 Add Directory dialog box
Use this dialog box to add an entry to a list of directories. Enter a drive letter, path, and 
directory name in the Directory field and choose OK. 



 Add SmartDimensions dialog box      
 

If you’re using TriSpectives Professional, you can use SmartDimensions to position your 
shapes and models. A SmartDimension is a tool for measuring the distance or angle 
between two features of your model. You can also use it to move the features into position. 
For information on positioning, see Edit SmartDimension dialog box.
Distance 
Angle 
How many should be added 

See also:
Edit All SmartDimensions dialog box 
Edit SmartDimension dialog box 



 Advanced Shadow Settings dialog box
Use the settings on this dialog box to refine the appearance of the shadows on a page or 
scene. You can adjust the softness and resolution of the shadows cast by each light source.
Edge softness 
Shadow resolution 

See also: 
Directional Light Properties sheet 
Spot Light Properties sheet 



 Analysis property sheet
These controls let you perform quantitative analysis on a model as if it were a physical 
object. You can measure its volume, mass, and other properties.
Requested accuracy
Achieved accuracy 
Compute 
Shape body tab 
Surface tab 
Moments of inertia tab 

See also: Model Properties sheet 

Limitations
When you perform an analysis on group shapes, only solid models within a group are 
included in the analysis results. Shapes not included in the analysis are 2D shapes, boundary
representation models, or facet models.



 Animation Frame Size dialog box
After assigning a name and path for your exported animation file, choose frame size settings
in the Animation Frame Size dialog box.
Dimensions
Dots per inch
Output image size
Size (units, width, height)
Match aspect ratio of page
Rendering style
Options button: Click this button to open a new dialog of image export options. These 
options differ depending on the file format you choose. See the help topics for information 
on the options in these dialogs. 
See also:
Export AVI
Export Encapsulated PS
Export GIF
Export JPEG
Export Paintbrush PCX
Export RTL
Export TGA
Export TIFF
Export Windows BMP



 Annotation Properties sheet      
 

An annotation dimension is a measurement and positioning tool. Annotation dimensions 
often appear in technical illustrations. Use the options on this property sheet to adjust the 
behavior and appearance of an Annotation Dimension.
General tab 
Annotation tab 
Interaction tab 



 AutoCAD DXF Read dialog box
When you import 3D data, you can use only ASCII (not binary) DXF files. You can use 3DFACE
and POLYLINE entities, but not extruded 2D objects or repeats. You can insert within a single 
file.
When you import a model from a .DXF file, you have the following options:
Use smoothing. Check this box if you want to smooth the edges of the imported model. 
This means TriSpectives considers polyline meshes to be continuous smooth surfaces. Other 
surfaces are smoothed if the angle between touching polygons with within the smoothing 
angle you enter.

 
If you don’t use smoothing, all polygons are imported as facets, with no smooth rendering. 

 
Smoothing angle. If you do use smoothing, enter a smoothing angle, such as 23.00.



 AutoCAD DXF Write dialog box
All polygons are tessellated into triangles as needed, and 3DFACE entities are used to output
them. You can select the type of end of line, which is useful when moving the data to 
another system.
End of line 



 Bevel dialog box
Use this dialog box to round off an edge on a shape or model.
None 
Constant blend 
Radius 
Variable blend 
Start radius 
End radius 
Chamfer 
Setback right 
Setback left 

Modeling exceptions
· To maintain smooth connectivity, a set of edges you want to blend or chamfer are 

augmented with adjacent edges that are smoothly connected.
· You can give only single edges a variable blend. If a selected edge set has more than one

edge, the Variable blend option is disabled.

See also: Bevel tab in the Model Properties sheet.



 Bezier dialog box
Use the controls on this dialog box to change the shape of a Bezier curve. You create Bezier 
curves using the 2D drawing tools.
The options on the Bezier dialog box control the tangent lines of the curve. A tangent line is 
like a thread tied to a rubber band. When you pull the thread, the band stretches. By varying
the angle and the strength of the pull, you can change the shape of the curve.
A Bezier curve has two tangent lines. One¾the start line¾is close to the starting point of the 
curve. The end line is near the curve’s end point. The following parameters appear twice on 
this dialog box, once for each tangent.
Slope angle 
Magnitude 

See also: 
Circular Arc dialog box 
Line dialog box 



 Box Projection dialog box
The Box method is one of four ways to project a texture or other image onto the surface of a 
model. The 2D plane of the bitmapped image is parallel to the surface. With multiple 
surfaces, the effect is like surrounding the model with six slide projectors forming a box of 
images.
Height 
Width 
Preserve aspect ratio 

See also:
Cylindrical Mapping dialog box 
Slide Projection dialog box 
Spherical Mapping dialog box 



 Catalog Sets dialog box      

Use this dialog box to organize TriSpectives catalogs into sets. You can create a set of related
catalogs for a particular project, client, or other purpose. Once you define the catalogs in a 
set, you can open them all and use their resources with a single command.
This dialog lists the available catalogs.
Open 
New 
Edit 
Remove 
Done 



 Circular Arc dialog box
Use the controls on this dialog box to adjust the radius and other features of an arc you 
create with the 2D drawing tools.
Radius 
Flip center of circle 
Swap start and end points 



 Color dialog box
Use this dialog box to set the color of a shape, background, light source, or other feature in 
the TriSpectives display.
Basic colors 
Custom colors 
Define custom colors 
Palette 
Luminosity scale 
Color/Solid 
Hue 
Sat. 
Lum. 
Red 
Green 
Blue 
Add to Custom Colors 



 Cross-Section Properties sheet
These properties apply to objects you create with the 2D Drawing tools.
General tab 
Outline tab 

See also:
Edit Cross-Section dialog box 
Edit Loft Cross-Section dialog box 
Insert Cross-Sections dialog box 



 Cylindrical Mapping dialog box
Cylindrical mapping is one of the four techniques in TriSpectives for projecting an image onto
the surface of a model. TriSpectives projects the model onto a simpler form, such as a 
cylinder. Then it unrolls the cylinder to make a flat surface and applies the image. 
This method is good for placing textures on soup cans, storage drums, and other cylindrical 
objects. The quality of the image on the side of the cylinder is very good with little distortion.
The top and bottom of the cylinder, however, are very distorted. Use the Box Normal or Slide
Projection method or a different image with the ends of the cylinder. 

Projected image size options
These options let you specify how large the image will be after projection.
Horiz. Ratio 
Height 

Projected image location options
These specify where the image falls on the surface of the model.
Horiz. angle 
Height offset 
Flip Left/Right 

Cylinder Orientation options
These specify the starting point and alignment of the image.
Origin 
Up direction 

See also:
Box Projection dialog box 
Slide Projection dialog box 
Spherical Mapping dialog box 



 Decal Slide Projection dialog box
The values on the Decal Slide Projection dialog box control how the decal image is projected 
onto model surfaces.
Projected image size
Projected image location
Orientation



 Directional Light Properties sheet      
 

TriSpectives has two kinds of light sources: directional and spot lights. Like the sun, 
directional lights provide diffuse illumination from the general direction of the source.
General tab
Light tab

See also: Spot Light Properties sheet 



 Edit All SmartDimensions dialog box
If you’re using TriSpectives Professional, you can use SmartDimensions to position your 
shapes and models. SmartDimensions measure the distance or angle between two features 
of your model. You can also use SmartDimensions to move shapes or models to a particular 
location. Edit the value of a SmartDimension to adjust the distance or angle between two 
objects.
The Edit All SmartDimensions dialog box lets you reposition an object by modifying more 
than one dimension at a time. The SmartDimensions and their values appear in the form of a
spreadsheet. Edit the values you want to change. Then select the OK button to move the 
object according to the new dimensions.
· To edit the value of a SmartDimension, locate the SmartDimension in column one of the 

spreadsheet and change the corresponding number in column two.
You can also format the spreadsheet to view its data clearly.
· To change the width of the columns to accommodate their data, check the Auto Size box.

See also:
Add SmartDimensions dialog box 
Edit SmartDimension dialog box 



 Edit Catalog Set dialog box
Use this dialog box to change or reorder the catalogs in a catalog set.
Catalog set name 
List of catalogs 
Update 
Add 
Remove 
Move up 
Move down 

See also: Catalog Sets dialog box 



 Edit Cross-Section dialog box
When you create a custom shape, you select a 3D Shapes tool, such as the Extrude Shape 
tool, and then draw a 2D cross-section using the 2D drawing tools. During this process, you 
see the Edit Cross-Section dialog box.
· Choose the Finish Shape button after you’ve drawn the 2D cross-section. TriSpectives 

then extends the shape into the third dimension according to the 3D Shapes tool you 
selected.

You can also finish or cancel editing the cross-section by right-clicking the grid and choosing 
Finish or Cancel from the pop-up menu. If you prefer working with the pop-up menu, you can
prevent the Edit Cross-Section dialog box from appearing by choosing Options from the Tool 
menu, and then clearing the Show Cross-Section edit dialog option in the General tab.

See also:
Extrude Shape wizard 
Loft Shape wizard 
Spin Shape wizard 
Sweep Shape wizard 
Insert Cross-Sections dialog box 



 Edit Distance dialog box
This dialog box lets you move an object along one of the three axes in the 3D scene. You see
this dialog box when you right-click a measurement in the scene and choose Edit Value from 
its pop-up menu.
Distance. Enter the new distance value.



 Edit Handle Value dialog box
Variable. This shows you what value you’re editing—length, width, or height.
Value. Check or change the value. You can set the units for this value, such as centimeters 
or inches, in the Units tab on the Options dialog.



 Edit Loft Cross-Section dialog box
When you create a custom loft shape, you select the Loft Shape tool, and then draw 2D 
cross-sections using the 2D drawing tools. During this process, you see the Edit Loft Cross-
Section dialog box.
Next section 
Previous section 
Finish shape 
Options 

See also:
Cross-Section Properties sheet 
Edit Cross-Section dialog box 
Insert Cross-Sections dialog box 



 Edit Loft Path dialog box
When you choose IntelliShape from the Insert menu, you can choose to insert a new shape 
by lofting. Click the scene to see the Loft Shape wizard, and then choose Finish. TriSpectives 
creates a 3D shape according to the settings on the Loft Shape wizard. Right-click the shape,
and then choose Edit Path from the pop-up menu to see the Edit Loft Path dialog box, which 
allows you to edit the loft path for creating a 3D shape.



 Edit SmartDimension dialog box
If you’re using TriSpectives Professional, you can use SmartDimensions to position your 
shapes and models. Use SmartDimensions to measure the distance or angle between two 
features of your model. You can also change the distance or angle of one SmartDimension 
using this dialog box.
Value 
Lock 

See also:
Add SmartDimensions dialog box 
Edit All SmartDimensions dialog box 



 Edit Sweep Path dialog box
When you choose IntelliShape from the Insert menu, you can choose to insert a new shape 
by sweeping. Click the scene to see the Sweep Shape wizard, and then choose Finish. When 
you see the Edit Cross-Section dialog box, choose Finish Shape to see the Edit Sweep Path 
dialog box, which allows you to use the 2D drawing tools to edit the sweep path for creating 
a 3D shape.



 Ellipse dialog box
Use the Ellipse dialog box to adjust the shape of a circle or ellipse you create with the 2D 
drawing tools.
Circle 
Major radius 
Minor radius 
Orientation angle 



 Embedded Page Properties sheet      
 

An embedded page is a 3D page contained within a 3D scene. This technique lets you add 
illustrations, advertisements, and other graphics to a model.
General tab 
Sizebox tab 
Anchor tab 
Position tab 
Drawing style tab 
Interaction tab 



 Embedded Scene Properties sheet
An embedded scene is contained within a 3D page or 3D scene.
General tab 
Sizebox tab 
Anchor tab 
Position tab 
Drawing style tab 
Camera tab 
Interaction tab 



 Export 2D Geometry dialog box
Use the controls on this dialog box to navigate your file system and choose a particular file. 
Aside from the standard Windows features, the dialog box contains the following controls:
Save in/Drives 
File and folder list/Directories 
File name 
Files of type 



 Export Animation dialog box      
 

When you export an animation, TriSpectives exports the entire scene. Assign a name and 
path for your exported animation file, and then choose more settings in the Animation Frame
Size dialog box.
Save in/Drives 
File and folder list/Directories 
File name 
Files of type 



 Export AVI dialog box
Use this dialog box to set options for exporting an AVI file.
Key frame frequency
Quality
Compressor type



 Export dialog      
 

Use the Export dialog to export image, animation, and model files.
Use the controls on this dialog box to navigate your file system and choose a particular file. 
Aside from the standard Windows features, the dialog box contains the following controls:
Look in/Drives 
File and folder list/Directories 
File name 
Files of type 



 Export Encapsulated PS dialog box
Use this dialog box to set options for exporting an encapsulated PostScript file. 
Convert to grayscale 
Use RLE compression 
Size scale 
Rotate 90 degrees 
Center on 8.5 x 11 



 Export GIF dialog box
This compact format is popular, especially on the World Wide Web. However, it uses 
colormaps and eight bits of depth, which means it can lose information. Interlacing the 
image data makes it load progressively—you see a fuzzy image that gets better as it loads.
Convert to grayscale 
Storage depth 
Interlaced 
Sorted colormap 
Use the controls on this dialog box to navigate your file system and choose a particular file. 
Aside from the standard Windows features, the dialog box contains the following controls:
Look in/Drives 
File and folder list/Directories 
File name 
Files of type 



 Export Image File dialog box      
 

When you export an image, TriSpectives exports the last view you selected to an image file. 
Each file has its own special options, which you see when you click the Options button in the
Exported Image Size dialog box. 
In general, most file formats let you output the image to grayscale or to specific color 
depths. Some formats let TriSpectives decide which color depth is the most economical, yet 
still maintain all the colors in the image. You can also select compression schemes for some 
formats.

 
For very large images (such as poster-size or those with very high resolution), you can 
export to 24 bit TIFF format to minimize memory usage. Save your work before trying to 
export a large image.
Assign a name and path for your exported image file. Choose a file type, such as Tag Image 
(*.tif) from the drop-down list, and then choose additional settings in the Exported Image 
Size dialog box. 
Save in/Drives 
File and folder list/Directories 
File name 
Files of type 
See also:
Export Encapsulated PS
Export GIF
Export JPEG
Export Paintbrush PCX
Export RTL
Export TGA
Export TIFF
Export Windows BMP



 Export JPEG dialog box
Not all data is perfectly preserved when you export in this format. However, many images 
are almost identical to the originals, especially those without vectors. You can use this file 
format with World Wide Web pages.
Convert to grayscale 
Quality 



 Export Model File dialog box      
 

You can export 3D models to a wide variety of formats. Whatever single object you select in 
model mode is exported. If you want to export more than one shape, group them by 
selecting the set and choosing the Group tool. See Working with groups of models and the 
Group tool for more information.
When you export a model, be aware of the following limitations:
· TriSpectives saves only model information, not camera, light, background, or animation 

information.
· TriSpectives does not save hierarchy within a group, or texture mapping information in 

models.
Assign a name and path for your exported model file, and then choose a file type, such as 
Acis Model file (*.sat) from the drop-down list. See topics for individual export formats for 
more information.
Save in/Drives 
File and folder list/Directories 
File name 
Files of type 
See also: 
AutoCAD DXF Write dialog box 
POV 2.x Write dialog box 
Raw Triangle Write dialog box 
Stereolithography Write dialog box 
VRML 1.0 Write dialog box 
Wavefront OBJ Write dialog box 



 Export Paintbrush PCX dialog box
This format is popular in a variety of painting applications.
Convert to grayscale 
Storage depth 



 Export RTL dialog box
RTL (Raster Transfer Language) is a plotter format language. If you want to print the RTL file 
instead of creating an exported file on disk, check the box for Output directly to lpt1:device.



 Export TGA dialog box
Before exporting images with this relatively simple format, choose from the following 
storage depth and compression options.
Convert to grayscale 
Storage depth 
Use RLE compression 



 Export TIFF dialog box
Tag(ged) Image File Format (TIFF) is a professional-quality file format.
Convert to grayscale 
Storage depth 
Compression



 Export Windows BMP dialog box
This format is popular for some paint programs and for making wallpaper in Windows screen 
backgrounds.
Convert to grayscale 
Storage depth 
File type 



 Exported Image Size dialog box
After assigning a name and path for your exported image file, choose image size settings in 
the Exported Image Size dialog box.
Dimensions 
Dots per inch (DPI) 
Output image size (pixels)
Units
Width
Height
Match aspect ratio of the page
Rendering style
Options
See also:
Export Encapsulated PS
Export GIF
Export JPEG
Export Paintbrush PCX
Export TGA
Export TIFF
Export Windows BMP



 Extrude Shape wizard      
 

When you’re creating a custom shape by extruding from a 2D cross-section, choose the 
Extrude Shape tool from the 3D Shapes toolbar. Click in the scene to see the Extrude Shape 
wizard, which helps you complete your custom shape. 
Page 1 - How to orient the new shape
Page 2 - How the new shape affects existing models



 Facet Model Properties sheet
A facet model does not contain IntelliShapes. It is simply a collection of polygonal surfaces 
that represent a model. You cannot perform IntelliShape functions on facet models. 
IntelliShape models have their own property sheet.
General tab 
Sizebox tab 
Anchor tab 
Position tab 

See also: Model Properties sheet



 Fillet dialog box
The Fillet dialog box lets you change the radius of two lines that join in a filleted corner.
Radius. Enter the radius of the curve of the fillet. 



 Flip Anchor dialog box
Use this dialog box to rotate an anchor point around its forward axis. The dialog box appears
when you right-click the anchor and choose Flip Anchor from its pop-up menu.
Angle. Enter a new angle. TriSpectives flips the anchor by this angle.
Apply button. Choose the Apply button to flip the anchor while keeping the dialog active so
you can continue working.



 Flip Attachment Point dialog box
Angle. Enter a new angle. TriSpectives flips the attachment point by this angle.
Apply button. Choose the Apply button to flip the attachment point while keeping the 
dialog active so you can continue working.



 Grid Settings dialog box
These options control the size of the increments on a 2D drawing grid.
Horizontal: Enter the distance between the horizontal lines on the grid.
Vertical: Enter the distance between the vertical lines on the grid.



 Group Properties sheet
A group is a collection of individual shapes or models. To create a group, hold down the Shift 
key while selecting the individual objects. Then choose the Group tool or select Group from 
the Shape menu.
The advantage of working with a group is that you can manipulate all objects in the group at
once. The options on the Group property sheet work on all objects in the group.
General tab 
Sizebox tab 
Anchor tab 
Position tab 
Interaction tab 



 Hidden Line Settings dialog box
If you’re using TriSpectives Professional, you can use hidden lines when creating your 
models. The options on the Hidden Line Settings dialog box let you control the appearance 
of a hidden line drawing in embedded pages and scenes. This drawing style produces 
transparent objects that reveal all their features at once. TriSpectives uses hidden (usually 
dashed or dotted) lines to draw the features that would normally be concealed.
Coarse 
Normal 
Fine 
Visible lines 
Hidden lines 
Visible silhouettes 
Hidden silhouettes 



 Insert Cross-Sections dialog box
Use this dialog box to add new cross-sections to a loft shape.
Number of new cross-sections 
Insert after which section 

See also:
Cross-Section Properties sheet 
Edit Cross-Section dialog box 
Edit Loft Cross-Section dialog box 



 Insert Light dialog box
Use the Insert Light dialog box to add a new light source to a scene or page and to select the
type of light you want to shine. 
Directional. Choose this option to insert a diffuse light, like sunlight.
Spot Light. Choose this option to insert a focused light, like light coming from a spot light.

See also:
Spot Light Properties sheet 
Directional Light Properties sheet 
Show tab on the Style Properties sheet



 Insert Model File dialog box
You can import models created in other applications, such as 3D Studio, ACIS 1.7, AutoCAD, 
and Wavefront, to TriSpectives. See the individual topics listed below for complete 
instructions on inserting a model. In general, be aware of the following limitations:
· TriSpectives retrieves only model information within an inserted file. No camera, light, 

background, or animation information affects the scene.
· TriSpectives places all objects in a file into one clip art shape. If you want to manipulate 

objects individually, import each object separately.
· Hierarchy within a model is not preserved.
· Texture mapping information in a model is not preserved.
· Some file formats do not specify the units used to create the geometry. In this case, 

when models are inserted, TriSpectives asumes the geometry was created using its own 
internal, universal unit of length, the centimeter. If this is not the correct unit of measure,
you can use the handles to re-scale the model to the appropriate size. For example, if a 
model in another system is 24 inches long, but has been inserted into TriSpectives at 24 
centimeters, which equals 9.488 inches, you can scale the shape back to its original size 
by right-clicking the length handle of the imported shape and multiplying the displayed 
value by 2.54 (the centimeter-to-inch conversion factor).

When TriSpectives reads various file formats, it massages data. For example, it may smooth 
and edge surfaces so that you can edit curved sections in a group. Reconstructing these 
surfaces may take some time, particularly with large models.
Locate the name and path of the model file you want to insert. You can choose a file type, 
such as Acis Model file (*.sat) from the drop-down list, and select the model file you want to 
insert.
Look in/Drives 
File and folder list/Directories 
File name 
Files of type 
See also:
3D Studio Import 
AutoCAD DXF Read dialog box 
Raw Triangle Read dialog box 
Stereolithography Read dialog box 
TriSpectives and the outside world
Wavefront OBJ Import 
VRML Import 



 Insert Object dialog box      
 

Use the Insert Object dialog to insert a linked object, such as a chart or a graph.
You can insert data from other programs into a TriSpectives document using OLE (Object 
Linking and Embedding) technology. For example, you could incorporate text from a word 
processor as one element in a collage on the 3D page. The embedded text object retains ties
to the program that created it. To edit the text within TriSpectives, double-click it to open it 
in the word processor.
Create New 
Object Type 
Create from file 
File
Browse 
Link 
Display as icon 



 Insert Page dialog box      
 

Use the Insert Page dialog to add a new page to your WorkBook. You can insert a page:
· As a new page in the WorkBook
· On the current page or in the current scene



 Insert Scene dialog      

Use the Insert Scene dialog to add a new scene to your WorkBook. You can insert a scene:
· As a new scene in the WorkBook
· On the current page or in the current scene



 IntelliShape Properties sheet
In TriSpectives, you build 3D models from IntelliShapes, basic geometric forms with many 
intelligent features. The options on this property sheet let you control the appearance and 
behavior of the IntelliShapes in your model.
General tab 
Sizebox tab 
Anchor tab 
Position tab 
Shell tab
Surface Reshaping tab 
Bevel tab 
Interaction tab 
Cross-Section tab 

See also: Shape Properties sheet 



 Key dialog box
A key is a critical moment in an animated sequence. Each key occurs at a particular time 
after the start of the animation. In addition, every key has a set of associated conditions that
define the state of the animation at that moment. For example, you might create a key that 
specifies the position of a model two seconds into the animation.
By setting up a series of keys, you control the progress of the animated sequence. 
TriSpectives fills in the gaps between the keys to create smooth animation.
For instance, you could build a simple animated sequence of a bouncing ball using three 
keys:
· Key 1: Describes the position of the ball in the air at the start of the sequence. 
· Key 2: Places the ball on the ground seconds later. 
· Key 3: At the end of the animation, this key specifies how high the ball goes after 

bouncing.
You don’t need to give any other information about the in-between stages. When you play 
the animation, TriSpectives creates intermediate frames to connect the keys. The result is a 
ball falling to the ground and bouncing back up again.
Use the Segment Properties sheet to specify the number of keys and the times they occur. 
Once you create a key, you can use the options on the Key dialog box to describe the state 
of the animation at a particular time. 
· To specify what happens when the key occurs, choose a key type from the Key Parameter

list and select or enter your options.
Origin 
Position parameter 
Scale parameter 
Orient At parameter 
Orient Up parameter 
Tilt parameter 
Roll parameter 
Pan parameter 
How to use SmartMotions



 Line dialog box
The Line dialog box lets you change the slope angle and width of a line you create with the 
2D drawing tools.
Slope angle 
Length 



 Loft Edit Options dialog box
You can create a loft shape out of predefined cross-sections¾circles and rectangles¾or you 
can create custom cross-sections with the 2D drawing tools. In the latter process, you create
each section in turn. By default, you see the cross-section you’re currently working on. This 
dialog box lets you see two or more cross-sections at once. You may find it easier to position 
a section if you can see its neighbors.
Next cross-section 
Previous cross-section 
All cross-sections 

See also: Edit Loft Cross-Section dialog box 



 Loft Shape wizard      
 

Use this Wizard to create a new IntelliShape through the process of lofting. To see the 
Wizard, select the Loft Shape tool and click in the 3D scene.
When you create a custom shape by extruding, spinning, or sweeping, you use a single 2D 
cross-section. With lofting, you can define as many cross-sections as necessary. You place 
these cross-sections along a straight or curved path and TriSpectives blends them to create 
the final shape.
Page 1 - Number of cross-sections 
Page 2 - Cross-section and path types 
Page 3 - How the new shape affects existing modes 



 Model Properties sheet
The options on this property sheet apply to IntelliShape models. Facet models have their 
own property sheet.
General tab 
Sizebox tab 
Anchor tab 
Position tab 
Attachment points tab
Bevel tab
Interaction tab 



 Move Anchor dialog box
Use these options to reposition the anchor point of an IntelliShape, model, or object. The 
dialog box appears when you right-click the anchor of an item and choose the Move Anchor 
option from its pop-up menu.
Up. Enter the distance to move the anchor along the up direction.
Forward. Enter the distance to move the anchor along the forward direction.
Sideways. Enter the direction to move the anchor along the sideways direction.
Apply button. Choose the Apply button to move the item while keeping the dialog active so
you can continue moving anchor points.



 Move Attachment Point dialog box
Once you insert an attachment point on an IntelliShape, you can move it precisely using this 
dialog box.
Up. Enter the distance to move the attachment point along the up direction.
Forward. Enter the distance to move the attachment point along the forward direction.
Sideways. Enter the direction to move the attachment point along the sideways direction.
Apply button. Choose the Apply button to move the item while keeping the dialog active so
you can make additional movements.



 Open dialog box      
 

Use the Open dialog to open files, such as WorkBooks, catalogs, and images.
Use the controls on this dialog box to navigate your file system and choose a particular file.
Look in/Drives 
File and folder list/Directories 
File name 
Files of type 



 Options dialog box
Use the Options dialog to set general options and preferences for your projects. Click the 
name of the tab to see information about it.
General tab
Models tab
Directories tab
2D Drawing tab 
Scene Grid tab
Units tab
Color tab



 Page Properties sheet
Use the Page Properties sheet to select the attributes of 3D pages. Click the name of the tab 
to see information about it.
General tab 
Page size and grid tab 
Background tab 
Rendering tab 
Show tab



 POV 2.x Write dialog box
If you’re using TriSpectives Professional, you can export to POV-Ray (a popular free ray 
tracer) format using this option. Select the type of end of line, which is useful when moving 
the data to another system. The output file generates a model file which you can include in 
a POV-Ray scene. 
End of line. Choose the type of computer you’ll use with the exported file. Your choices are 
PC, Unix, and Macintosh.



 Print dialog      
 

Use the Print dialog to print the current WorkBook and select printers and printer settings.
Name 
Properties 
Print to file 
Print range 
Number of copies 



 Raw Triangle Read dialog box
Raw is an extremely simple file format. The file contains one line of nine numbers 
corresponding to the X, Y, and Z values of the three points on a triangle. If you want to 
import a model in a file format unknown to TriSpectives, try converting to Raw first.
When you import a model from a .RAW file, you have the following options:
Use smoothing. Check this box if you want to smooth the edges of the imported model. All 
surfaces are smoothed if the angle between touching triangles is within the smoothing angle
you enter.
If you don’t use smoothing, TriSpectives imports all polygons as facets, with no smooth 
rendering.

 
Smoothing angle. If you do use smoothing, enter a smoothing angle, such as 23.00.



 Raw Triangle Write dialog box
Raw is a very simple file format. The file contains one line of nine numbers corresponding to 
the X, Y, and Z values of the three points on a triangle.
End of line. Choose the type of computer you’ll use with the exported file. Your choices are 
PC, Unix, and Macintosh.



 Rename Page/Scene dialog box
When you first create a new page or scene, TriSpectives gives it a generic name, such as 
Doc-1. Enter a new name on the Rename Page or Rename Scene dialog box, and then 
choose OK.



 Reset Sizebox dialog box
Use this dialog box when you want a model or group to scale up or down as you pull its 
sizebox handles. 
You can also use this dialog box to adjust the sizebox to make it fit tightly around the 
geometry within it. You may want to reset the sizebox after changing the geometry of 
shapes inside the model or group, since the sizebox is not adjusted automatically.
· Scale bevels, shells, caps, and tapers along with model. Check this box if you 

want these modeling features to scale up or down along with the sizebox. Clear this box 
to force these features to keep a constant size. For example, clear this checkbox if you 
want the radius of edge blends to remain constant as you scale the model up or down.



 Resolution Selection dialog box
When you use a Kodak Photo CD (.pcd) file for your image texture file, you can set the image
resolution, depending on the capabilities of your monitor. The resolution improves as the 
numbers increase. Choose one of the following resolution settings:
· 64 x 96 pixels
· 128 x 192 pixels
· 256 x 384 pixels
· 512 x 768 pixels
· 1024 x 1536 pixels
· 2048 x 3072 pixels
· 4096 x 6144 pixels



 Save As dialog box      
 

Use the Save As dialog to save a new WorkBook or to save the current WorkBook with a 
different name or in a different location.
Assign a name and path for your file.
Look in/Drives 
File and folder list/Directories 
File name 
Files of type 



 Scene Properties sheet
Use the Scene Properties sheet to select the attributes of your scenes. Click the name of the 
tab to see information about it.
General tab 
Background tab 
Rendering tab 
Show tab
Camera tab



 Segment Properties sheet
A segment is an animated sequence. You create animation by dropping a SmartMotion on a 
model, shape, or document. Each animated object appears as a distinct segment in the 
SmartMotion Editor. 
When you expand a group segment¾by choosing Expand from its pop-up menu¾you see its 
components. Each group segment includes a model segment and one or more motion 
segments.
You can control many features of the animation using the Segment Properties sheet. 
Segment Properties appear on the pop-up menu for each segment. 
General tab 
Time Effect tab 
Path tab 
Use the controls on this dialog box to navigate your file system and choose a particular file. 
Aside from the standard Windows features, the dialog box contains the following controls:
Look in/Drives 
File and folder list/Directories 
File name 
Files of type 



 Set Operation dialog box
Set operations refer to the Boolean functions AND and NOT. When you’re building models, 
these operations create positive models—solid objects—or negative models—holes.
The Set Operation dialog box lets you change the effect a shape in the catalog has when you
drop it on a model. Some shapes add material to the model; others, like holes, remove 
material. 
Use this dialog after you create a model and drag it back to a catalog. Double-click the 
model in the catalog, select the model, and then choose the Set Operation command from 
the Tools menu. Choose one of the following options:
Add material 
Remove material 

After you set the operation, you can right-click the anchor point of the model, and then 
choose Move Anchor from the pop-up menu to change the orientation and point where your 
model attaches to other models when you drop it.

When you finish working with this model, close the scene window to stop editing the model 
in the catalog.



 Shape Properties sheet
This version of the Cross-Section Properties sheet appears before you begin drawing the 
cross-section. Right-click the empty 2D grid and choose Cross-Section Properties to see 
these options. For more information, see Cross-Section Properties sheet.



 Slide Projection dialog box
The slide projection method is a way to place a bitmapped image on the surface of a model. 
Like a photographic slide projector, TriSpectives casts the image straight on to the surface. 
Use the options on this dialog box to control slide projection.

Projected image size options
These options let you specify how large the image will be after projection.
Width
Height
Preserve aspect ratio

Projected image location options
These specify where the image falls on the surface of the model.
Width offset
Height offset
Rotation
Flip left/right

Slide projection orientation options
These specify the starting point and alignment of the image.
Origin
Projection direction
Up direction

See also:
Box Projection dialog box 
Cylindrical Mapping dialog box 
Spherical Mapping dialog box 



 Spherical Mapping dialog box
Spherical mapping is a way to project a bitmapped image onto the surface of a model. 
Typically, you use this method to add textures to spherical objects such as planets, billiard 
balls, marbles, and so forth.

Projected image size options
These options let you specify how large the image will be after projection.
Horiz. ratio
Vert. ratio

Projected image location options
These specify where the image falls on the surface of the model.
Horiz. angle
Vert. angle
Flip Left/Right 

Orientation options
These specify the starting point and alignment of the image.
Origin
Up direction

See also:
Box Projection dialog box 
Cylindrical Mapping dialog box 
Slide Projection dialog box 



 Spin dialog box
You can change the angle TriSpectives uses to create an IntelliShape through the spinning 
process.
Angle. Enter a new angle. TriSpectives spins the shape, adding to or taking from it, until it 
matches the angle.



 Spin Anchor dialog box
Use this dialog box to rotate an anchor point around its up axis. The dialog box appears 
when you right-click the anchor and choose Spin Anchor from its pop-up menu.
Angle. Enter a new angle. TriSpectives spins the anchor by this angle.
Apply button. Choose the Apply button to spin the anchor while keeping the dialog active 
so you can continue working.



 Spin Attachment Point dialog box
Once you insert an attachment point on an IntelliShape, you can spin it precisely using this 
dialog box.
Angle. Enter a new angle. TriSpectives spins the attachment point by this angle. Initially, 
TriSpectives spins about the axis perpendicular to the surface of the IntelliShape (the longest
axis of the attachment point).
Apply button. Choose the Apply button to spin the item while keeping the dialog active so 
you can continue spinning the attachment point.



 Spin shape wizard      
 

Use this Wizard to create a new IntelliShape through the process of spinning. To see the 
Wizard, select the Spin Shape tool and click in the 3D scene.
Use Spinning to create a custom shape by rotating a 2D cross-section around an axis. The 
process is very much like extrusion.
Page 1 - How to orient the new shape
Page 2 - How the new shape affects existing models



 Spot Light Properties sheet      
 

The spot light is one of two light sources in TriSpectives. It casts a cone of light from a 
specific location in the scene. Use these options to adjust the color, intensity, cone angle, 
and other characteristics of a spot light. For information on the other kind of light source, 
see Directional Light Properties.
General tab 
Anchor tab 
Position tab 
Light tab 
Interaction tab 

See also: Directional Light Properties sheet 



 Stereolithography Read dialog box
STL is a format for making prototypes using a special machine. You can use both ASCII and 
binary formats. TriSpectives checks the imported data to make sure the model has no 
dangling edges in the surface. Professional version only.
When you import a model from a .STL file, you have the following options:
Use smoothing. Check this box if you want to smooth the edges of the imported model. All 
surfaces are smoothed if the angle between touching triangles is within the smoothing angle
you enter.
If you don’t use smoothing, TriSpectives imports all polygons as facets, with no smooth 
rendering.

 
Smoothing angle. If you do use smoothing, enter a smoothing angle, such as 23.00.



 Stereolithography Write dialog box
STL is a format for making prototypes using a special machine. You can export a TriSpectives
model into an STL file using ASCII and binary formats.
End of line. Choose the type of computer you’ll use with the exported file. Your choices are 
PC, Unix, and Macintosh.
Binary output. Choose this option if you want to create binary rather than ASCII output.



 Style Properties/Surface Style Properties sheet
The options on these two property sheets control surface features such as color, texture, 
transparency, and bumpiness. The Style Properties control the appearance of models, 2D 
IntelliShapes, and embedded pages. The Surface Style Properties work the same way for one
surface. 
TriSpectives lets you set styles for two levels of the model. A model as a whole has a single 
style that determines the appearance of all surfaces of the model. You can also set styles for
individual surfaces. These surface styles can override the model style.
The two property sheets are identical with the exception of the Replace Surface Styles 
option on each tab of the Style Properties sheet. Check this option if you want the properties
of the model to take precedence over those for individual surfaces. In addition, the Style 
Properties sheet varies slightly depending on whether it’s for a 2D shape, model, or 
embedded page.
Color/Fill color tab 
Finish tab 
Transparency tab 
Bumps tab 
Reflection Effect tab 
Decal tab 
Line style tab 



 Sweep Shape wizard      
 

Sweeping involves extending a 2D cross-section into the third dimension along a path. The 
path can be a line, a series of line segments, a curve, or anything else you can create with 
the 2D drawing tools.
Page 1 - How to orient the new shape
Page 2 - Path type
Page 3 - How the new shape affects existing models



 Text Properties sheet
You can create 3D text on a page or scene using the items in the Text catalog. The resulting 
text is an IntelliShape similar to the others in TriSpectives. 
Although a text shape has handles and a sizebox, they behave differently than they do with 
other IntelliShapes. The sizebox of a text shape defines the boundaries of the text editing 
area and not the text itself. When you drag the handle of a text shape, you change the size 
of the editing area.
Most options on the Text Properties sheet¾anchor, position, interactive behavior, and so 
forth¾are standard items that apply to all IntelliShapes. The only unique properties appear 
on the Text tab.
General tab 
Sizebox tab 
Anchor tab 
Position tab 
Text tab 
Interaction tab 



VRML Import
Make sure you are strictly compliant with VRML 1.0 format before importing, though minor 
transgressions may be ignored. TriSpectives imports all model primitives and all 
transformation nodes. All data should be inside a single Separator {} node.



 VRML 1.0 Write dialog box
Use this dialog box to create VRML 1.0 compliant output, exporting all polygon meshes as 
compact IndexedFaceSets. Some VRML browsers do not handle concave or complex 
polygons well, so you may want to make all polygons convex.

End of line         
Make all polygons convex
Minimize output



Wavefront OBJ Import
You can import smoothing groups, but not spline-based primitives. You can also use the 
mtllib material library command—use absolute path names to specify the material file’s 
location. For Professional version only.



 Wavefront OBJ Write dialog box
Use this dialog box to export a TriSpectives model as a Wavefront OBJ file. You can also 
create a material file with the same name and an MTL extension. If you do so, you also 
create a corresponding mtlib token in the OBJ file with the material file’s absolute path. If you
move the material file, be sure to edit the path in the OBJ file.
End of line 
Output material file
Tessellate if >6 vertices



 Welcome dialog
Use this dialog box to choose a WorkBook at the beginning of a TriSpectives session.
Create a new WorkBook. Select this option to work with a new, blank WorkBook. You see 
the WorkBook wizard.
Open an existing WorkBook. Select this option to continue working with a WorkBook on 
your system. You see the Open dialog box.
Always show this dialog on startup. Check this box if you want to see the Welcome 
dialog box every time you start TriSpectives.
Note: You can also choose Options from the Tools menu, and then check the Show Welcome 
dialog on startup box on the General tab.



 WorkBook Wizard
Use the WorkBook Wizard to select your initial settings for working with a new WorkBook.
1. On page 1 of the WorkBook Wizard, choose the type of page you want to start with:

· Choose a 3D page to create a finished illustration.
· Choose a 3D scene to build models.

2. Choose the Next button to go to page 2, where you can select a set of catalogs to use 
with this WorkBook. Select the one you want from the list, and then choose Finish.



 Zoom dialog box
Use this dialog box to change your view of the 3D page. You can zoom in to see details or 
out to view the whole page at once.
200%. Choose this option to make the page appear twice its normal size.
150%. Choose this option to make the page appear one and a half times its normal size.
100%. Choose this option to make the page appear at its normal size.
75%. Choose this option to make the page appear at three quarters its normal size.
50%. Choose this option to make the page appear at half its normal size.
Page Width. Choose this option to see the entire width of the page in the display.
Whole Page. Choose this option to see the entire page in the display.
Fit Selected Object. Choose this option to have the display fit the selected models or 
shapes.
Percent. Enter a zoom factor.



Edge softness
To make shadows soft or sharply defined, enter 0 for sharp definition, or 1 for soft definition.



Shadow resolution
Enter a value from 20 to 1000 to change the resolution of a shadow. A higher the value, the 
better the quality of resolution. Higher values also require more memory.



Requested accuracy (%)
Enter the level of accuracy you want during the measurement process. For example, if you 
want TriSpectives to measure the volume of your model with 90% accuracy, enter 90.



Achieved accuracy (%)
This field shows the degree of accuracy that TriSpectives was able to achieve when 
performing measurements.



Compute
Choose this button to measure the quantities, locations, and other values on one of the 
Analysis property sheets. For example, to measure the surface area of your model, click 
Compute on the sheet of Surface properties. 



Shape body tab
These measurements refer to the entire structure of a model.
Density. This field shows the density of your model.
Volume. This field shows the volume of your model.
Mass. This field shows the mass of your model.
Center of gravity: These three fields show the x, y, and z coordinates for your model’s 
center of gravity.



Surface tab
Use this sheet of properties to measure the surface area of your model.
Area. This field shows the surface area of your model.



Moments of inertia tab
(|_xx, |_yy, |_zz). These fields show the moment of inertia about the X, Y, and Z axes.
(|_xy, |_yz, |_zx). These fields show the product of inertia about the X, Y, and Z axes.
Principal moments. These fields show the principal moments of inertia.
Principal axis U. These fields show the principal axis U.
Principal axis V. These fields show the principal axis V.
Principal axis W. These fields show the principal axis W.



Height
Enter the vertical length of the image.



Width
Enter the horizontal length of the image.



Preserve aspect ratio
Choose this option to maintain the horizontal to vertical ratio of the image after projection.



Slope angle
Enter the slope of the tangent line. The slope defines the angle of the tangent relative to the
coordinate system of the 2D drawing grid. Vary the angle to change the direction of 
curvature.



Magnitude
Enter the length of the tangent line. The greater the magnitude, the more the curve extends 
in the tangent direction.



Open
To work with all the catalogs in a set, choose an entry in the list of sets and click this button. 
The catalogs appear in the TriSpectives catalog browser.
When you choose this option, TriSpectives closes all currently open catalogs so you see only 
the catalogs in the set you choose.



New
To create a new catalog set and specify its members, choose this button. TriSpectives 
displays the Edit Catalog Set dialog box.



Edit
To add, delete, or rearrange the catalogs in a set, choose an entry in the list of catalog sets 
and click this button. TriSpectives displays the Edit Catalog Set dialog box.



Remove
To remove a catalog set, choose an entry in the list of catalog sets and click this button.



Done
Choose this option to close the Catalog Sets dialog box.



Radius
Enter the radius of the circle for the arc.



Flip center of circle
Choose this option to move the center of the circle to the other side of the arc. The effect is 
to flip the arc into the position of its mirror image.



Swap start and end points
Choose this option to move the arc so that the start point becomes the end point and vice-
versa. 



Basic colors
Click a color to apply it to the item in the display.



Custom colors
If these boxes contain colors, you can click one to apply it to the item in the display.



Define custom colors
If you want to create a new color that doesn’t appear in the set of basic colors, choose this 
option. The dialog box expands to display the palette and the controls beneath it.



Palette
Click in this area to choose one color from a continuous spectrum. The color you select 
appears in the Color/Solid preview box beneath the palette. If the box appears white, the 
slider for the Luminosity scale is at its highest setting. 



Luminosity scale
To adjust the brightness of the color, drag the slider (the arrowhead next to the scale) up or 
down. The scale represents a brightness spectrum with white at the top, black at the 
bottom, and degrees of the color in between. When you drag the slider, the value in the Lum
field changes.



Color/Solid
Double-click the right half of this box to select the closest solid color on the palette. Many 
colors on the palette are mixtures that consist of alternating dots of solid color. 
The left half of this box shows a preview of how a mixed color will appear on a model or 
other surface. The right half shows the solid color that’s nearest to the current position of the
cursor on the palette. 



Hue
Enter a value to see the corresponding color. The number of possible values and the 
resulting colors depend on your display adapter. When you drag the pointer over the palette,
the value in this field changes to identify the current color.



Saturation
Enter a saturation value. Enter 0 for gray. The highest value, which depends on your system,
produces a pure, undiluted color. When you drag the pointer over the palette, the value in 
this field changes to reflect the saturation of the current color.



Lum.
Enter a brightness value. Enter 0 for black. Higher values produce brighter colors. The 
highest value, which depends on your system, produces pure white. When you drag the 
pointer over the palette, the value in this field changes to show the luminosity of the current
color.



Red
Enter a value to specify the amount of pure red in the color. As the value increases, the color
gets redder. When you drag the pointer over the palette, this field shows the amount of red 
in the current color.



Green
Enter a value to specify the amount of pure green in the color. As the value increases, the 
color gets greener. When you drag the pointer over the palette, this field shows the amount 
of green in the current color.



Blue
Enter a value to specify the amount of pure blue in the color. As the value increases, the 
color gets bluer. When you drag the pointer over the palette, this field shows the amount of 
blue in the current color.



Add to Custom Colors
Choose this button to add the current color to the set of custom color selections on the left 
side of the dialog box. You can then use the color with a model or other item. 



General tab
Type field. Shows the classification of the selected IntelliShape. The possible types are: 2D 
IntelliShape, Cross-Section IntelliShape, Extrude IntelliShape, Spin IntelliShape, Loft 
IntelliShape, Sweep IntelliShape, Text IntelliShape, Bevel IntelliShape, Spotlight IntelliShape, 
Directional Light IntelliShape.
System name field. Shows the unique name that TriSpectives assigns to every object in a 
document. For example, the two IntelliShapes in a model might be Shape1 and Shape2. 
TriSpectives uses the system shape name to reference specific variables of a shape when 
writing formulas. The system name is also the default user name.
User name field. Enter a custom name. TriSpectives uses this name to reference a shape in
the WorkBook Browser. For example, you might create a model house with individual shapes 
named Roof, Window, and so forth.
Link Status field. Shows the value LINKED or NOT LINKED. 
LINKED indicates that the selected shape is a copy linked to its original. Linked shapes look 
identical. When you change one shape in a linked set, you change all shapes in the set. 
Once you link a shape, you can only unlink it by choosing Undo from the Edit menu.
Note: TriSpectives only links geometry and style properties, such as color and transparency,
in its linked shapes.
NOT LINKED indicates the selected shape is unique. If you change an unlinked shape, you 
change only that shape.
The General tab of the cross-section IntelliShape used to generate the loft IntelliShape also 
includes the Loft Shape Cross-Section options. 



Loft Shape Cross-Section options
Apply Cross-Section to Loft Shape. Check this option if you want TriSpectives to use the 
cross-section to generate the loft IntelliShape.
Relative Distance from Start of Path. Enter a value from 0 to 1 to specify the position of 
the cross-section along the loft path. Position 0 is the beginning of the path, and 1 is the 
end. For example, to position a shape halfway along the loft path, enter .5.
Note: When the path is not a straight line or circular arc, the spacing of increments along 
the path is not uniform.
Orientation angle about path. This angle value represents the rotation of the cross-
section from its original position. The axis of rotation is the direction perpendicular to the 
surface of the cross-section. The center of rotation is the point on the cross-section which 
intersects the loft path.



Outline tab
An outline consists of lines, arcs, and other elements connected end to end. An outline may 
or may not enclose a space. Outlines make up the cross-sections, 2D shapes, and paths in 
TriSpectives. For instance, if you create a 2D shape by drawing a circle inside a rectangle, 
the resulting shape has two outlines.
When you draw a line or other element of an outline using the 2D drawing tools, you define 
a unique set of coordinates, angles, and other values. These numbers appear in a table on 
this property sheet.
Each row in the table describes one component of the 2D outline. The components include:
· The starting point of the drawing
· Lines
· Ellipses
· Elliptical arcs
· Bezier curves
· Fillets
The columns contain coordinates, angles, and other values that make each 2D object 
unique. The following list shows the values that appear for each kind of component.
The starting point of the drawing. The columns are:
0: The word “Start.”
1: The X coordinate of the starting point of the first 2D object.
2: The Y coordinate of the starting point of the first 2D object.
9: The value 0 for an open curve, 1 for a closed curve.
10: The value 0 for real geometry, 1 for construction geometry.
Lines. The columns are:
0: The word “Line.”
1: The X coordinate of the line’s end point.
2: The Y coordinate of the line’s end point.
9: The starting trim parameter for filleting.
10: The ending trim parameter for filleting.
Ellipses. The columns are:
0: The word “Ellipse.”
1: The X coordinate of the center of the ellipse.
2: The Y coordinate of the center of the ellipse.
3: The X coordinate on the primary axis.
4: The Y coordinate on the primary axis.
9: The eccentricity of the ellipse, the quotient of the secondary axis divided by the primary 
axis.
Elliptical Arcs. The columns are:
0: The word “Arc.”
1: The X coordinate of the arc’s end point.
2: The Y coordinate of the arc’s end point.
3: The ratio of the arc. (See note below.)
8: The angle between the arc’s primary axis and the X axis.
9: The eccentricity of the arc, the quotient of the secondary axis divided by the 
primary axis.
Note: The ratio of an elliptical arc (the value in column 3) is the fraction D/C. C is the length 
of the arc’s chord, the line that connects its endpoints. D is the length of a line that connects



the arc with the bisection point of the chord.
Bezier curve. The columns are:
0: The word “Bezier.”
1: The X coordinate of the curve’s end point.
2: The Y coordinate of the curve’s end point.
3: The X component of the tangent at the starting point.
4: The Y component of the tangent at the starting point.
5: The X component of the tangent at the end point.
6: The Y component of the tangent at the end point.
Fillet. The columns are:
0: The word “Fillet.”
1: The X coordinate of the fillet’s endpoint.
2: The Y coordinate of the fillet’s endpoint.
3: The radius of the fillet.
· To modify a 2D object, change one or more values in the table of outline 

properties.
For instance, if you want a line to begin at the origin, enter 0 in the second and third 
columns of the row that contains the line. When you choose OK, the drawing changes to 
reflect the new values.
· To work with a different 2D object, select it from the drop-down list beneath 

the spreadsheet.
If the cross-section contains 20 outlines, this list has 20 entries. They appear in the order 
you created them.
Other outline properties include the ones below.
Show Formulas. To see the formulas that produce some of the values on this property 
sheet, check this box.
Auto Size. Check this box if you want TriSpectives to automatically adjust the width of the 
spreadsheet columns to match their contents.



Sizebox tab
The sizebox is the frame that surrounds an IntelliShape or other object. It normally controls 
the size of the object. Use this property sheet to adjust the dimensions of the sizebox and 
change its behavior.

Dimensions
The dimensions control the proportions of the sizebox and the underlying object. Use these 
controls when you need precise measurements instead of dragging the handles on the 
sizebox.
Length 
Width 
Height 

Resizing behavior
These options control the way the sizebox behaves when you drag its handles. TriSpectives 
can display handles on five axes: length, width, height, and—for a 2D sizebox—two 
diagonals. Choose an axis from the list and then select one of the three forms of resizing 
behavior.
About sizebox center 
About anchor 
From opposite handle 

Aspect locks
The aspect locks maintain the proportions of the sizebox when you resize it. You can lock two
or more dimensions to keep them in proportion. For example, if you lock the length and 
width of a shape, you can drag either handle to change the size of the shape along both 
dimensions. The resized shape preserves the ratio of the original length and width.
None 
Length and width 
Length and height 
Width and height 
All 

Display options
These govern what you see when you select this object.
Handles 
Box 

Permit reset of the sizebox
Check this box if you want to prevent modification of sizebox formulas when a model or 
group containing this shape has its sizebox reset using the common Reset Sizebox. This 
option preserves formulas that would otherwise be lost when Reset Sizebox is performed.

Keep anchor fixed in space during resize



Check this box if you want the anchor to stay in place when you change the dimensions of 
the sizebox.

Show Formulas
TriSpectives computes some values on this property sheet from formulas. If you’re interested
in the underlying formula, you can change the display to see variables, constants, and 
calculations that produce a particular number. 
Show Formulas 



Anchor tab
The anchor is the point where the selected object attaches to other objects. Use the anchor 
properties to set the position and orientation of the anchor within the sizebox of the selected
object.
For example, if you create a model of a filing cabinet, put the anchor on the bottom surface 
so that the cabinet lands right side up when you drop it on another model.
The anchor is also the reference point TriSpectives uses when measuring the position of an 
object. See Measuring position for more information.

Distance from sizebox corner
The first set of anchor properties determines the position of the anchor. The corner is the 
starting point of the 2D cross-section that underlies the shape. The three measurements 
indicate how far the anchor is from the corner of the sizebox of this object.
Along length L 
Along width W 
Along height H 

Orientation
These properties let you tilt the anchor so that an object lands at a particular angle when 
you drop it into the scene or page. Enter dimensions to define the axis about which the 
rotation occurs.
L 
W 
H 
By this angle 
TriSpectives computes some values on this property sheet from formulas. If you’re interested
in the underlying formula, you can change the display to see variables, constants, and 
calculations that produce a particular number.    
Show Formulas 



Position tab
These properties determine the location and orientation of the selected shape. 

Location
Enter the distance from the corner of the model’s sizebox to the anchor of this shape.
Along length L 
Along width W 
Along height H 

Orientation
Enter the axis around which you want to rotate the selected shape, and the angle by which 
you want to tilt the shape. 
L 
W 
H 
By this angle 
TriSpectives computes some values on this property sheet from formulas. If you’re interested
in the underlying formula, you can change the display to see variables, constants, and 
calculations that produce a particular number.    
Show Formulas 



Position tab
These properties determine the location and orientation of the selected shape within the 
scene. 

Location
Enter the distance from the corner of the model’s sizebox to the anchor of this shape.
Along length L 
Along width W 
Along height H 

Orientation
Enter the axis around which you want to rotate the selected shape, and the angle by which 
you want to tilt the shape. 
L 
W 
H 
By this angle 
TriSpectives computes some values on this property sheet from formulas. If you’re interested
in the underlying formula, you can change the display to see variables, constants, and 
calculations that produce a particular number.    
Show Formulas 



Horiz. Ratio
Enter the number of times you want to repeat the image around the side of the cylinder. In 
general, use a whole number to avoid seams in the image.



Height
Enter the height of the projected image.



Horiz. angle
Use this control to shift the field horizontally. To shift the image by a percentage of its width, 
enter the corresponding fraction of 360°. For example, to shift the image horizontally by half 
its width, enter 180.



Height offset
Use this field to shift the image vertically. Enter the distance that you want to move the 
image. For example, if the image is 100 units high and you want to move it up by half its 
length, enter 50.



Flip Left/Right
Check this box if you want TriSpectives to invert the projected image so that it mirrors the 
original.



Origin
Enter three coordinates in these fields to specify the starting point of the image. In general, 
this should be the center point of the object.



Up direction
Use these fields to specify the axis that orients the image up and down. Enter 1 for this axis 
and 0 in the other fields.



Light tab
These options govern the color, intensity, and other characteristics of the light coming from 
the directional source.
Light On. Check this box if you want the directional source to emit light.
Cast shadows. Check this box if you want the light coming from this source to cast 
shadows.
Advanced Settings. If you want to change the appearance of the shadows cast by this 
light source, choose this button. You see the Advanced Shadow Settings dialog box.
Show Formulas. To see the expressions that produce values on this property sheet, check 
this box.
Intensity. To make the light brighter or dimmer, enter an intensity value. The larger the 
value, the brighter the light.
Color. To change the color of the light this source emits, select a color sample on this 
palette.
More Colors. Choose this option to select from a larger color palette or to define a new 
color. TriSpectives displays the Color dialog box.



Circle
If you want the 2D drawing to be a circle, check this box.



Major radius
Enter the length of the major radius of the ellipse.



Minor radius
Enter the length of the minor radius of the ellipse.



Orientation angle
Enter the angle of the major radius of the ellipse relative to the 2D coordinate plane.



Drawing style tab
These properties let you control the appearance of the page and of models on the page.
Wireframe. Choose this option to display models as wireframe drawings. A wireframe is a 
hollow form with a grid of lines for the surface. Wireframes have no surface covering, color, 
or texture.
Hidden line. Use this option to display models on the page as hidden line drawings. This 
style reveals the surfaces that would normally be invisible behind other surfaces. Since the 
resulting model is transparent, you can view all its features at once. Use this style if your 
objective is a technical illustration like the kind you get from a CAD program.
Line Settings. Choose this button to see the Hidden Line Settings dialog box. The options 
on this dialog box govern the appearance of hidden line drawings. 
Facet shading. Choose this option to display models with a single color on each facet. 
Models are approximated as objects composed of flat surfaces called facets for display.
Smooth shading. Select this button to display models as solid objects with smooth, evenly 
shaded surfaces.
Show textures. Check this box if you want surface textures to appear on the models. This 
option only applies to models that have textures, and only when the smooth shading option 
is active.
Realistic shading. Choose this option to display models with advanced rendering 
techniques. The shading along the surfaces is continuous and fine-grained. Use this drawing 
style to produce the most convincing results. When you choose realistic shading, the next 
three options become available.
· Shadows. Choose this button if you want to display shadows.
· RayTracing. Select this option for high-quality rendering that includes reflections and 

refracted light.
· Antialiasing. Choose this option for high-quality rendering that smooths jagged edges.
Annotation dimensions. Choose Show to include annotation dimensions with your models.
Use the Font Size option to set the font size for the annotation dimension.
Make background transparent. Choose this option to make the page background 
disappear. 
Draw page border. Select this option to display a border around the edges of the page.
Draw model edges. Use this option if you want TriSpectives to display colored lines on the 
edges of a model.



Interaction tab
These options determine how an object behaves when you click and drag it.

Double-click action
These properties control what happens after you double-click a shape. The default action 
depends on the type of shape you double-click:
Type of shape Double-click default action
Text shape Edit Text
Embedded object Edit Embedded Object
Any other shape Edit Properties
Default action 
Edit shape properties 
Edit text 
Edit embedded object 

Drag positioning behavior
These options govern what happens when you drag a shape within a page or scene. The 
default for a model is to move freely in space. The default for a shape is to slide along the 
surface of its landing shape.
Slide along surfaces 
Move freely in space 
Fixed position 

Post-drop action properties
These properties determine how an object behaves when you drop it on the page or scene.
None (default) 
Edit shape properties 
Edit text 
Edit embedded object 



Background tab
By default, the page and the scene provide a neutral backdrop for your models and 
illustrations. The page is white and the scene is gray. If you want another color, or a graphic 
image, change the background properties.
Solid Color. Choose this option if you want to use a homogenous color for the page or 
scene background.
Color. Choose a color sample from this display. The color you select forms a solid 
background on the page or scene.
More colors. Choose this button if you want a wider selection of colors or if you want to 
create a custom color. TriSpectives displays the Color dialog box.
Image Texture. Select this option if you want to use a graphic image for the page or scene 
background.
Image File. Enter the name of the graphic image file. If you want to select a file from a 
directory listing, use Browse.
Browse. Choose this button to choose a graphic file for the background of the page or 
scene. TriSpectives displays the Select Image File dialog box.
Stretch image to fill page or scene. If you want the graphic image to cover the whole 
background, choose this option. TriSpectives expands the image as much as necessary.
Preserve ratio of image height to width. Choose this option if you want to keep the 
height of the image proportional to its width. This option reduces distortion in photos and 
other realistic images.
Repeat image to fill page or scene. Choose this option to create multiple copies of the 
image. TriSpectives duplicates the image enough times to cover the page or scene.
Number of horizontal repeats. If you chose the previous option to make multiple copies 
of the image, you can specify the number of times an image is repeated horizontally. The 
aspect ratio is preserved and the image is repeated vertically to fill the page or scene.
Smooth image. Check this box to smooth out any blockiness in a background image, which
can happen when the original image file is small.



Coarse
Choose this option for coarse lines suitable for drafts or sketches.



Normal
Use this option to get normal quality output.



Fine
Choose this setting for the best quality drawings.



Show Dimensions
Check this box if you want to see measurements next to the lines in the drawing.



Visible lines
Choose filled, dashed, or dotted lines. TriSpectives uses this style for the visible lines in a 
drawing. These lines are the edges that would be visible if the object were solid.



Hidden lines
Choose filled, dashed, or dotted hidden lines in the drawing. These lines would be concealed 
if the object were solid.



Visible silhouettes
Use this menu to choose a line style for the visible silhouettes in the drawing. A silhouette is 
a curved surface that appears as an edge. Visible silhouettes would be in view if the object 
were solid.



Hidden silhouettes
From this menu, choose a line style for the hidden silhouettes in the drawing. A silhouette is 
a curved surface that appears as an edge. Hidden silhouettes would be invisible if the object
were solid.



Create new
Choose this option if you want to insert an object with new data into your document. You can
insert any object in the Object Type list. 



Object type
Choose an object type from this list. Each entry shows the name of a program and one of the
kinds of data it can create. Select an entry to launch the program and create new data.



Create from file
Use this option if you want to embed existing data into a TriSpectives document.



Browse
Choose this button to select a file with the data you want to embed in your TriSpectives 
document. 



Link
Check this box to establish a link between the embedded object in TriSpectives and the 
original file. When the two are linked, changes to the original file appear within TriSpectives.



Display as icon
Check this box to display the embedded object as an icon. Otherwise, it appears in its native
format.



Origin parameter
The origin is a location within the animated model. It’s the focus for several animation 
effects including rolling, panning, tilting, and scaling. For instance, when you tilt a model, it 
tilts around the origin. 
Using the following options, specify the location of the origin relative to the anchor of the 
model. For example, the anchor of a model car might be near its wheels. If you want the car 
to roll around its side, enter the distance between the side of the car and its wheels in the 
following fields.
L. Enter the distance between the anchor and the origin, measured along the anchor’s 
forward direction.
W. Enter the distance between the anchor and the origin, measured along the anchor’s 
sideways direction.
H. Enter the distance between the anchor and the origin, measured along the anchor’s up 
direction.



Position parameter
The Position parameter sets the position of an animated model at the time the key occurs. 
The position is relative to the model’s anchor point measure along the up, forwards, and 
sideways directions defined by the anchor.
L. Enter the distance between the animated object and the location of the anchor along the 
anchor’s forward direction.
W. Enter the distance between the animated object and the location of the anchor along the
anchor’s sideways direction.
H. Enter the distance between the animated object and the location of the anchor along the 
anchor’s up direction.



Scale parameter
The Scale parameter determines the apparent size of the animated object. Its physical 
dimensions don’t change, just its scale within the display.
Enter the scale of the animated model. For example, if you want an object to appear twice 
its normal size, enter 2.



Orient at parameter
The Orient at parameter points the animated object in a particular direction. You can point 
the object at one spot, orient it along a direction or an axis, or keep it oriented along the 
path of animation. The path is the line or curve that connects the keys.
L. Enter the component of the Orient At direction measured along the anchor’s forward 
direction.
W. Enter the component of the Orient At direction measured along the anchor’s sideways 
direction.
H. Enter the component of the Orient At direction measured along the anchor’s up direction.



Orient Up parameter
The Orient Up parameter determines which direction is up during an animated sequence. 
You can specify a point, axis, or the tangent of the animation path.
L. Enter the component of the Orient Up direction measured along the anchor’s forward 
direction.
W. Enter the component of the Orient Up direction measured along the anchor’s sideways 
direction. 
H. Enter the component of the Orient Up direction measured along the anchor’s up direction.



Tilt parameter
Use the Tilt parameter to rotate an animated model around the anchor’s forward direction.



Roll parameter
Use the Roll parameter to rotate an animated model around the anchor’s sideways direction.



Pan parameter
Use the Pan parameter to rotate an animated model around the anchor’s up direction.



Slope angle
Enter the angle for the slope of the line.



Length
Enter the length of the line.



Bevel tab
Beveling changes the shape of a model along its edges. In TriSpectives, you can bevel by 
blending and chamfering.
Blend. Choose this option to round the sharp angle of an edge to a smooth surface.
Chamfer. Choose this option to cut off the sharp angle of an edge at a diagonal. The result 
is two edges that are less sharply angled than the original.
Use the following controls to blend or chamfer the edges of an IntelliShape or model.
Set bevel for (IntelliShapes). You can bevel five sets of edges on an IntelliShape:
· All intersection edges. Shape edges created by intersecting other shapes in the 

model.
· End section edges. Edges that lie on the end section of the shape. See Shape sections 

for a description of end sections.
· Start section edges. Edges that lie on the start section of the shape. See Shape 

sections for a description of start sections.
· Side section edges. Edges that lie on the surface between the start and end sections 

of the shape.
When you choose an edge, TriSpectives displays its current bevel type on the page.

Set bevel for (Models). You can bevel two sets of edges on a model:
· All edges. All edges of the model
· All intersection edges. Model edges created by intersecting shapes within the model.

When you choose an edge, TriSpectives displays its current bevel type on the page.
Note: When you want to bevel a shape and a model, TriSpectives bevels first the shape, 
then the model.
No bevel. Select this option for no beveling or to remove beveling from the selected object.
Blend. Choose this option to blend the edges of the selected edge set. 
Radius. If you choose the Blend option, enter the radius of the circle that forms blended 
edges. As the radius increases, the blending becomes more gradual.
Chamfer. Choose this option to chamfer the edges of the selected edge set. The angle of 
the chamfer is controlled by the setback right and setback left parameters. When two 
adjacent faces meet at the edge, you can chamfer that edge. 

What’s right and left depends on the sequence of edges, which you can determine through 
experimentation.
By default, TriSpectives chamfers an edge at a 45 degree angle. In other words, the two 
edges that appear after the chamfer operation each have an angle of 45 degrees. Use the 
next two options if you want unequal angles for the two edges. 
Inset Right. Enter a distance. When the chamfer operation is complete, one of the two new 
edges has this distance from the original edge. You can determine which is the left edge and 



which is right through experimentation.
As you look in the direction of the edge, the setback right parameter is the perpendicular 
distance away from the edge along the right face at which the chamfer diagonal meets the 
right face.
Inset Left. Enter a distance. When the chamfer operation is complete, one of the two new 
edges has this distance from the original edge. You can determine which is the left edge and 
which is right through experimentation.
The setback left parameter is the perpendicular distance away from the edge along the left 
face where the chamfer diagonal meets the left face.
Show Formulas. To see the expressions that produce values on this property sheet, check 
this box.

Single-edged IntelliShapes
Bevel IntelliShapes with a single edge have an additional option:
Variable blend 
Start radius 
End radius 

Modeling exception
You cannot apply a chamfer if the surfaces on which the edges lie are non-conic or non-
planar. You cannot chamfer the edges of a free-form surface such as those generated with a 
loft.



General tab
These options apply to the model and motion segments as well as the group segment. 
Name. Enter a name for the segment.
Type. This read-only field contains “Track Group,” “Motion Effect,” or the kind of object in the 
segment.
Track Start Time (relative). Enter the starting time of a motion effect relative to the 
beginning of the entire segment.
Length (secs). Enter the length of the animated sequence in seconds.



Time Effect tab
Use these properties to control how an object moves during animation. Although the 
properties affect the behavior of the animated object, they apply to motion effects. The Time
Effect tab doesn’t appear on the property sheet for the model segment or group segment.
Type. Choose a time effect from this pull down list. The choice you make determines the 
other options that appear on this property sheet.
Repeats. In this box, enter the number of times you want the motion effect to repeat during
the animation. Enter a number directly or use the arrow buttons to increase or decrease the 
value.
Lap. Check this box if you want each repetition of the motion effect to move forward. The 
result is continual cycles of identical motions.
Reverse. Check this box if you want successive repetitions of a motion effect to cycle back 
and forth. The result is continual oscillation.
Strength. Use this control to set the time when the speed of the animated object changes. 
This control works in conjunction with the Accelerate, Decelerate, EaseIn, EaseOut, and 
EaseBoth effects. Enter a number between 0 and 1 in the field or use the slider to select a 
value. If you enter 0, the change occurs at the beginning of the effect. The value 1 places 
the change at the end.



Annotation tab
Use the fields on this tab to add labels or other text to the value in the Annotation 
Dimension.
Prefix text. Enter a label or other text. The text appears before the value in the Annotation 
Dimension.
Postfix text. Enter a label or other text. The text appears after the value in the Annotation 
Dimension.



General tab
Type field. Shows the classification of the selected object.
System name field. Shows the unique name that TriSpectives assigns to every object in a 
document. For example, the two IntelliShapes in a model might be Shape1 and Shape2.
TriSpectives uses the system shape name to reference specific variables of a shape when 
writing formulas. The system name is also the default user name.
User name field. Enter a custom name. TriSpectives uses this name to reference a shape in
the WorkBook Browser. For example, you might create a model house with individual shapes 
named Roof, Window, and so forth.
Link Status field. Shows the value LINKED or NOT LINKED. 
LINKED indicates that the selected shape is a copy linked to its original. Linked shapes look 
identical. When you change one shape in a linked set, you change all shapes in the set. 
Once you link a shape, you can only unlink it by choosing Undo from the Edit menu.
Note: TriSpectives only links geometry and style properties, such as color and transparency,
in its linked shapes.
NOT LINKED indicates the selected shape is unique. If you change an unlinked shape, you 
change only that shape.
Apply cross-section to loft shape. Check this option if you want TriSpectives to use the 
cross-section to generate the loft IntelliShape.
Relative distance from start of path. Enter the distance between the cross-section and 
the beginning of the path. The path is the line or curve that connects the cross-sections in a 
loft shape. Enter the value of 0 to place the cross-section at the start of the path, and 1 for 
the end. Use intermediate values for other locations.
Orientation angle about path. Enter the angle of the cross-section relative to the tangent
of the plane at the point of intersection. The axis of rotation is perpendicular to the surface 
of the cross-section. The center of rotation is the point where the cross-section intersects the
path. The path is the line or curve that connects the cross-sections in a loft shape.
Show Formulas. To see the expressions and variables that produce the values on this 
property sheet, check this box.



Catalog set name
Enter the name of a new catalog set. If you’re editing an existing set, its name appears here.



List of catalogs
This list shows the catalogs available to define a new set, or the contents of an existing set.



Update
Choose this option to update the catalog set by reflecting the changes you make on this 
dialog box.



Add
Select this button to add a catalog to the set. TriSpectives displays the Select Catalog File 
dialog box.



Remove
Use this option to remove a catalog from the list. Choose a catalog in the list and then select
this button.



Move up
Use this option to reorder the catalogs in the set. Select a catalog in the list and choose this 
button to move the catalog up one level. The catalog browser in the main TriSpectives 
window reflects the new order.



Move down
Use this option to reorder the catalogs in the set. Select a catalog in the list and choose this 
button to move the catalog down one level. The catalog browser in the main TriSpectives 
window reflects the new order.



Value
Enter a new distance or angle value. When you return to your model, its features reflect the 
new measurement.



Lock
Check this box if you want to lock the value of the SmartDimension. You can then drag the 
object, but the locked SmartDimension constrains how the object moves.



Next section
Choose this option to work with the next cross-section in the loft shape.



Previous section
Use this option to work with the previous cross-section in the loft shape.



Finish shape
Select this button to finish the lofting process and create a 3D shape from the cross-sections.



Options
When you choose this button, TriSpectives displays the Loft Edit Options dialog box. 



Length
Enter the length of the sizebox.



Width
Enter the width of the sizebox.



Height
Enter the height of the sizebox.



About sizebox center
Choose this option to resize the object symmetrically about the center point of the sizebox.



About anchor
Choose this option to resize the object symmetrically about its anchor point.



From opposite handle
Choose this option to resize the object by dragging one surface towards or away from the 
handle on the opposite surface.



Handles
Choose this option if you want TriSpectives to display shape handles.



Box
Choose this option if you want TriSpectives to display an outline for the sizebox.
Note: Turning on the box or handles for the first time for a new model or group 
automatically resets the sizebox.



None
Choose this option for no aspect locks. You can drag any handle to resize the object in one 
direction without changing it elsewhere.



Length and width
Choose this option to preserve the ratio between length and width. When you change one 
measurement, the other changes in proportion.



Length and height
Choose this option to preserve the ratio between length and height. When you change one 
measurement, the other changes in proportion.



Width and height
Choose this option to preserve the ratio between width and height. When you change one 
measurement, the other changes in proportion.



All
Choose this option to preserve the ratio of all dimensions. When you change one 
measurement, they all change in proportion.



Show Formulas
To see formulas instead of their resulting values, check this box.



Along length L
Enter the distance on the length axis between the anchor or attachment point and the 
corner of the sizebox.



Along width W
Enter the distance on the width axis between the anchor or attachment point and the corner
of the sizebox.



Along height H
Enter the distance on the height axis between the anchor or attachment point and the 
corner of the sizebox.



L
Enter a value between 0 and 1 to to define the length measurement on the axis of rotation.



W
Enter a value between 0 and 1 to define the width measurement on the axis of rotation.



H
Enter a value between 0 and 1 to define the height measurement on the axis of rotation.



By this angle
Enter the angle of rotation.



Default action
Use this option if you want an object to behave in its normal fashion when you double-click 
it. For example, when you double-click a model, you normally see the property sheet for the 
model. When you double-click an embedded scene or page, it expands into its own window.



Edit shape properties
Choose this option if you want an object to display its property sheets when you double-click
it.



Edit text
Select this option to see an editing box when you double-click an object.



Edit embedded object
Choose this option if you want to work on an embedded page or scene when you double-
click it. The page or scene expands into its own window.



Slide along surfaces
Choose this button when you want two connected objects to stay attached. You can drag one
object across the other, but not off its surface.



Move freely in space
Use this option if you want to drag the object anywhere on the page or scene.



Fixed position
Choose this option to keep the object in one place.



None (default)
Select this option if you want the object to perform its default function when you drop it. For 
example, when you drop a text shape on the page, TriSpectives displays an editing box. 
When you drop a shape, it falls into place without further actions.



Edit shape properties
Use this option if you want the object to display its property sheet after you drop it.



Edit text
Select this option if you want to see a text editing box after you drop the object.



Edit embedded object
Choose this option to edit a scene after you drop it on the page. The scene appears in its 
own window.



Shell tab
Use the controls on this page to perform the shelling process. 
Shell this shape. Check this box if you want to hollow out the selected shape, leaving a 
thin wall.
Wall thickness. The width of the shape’s walls after the shelling process. Enter a value 
greater than 0.

End conditions
End section open. Check this box if you want the shelling process to extend through the 
end section of the shape, leaving it open.
Start section open. Check this box if you want the shelling process to extend through the 
start section of the shape, leaving it open.
See Shape sections for more information on start and end sections.

Advanced options
Stop shelling at model surface. Check the Start section box if the start section extends 
into the surface of another shape, but you want the hollow shelled space to stop when it 
meets the other shape’s surface. Check the End section box if the end section extends into 
the surface of another shape, but you want the hollow shelled space to stop when it meets 
the other shape’s surface.

Multi-shape shelling
Use these options if you want to extend the shelling process beyond the normal limits of the 
start and end sections. This technique is useful for spinning two shapes into a single hollow 
model. 
For example, suppose you want to construct a model of a storage tank from two shapes: a 
large drum connected to a pipe. You can shell out both shapes to make them hollow. 
However, even if you leave both ends of the pipe open, it will still be blocked by the wall of 
the tank. To get a clear passage into the tank, you can extend the shelling process for the 
pipe by a number of units equal to the thickness of the tank walls. For instance, if the tank 
walls are five units thick and the pipe walls are one unit, you can enter 5 as the start or end 
offset on the pipes shelling page. The result is a continuous hollow space extending from the
tank into the pipe.
Start offset. Enter the extra shelling distance beyond the start section. 
End offset. Enter the extra shelling distance beyond the end section. 
For subtracting material shape, shelling adds material around the original shape. The offset 
indicates reducing shelling distance from the start or end section.
Show Formulas. To see the expressions and variables that produce the values on this 
property sheet, check this box.

See also:
Shape sections 
Modeling exceptions



Surface Reshaping tab
Use the controls on this page to modify a surface of an IntelliShape. You can reshape a 
surface by tapering, capping, or matching. 
Which surface. Select the surface you want to modify: End Section, Start Section, or Side. 
For more information on start and end sections, see Shape sections.

Modeling options
No Reshaping. Choose this option if you don’t want any surface reshaping.
Cap. Select this option to add a rounded top to a shape.
Height. Enter the height of the cap in this field.
Taper. Choose this option if you want to taper a surface. The effects of tapering depend on 
the setting of the Which surface option.
When you taper the sides of a shape, the Tilt angle controls how fast the sides converge or 
diverge from the start section to the end section along the sweep axis of the IntelliShape. 
The start section always remains unmodified, but the end section is scaled to accommodate 
the taper.
When you taper the end section of a shape, the Tilt angle and the Orientation angle control 
how steeply the section surface tilts and along which direction. Tapering extends the end 
section with a chisel-like shape. The direction of the taper is defined by the Orientation 
angle.
Tilt angle. Enter an angle in this field. The end section tilts by this angle to form a chisel-
like shape. The side tapers toward the end section by this angle.
Orientation angle. Enter an angle in this field. This value defines the start point of the 
taper direction. Use the value 0 for the length coordinate axis of the cross-section shape. 
Match. Use this option to make the start or end section of a shape’s surface match the 
surface of the shape it lands on. For example, if you drop a block on a cylinder, use this 
option to make the intersecting face of the block curve around the cylinder.
Make opposite ends match. Select this option to make the start and end sections of the 
shape match. Use this option when you select the Match option for the end section or the 
start section, but not both.



Cross-Section tab
A cross-section is a 2D figure that TriSpectives uses to generate the form of an IntelliShape. 
When you create a new shape, you begin by drawing a 2D cross-section. TriSpectives 
extends this section into the third dimension through extrusion, spinning, or sweeping.
The lofting process requires two or more cross-sections. Loft shapes have their own version 
of this property page. For details, see the Cross-Sections tab.
Properties. Select this button to work with the cross-section for the current shape. 
TriSpectives displays the Cross-Section Properties sheet.



Cross-Sections tab
A cross-section is a 2D profile used to generate an IntelliShape. Lofting, unlike the other 
model creation processes, requires two or more cross-sections. It also requires a path¾which
can be a line, arc, or Bezier curve. Position the individual cross-sections along this path. 
During the lofting process, TriSpectives generates a shape by computing a surface which 
forms a skin over the path skeleton of the cross-section.

Align all cross-sections along path
Perpendicular to path. Choose this option if you want TriSpectives to orient each cross-
section perpendicular to the tangent of the path at the point where the two intersect.
Parallel to first cross-section. Choose this option if you want orient all the cross-sections 
so they are parallel to the start (first) cross-section.

Cross-section
Select cross-section. Choose the cross-section you want from this drop-down list.
Properties. Choose this button to work with the cross-section that appears in the Select 
cross-section box. TriSpectives displays the Cross-section Properties sheet of the path. The 
path, like the cross-section, is a 2D profile and the properties of the path and cross-section 
differ only in the number of curves in the outline tab.

Cross-section matching
During the generation of a loft shape, each point on a cross-section is matched with 
corresponding points on adjacent cross-sections. Each cross-section should have the same 
number of points so that correspondences are one to one and unique. If cross-sections do 
not have the same number of points, then you must split the curves in the cross-sections 
with fewer points so that they match the cross-section with the maximum number. The 
following options allow you some control over how to split the curves:
Automatic. Choose this option if you want TriSpectives to use its own internal algorithm to 
split cross-sections if necessary.
Manual. Choose this option if you want to split the cross-sections yourself using the edit 
cross-section tools. Be sure the number of points on all cross-sections are the same before 
splitting.

Path
Properties. Select this button to see the Cross-Section Properties sheet.



Attachment points tab
Select the attachment point you want to edit from the drop-down list, then change the 
values listed below.

Distance from sizebox corner
The first set of attachment point properties determines the position of the attachment point. 
The three measurements indicate how far the attachment point is from the corner of the 
sizebox of this object.
Along length L 
Along width W 
Along height H 

Orientation
These properties let you rotate the attachment point so that an object lands at a particular 
angle when you drop it into the scene or page.
L 
W 
H 
By this angle 
TriSpectives computes some values on this property sheet from formulas. If you’re interested
in the underlying formula, you can change the display to see variables, constants, and 
calculations that produce a particular number.    
Show Formulas 



General tab
Type field. Shows the classification of the selected object.
System name field. Shows the unique name that TriSpectives assigns to every object in a 
document. For example, the two IntelliShapes in a model might be Shape1 and Shape2.
TriSpectives uses the system shape name to reference specific variables of a shape when 
writing formulas. The system name is also the default user name.
User name field. Enter a custom name. TriSpectives uses this name to reference a shape in
the WorkBook Browser. For example, you might create a model house with individual shapes 
named Roof, Window, and so forth.
Link Status field. Shows the value LINKED or NOT LINKED. 
LINKED indicates that the selected shape is a copy linked to its original. Linked shapes look 
identical. When you change one shape in a linked set, you change all shapes in the set. 
Once you link a shape, you can only unlink it by choosing Undo from the Edit menu.
Note: TriSpectives only links geometry and style properties, such as color and transparency,
in its linked shapes.
NOT LINKED indicates the selected shape is unique. If you change an unlinked shape, you 
change only that shape.
Facet resolution. Increase or decrease the number of facets TriSpectives uses to facet a 
model. The more facets, the smoother the surface of the model.
The General tab of the cross-section IntelliShape used to generate the Loft IntelliShape also 
includes the Loft Shape Cross-Section options.



Light tab
Light On. Check this box if you want the spot source to emit light.
Intensity. To make the light brighter or dimmer, enter an intensity value. The larger the 
value, the brighter the light.
Color. To change the color of the light that this source emits, select one of the color samples
on this palette.
More Colors. Choose this option to select from a larger color palette or to define a new 
color. TriSpectives displays the Color dialog box.
Show Formulas. To see the expressions that produce some of the values on this property 
sheet, check this box.
Cast shadows. Check this box if you want the light coming from the source to cast 
shadows.
Advanced Settings. If you want to change the appearance of the shadows cast by the light
source, choose this button. You see the Advanced Shadow Settings dialog box..
Cone angle. Enter the angle of the cone of light that comes from the source. The light in 
this cone is uniform in intensity. There may be dimmer light outside the cone, depending on 
the value in the next field.
Fall off angle. Use this option if you want light to extend beyond the cone defined in the 
previous field. The angle you enter is the one between the light cone and the cone of 
darkness. For a razor-sharp spot light, make this value 0. If the fall off angle is larger, the 
space between the two cones contains light that diminishes in intensity as it approaches the 
outer boundary.
Concentration. Use this field to control the concentration of the light within the area of the 
two cones defined by the previous two options. Enter higher values for more concentration.



Color/Fill color tab
Use the options on this tab to apply a solid color or texture to a surface or model. The Fill 
Color tab appears for a 2D shape. Neither tab appears for an embedded page.
Solid color. Choose this option if you want to apply a uniform color to the surface or model. 
To select a color, click one of the boxes in the palette beneath this option.
More Colors. To choose a color that doesn’t appear on this property sheet, or to create a 
custom color, choose this option. TriSpectives displays the Color dialog box.
Image Texture. Choose this option if you want to apply a bitmap image to the surface or 
model.
Image file. Enter the name of the image file, or use the next option to search for a file.
Browse files. To locate and select an image file, choose this option. TriSpectives displays 
the Select Image File dialog box.
Box normal. Choose this option if you want to project the image onto the surface or model 
using the box method. For more information on this technique, see Box Projection dialog 
box. 
Slide projector. Choose this option if you want to cast the image onto the surface or model
using the slide projection method. For more information on this technique, see Slide 
Projection dialog box. 
Cylindrical. Choose this option if you want to project the image onto the surface or model 
using the cylindrical mapping method. For more information on this technique, see 
Cylindrical Mapping dialog box. 
Spherical. Choose this option if you want to project the image onto the surface or model 
using the spherical mapping method. For more information on this technique, see Spherical 
Mapping dialog box. 
Settings. Select this button to control the placement and orientation of the image. 
TriSpectives displays a dialog box for one of the image projection methods.



Finish tab
These settings determine how a surface or model reflects light.
Predefined finishes. If one of these illustrations looks like the surface finish you want, click
its box. These predefined finishes offer realistic results without trial and error. Each selection 
produces a unique combination of settings for highlight intensity, highlight spread, and 
diffusion intensity. You can also adjust these settings manually using the next three controls.
Diffuse intensity. Use this control to adjust the brightness of the reflected light across the 
object. Drag the slider and observe the results in the Preview box. You can also enter a value
between 1 and 100 in the field next to the slider.
Highlight intensity. Use this control to change the brightness of the highlight on the 
surface or model. 
Highlight spread. Use this control to make the highlight bigger or smaller.
Reflection intensity. Use this control to adjust the intensity of the reflected image on the 
surface of the object. For more information, see Reflection Effect tab.
Metallic highlight. Check this box to create a highlight that gives a metallic look to the 
surface finish.



Reflection Effect tab
Use these options to simulate reflections on a surface or model by reflecting a bitmapped 
image. Unlike the real reflections computed by Ray Tracing, the simulated reflections you 
select on this tab do not reflect other models in the scene. The intensity of the reflection is 
determined by the Relfection intensity set on the Finish tab.
Note: To see real reflections, select the Ray Tracing option from the Rendering tab on the 
property sheet for the scene or page.
None. Choose this option if you don’t want reflections on the surface or model.
Reflect image. Choose this option if you want the object to reflect an image.
Image file. Enter the name of the image file or use the next option to search for a file.
Browse files. To locate and select an image file, choose this option. TriSpectives displays 
the Select Image File dialog box.
Mirror Horizontally. If you want the reflected image to appear reversed as in a mirror, 
check this box.



Transparency tab
If you want to see through one surface of your model¾or make the whole object 
transparent¾use the settings on the Transparency tab. These options let you create 
windows, lenses, water, and other transparent items.
Predefined Transparency. If one of these illustrations shows the degree of transparency 
you want, click its box. Each selection changes the setting of the Transparency slider.
Transparency. Use this control to make the object more or less transparent. Drag the slider 
or enter a value between 1 and 100 in the field.
Index of Refraction. If you want the transparent object to bend the light that passes 
through it, use this control. Drag the slider to adjust the amount of bending or enter a value 
between 1 and 2.5 in the field.
Note: To see refraction, select the Ray Tracing option on the property sheet for the scene or 
page. It’s one of the selections on the Rendering tab.



Line style tab
These options control the appearance of the line on the edge of a 2D shape. (This tab 
doesn’t appear for a model or embedded page.)
Line Color. Choose a color from this selection. TriSpectives applies the color to the edge of 
the shape.
More Colors. Select this button if you want to choose from a larger selection of colors or 
define a custom color. TriSpectives displays the Color dialog box. 
Line Pattern. Choose a line style from this drop-down list. TriSpectives uses this style to 
draw the line around the edge of the shape.
Fill outlines. Check this box if you want to fill the 2D shape with a solid color. Clear the box 
to see the edge outline by itself.



Text tab
Text Depth: Use this field to make the 3D text thicker or thinner. Enter a large number for 
thick text or a small number for thin text.
Bevel type. Choose a bevel style from this drop-down list. Your choice affects the edges of 
the text. The selections are:
· No Bevel. This style produces 90-degree edges.
· Flat. This style produces a chamfer or chiseled effect.
· Round. This style produces convex edges.
· Inverted Round. This style produces concave edges.
Depth. Use this option to control the amount of beveling. Enter a depth value in the field. 
The higher the value, the more beveling occurs.
Scale. Enter the scale of the bevel, which is the ratio of the bevel height to its thickness. 
If you have a flat bevel, the scale value is 1 by default, which means the height of the 
beveled edge equals its thickness. If you decrease the scale to 2, the bevel edge has the 
same thickness, but the amount the bevel extends beyond the outline of the text doubles. If 
you make a round bevel with a bevel thickness equal to half of the text depth (which is as 
large as you can make this thickness, since each letter has two bevels, front and back), the 
letters are fully curved on the sides, looking inflated. To retain the roundness, but decrease 
the amount of inflation, set a smaller scale.
Smoothness. This option applies to the Round and Inverted Round bevel types. It 
determines how many polygons are used along the thickness of the bevel to represent it. A 
higher number creates a more geometrically smooth surface and silhouette. 
Show Formulas. Check this box if you want to see the expressions and variables that 
produce the values on this property sheet.
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Fillet dialog box 
Flip Anchor dialog box 
Flip Attachment Point dialog box 



G
Grid Settings dialog box 
Group Properties sheet 



H
Hidden Line Settings dialog box 



I
Insert Model File dialog box 
Insert Cross-Sections dialog box 
Insert Light dialog box 
Insert Object dialog box
Insert Page dialog box 
Insert Scene dialog box 
IntelliShape Properties sheet 



K
Key dialog box 



L
Line dialog box 
Loft Edit Options dialog box 
Loft Shape wizard 



M
Model Properties sheet 
Move Anchor dialog box 
Move Attachment Point dialog box 



O
Open dialog box 
Options dialog box 



P
Page Properties sheet 
POV 2.x Write dialog box 
Print dialog 



R
Raw Triangle Read dialog box 
Raw Triangles Write dialog box 
Rename page dialog box 
Rename scene dialog box 
Reset sizebox dialog box
Resolution Selection dialog box 



S
Save As dialog 
Scene Properties sheet 
Scene: Rename Page/Scene dialog box
Segment Properties sheet 
Set Operation dialog box 
Shape Properties sheet 
Slide Projection dialog box 
Spherical Mapping dialog box 
Spin dialog box
Spin Anchor dialog box 
Spin Attachment Point dialog box 
Spin shape wizard 
Spot Light Properties sheet
Stereolithography Read dialog box
Stereolithography Write dialog box 
Style Properties 
Surface Properties sheet
Sweep Shape wizard 



T
Text Properties sheet 
Toolbars dialog 



V
VRML 1.0 Write dialog box 



W
Wavefront OBJ Write dialog box 
Welcome dialog 
WorkBook Wizard 



Z
Zoom dialog box 



Name
Choose a printer from this drop-down list. The list contains all the printers that are installed 
in Microsoft Windows.



Number of copies
Enter the number of printed copies you want in this box. Enter a value directly or click the 
arrow buttons to increase or decrease the value.



Add material
Choose this option if you want the selected model to be a solid object. When you drop it on 
another object, it adds material to that object.



Remove material
Choose this option if you want the selected model to be a hole. When you drop it on another 
object, it removes material from that object.



Projected image size
Width. Enter the width of the image on the surface of the model.
Height. Enter the height of the image on the surface of the model.
Preserve aspect ratio. Check this box if you want the height and width of the projected 
image to maintain the proportions of the original.



Projected image location
Width offset. Use this field to shift the projected image horizontally. Enter the horizontal 
distance between the new center of the image and the point where you dropped it on the 
model. For example, if an image is 100 units wide and you want to shift it horizontally by half
that amount, enter 50.
Height offset. Use this field to shift the projected image vertically. Enter the vertical 
distance between the new center of the image and the point where you dropped it on the 
model. For example, if an image is 100 units tall and you want to shift it vertically by half 
that amount, enter 50.
Rotation. Use this option to rotate the image. Enter the angle of rotation for the projected 
image. The angle is relative to the orientation of the original image.
Flip left/right. Check this box if you want TriSpectives to invert the projected image so that 
it mirrors the original.



Orientation
Origin. Use these fields to specify the location of the slide projector.
Projection direction. Use these fields to specify which direction the slide projector is 
pointing.
Up direction. Use these fields to set the direction for the top of the image. Enter 1 in the 
field for axis that points up and down and 0 in the other fields.



Projected image size
Horiz. ratio. Enter the number of times you want to repeat the image horizontally around 
the sphere. In general, use a whole number to avoid seams in the image.
Vert. ratio. Enter the number of times you want to repeat the image vertically around the 
sphere.



Projected image location
Horiz. angle. Use this control to shift the field horizontally. To shift the image by a 
percentage of its width, enter the corresponding fraction of 360°. For example, to shift the 
image horizontally by half its width, enter 180.
Vert. angle. Use this control to shift the field vertically, similar to the latitude lines on a 
globe. To move some feature from the south pole to the equator, for example, enter 90 
degrees.
Flip left/right. Check this box if you want TriSpectives to invert the projected image so that 
it mirrors the original.



Orientation
Origin. Enter three coordinates in these fields to specify the point in space where the 
projection originates.
Up direction. Use these fields to set the direction for the top of the image. Enter 1 in the 
field for axis that points up and down and 0 in the other fields.



Path tab
When you animate a model, you define the conditions that occur at important moments 
during the animation. These key moments control what happens during the rest of the 
animated sequence. 
For example, you could animate a model car by specifying its position at the beginning and 
end of the animation. This simple animation has two keys. TriSpectives fills in the gap 
between the keys with images of the car in intermediate positions. 
The entire sequence of events¾the keys and everything in between¾is the path of an 
animation. The Path properties let you set up keys and control the way TriSpectives connects
them. 
No. of Keys: This read-only field shows the number of keys in the current motion effect.
Current Key. To work with a particular key, enter its number in this box. You can also click 
the arrow buttons to select a key.
Key Setup. Choose this option to set the location of the model and other conditions that 
make the key unique. TriSpectives displays the Key dialog box. 
Key Start Time: To set the time when the key occurs, drag the slider. The read-only field 
next to the slider shows the number of seconds since the beginning of the effect.
Linear. Use this option if you want the animated model to move between two key positions 
along a straight line.
Spline. Select this option if you want the animated model to move between two key 
positions along a curve.
Orient At Type. Use this drop-down list to specify whether a moving object is oriented 
towards a point, a direction, or the path of motion. Choose Direction, Position, or Along Path 
from the list.
Orient Up Type. Use this drop-down list to specify which way is up for a moving object. As 
with the Orient At Type property, you can choose Direction, Position, or Along Path from the 
list.
Insert Key. Choose this option to add a new key in the animation.
Remove Key. Choose this option to remove the current key from the animation.



Bumps tab
A bumpy surface appears to have a 3D finish. Parts of the surface appear higher or lower 
than the rest of the object. Although TriSpectives can produce a very convincing illusion of 
bumpy surfaces, the bumps don’t really extend into 3D. To see the effect of the bumps you 
create, select the Realistic shading option on the Rendering tab of the Scene Properties 
sheet.
You can use bumps to simulate rust on a metallic object, continents on a planet, dimples on 
a golf ball, and other realistic surfaces.
This tab doesn’t appear for an embedded page.
No bumps. Choose this option if you want a flat surface.
Make bumps from color texture. Select this option if you want to create bumps from the 
image on the surface of the object. 
TriSpectives creates bumps by raising or lowering a pixel based on its brightness. You can 
control which pixels are raised or lowered as well as their distance from the surface by using 
the Bump Height option. The brighter pixels in the image appear to be higher than the 
darker pixels, unless you make the height negative. Technical tip: TriSpectives uses the 
brightness of the red color channel of the source image to determine the bump height.
Make bumps from image. Choose this option if you want to create bumps from an image 
that isn’t on the surface of the object. Select an image file using the following two controls. 
The image acts as a template for bumps, but does not otherwise appear on the object.
Image file. Enter the name of the image file or use the next option to search for a file.
Browse files. To locate and select an image file, choose this option. TriSpectives displays 
the Select Image File dialog box.
Box normal. Choose this option if you want to project the image onto the surface or model 
using the box method. For more information on this technique, see Box Projection dialog 
box. 
Slide projector. Choose this option if you want to cast the image onto the surface or model
using the slide projection method. For more information on this technique, see Slide 
Projection dialog box.
Cylindrical. Choose this option if you want to project the image onto the surface or model 
using the cylindrical mapping method. For more information on this technique, see 
Cylindrical Mapping dialog box. 
Spherical. Choose this option if you want to project the image onto the surface or model 
using the spherical mapping method. For more information on this technique, see Spherical 
Mapping dialog box. 
Settings. Select this button to control the placement and orientation of the image. 
TriSpectives displays a dialog box for one of the image projection methods.
Bump Height. Use this control to adjust the apparent height of the bumps on the surface of
the object. Drag the slider and observe the results in the Preview window. The slider goes 
from -100 to 100, but you can also enter larger or smaller values in the box. The sign 
determines whether a particular part of the image is raised or lowered. The magnitude sets 
the height.



Decal tab
A decal is a bitmapped image that behaves like a sticker. Use decals to place a logo, 
decoration, warning label, or other image on one part of a surface or model. When you place
a decal on a surface or model, you see a single instance of the image. Unlike textures, 
decals don’t create multiple copies of themselves to cover an object.
Each surface can have one decal. Use the Move Decal tool on the Tools menu the first time 
you place a decal.
Like a real sticker, a decal image can be opaque or transparent. When you create a 
transparent decal, you can see through the blank parts of the image to the object beneath. 
To create a transparent decal, specify a see-through color. This is the color in the decal 
image which becomes transparent.
The see-through color has three components—red, green, and blue—represented by the R, 
G, and B fields on this tab. Each field takes a color value between 0 and 255. For example, if 
you want the white parts of a decal to become transparent, enter the value 255 in each 
field.
No decal. Choose this option if you don’t want any decals to appear on the surface or 
model.
Decal from selected image. Choose this option if you want an image to appear on the 
surface or model as a decal.
Image file. Enter the name of the image file or use the next option to search for a file.
Browse files. To locate and select an image file, choose this option. TriSpectives displays 
the Select Image File dialog box.
Slide projector. Choose this option if you want to cast the image onto the surface or model
using the slide projection method. For more information on this technique, see Slide 
Projection dialog box. 
Cylindrical. Choose this option if you want to project the image onto the surface or model 
using the cylindrical mapping method. For more information on this technique, see 
Cylindrical Mapping dialog box. 
Spherical. Choose this option if you want to project the image onto the surface or model 
using the spherical mapping method. For more information on this technique, see Spherical 
Mapping dialog box. 
Settings. Select this button to control the placement and orientation of the image. 
TriSpectives displays a dialog box for one of the image projection methods.
Enable. Choose this option to create a transparent decal. 
R. G. B. Enter a color value between 0 and 255 to specify the red, green, or blue component
of the see-through color. Pure white is 255/255/255.



Distance
Select this option to add a SmartDimension for measuring distance.



Angle
Select this option to add a SmartDimension for measuring angles.



How many
Enter the number of SmartDimensions you want to add to your model.



None
Select this option for no beveling.



Constant blend
Choose this option to get a smoothly rounded edge.



Radius
Enter the radius of the circle that produces the constant blend.



Variable blend
Select this option to create a smooth rounded edge of continuous varying radii.



Start radius
The rounding radius at the start of a variable blend.



End radius
The rounding radius at the end of a variable blend.



Chamfer
Select this option to bevel an edge by slicing off or adding a section. The result is two edges 
that aren’t as sharply angled as the original.



Setback right
Enter a distance. When the chamfer operation is complete, one of the two new edges has 
this angle. You can determine which is the left edge and which is the right one through 
experimentation.



Setback left
Enter the complementary distance to the one in the Setback Right field. For example, if the 
previous field contains the value 10, enter 80. When the chamfer operation is complete, one 
of the two new edges has the angle in this field. You can determine which is the left edge 
and which is the right one through experimentation.



Number of new cross-sections
Enter the number of new cross-sections you want to add to the loft shape.



Insert after which section
Enter the number of a cross-section. TriSpectives inserts the new sections after this one.



Next cross-section
Check this box to display the current cross-section and the next one in the lofting sequence.



Previous cross-section
Check this box to display the current cross-section and the previous one in the lofting 
sequence.



All cross-sections
Check this box to display all the cross-sections that make up the loft shape.



Loft Wizard: Page 1
In the Cross-Sections field, enter the number of cross-sections you want to create in the 3D 
shape.



Loft wizard: Page 2
Choose one of the following cross-section types:
· Rectangles
· Circles
· Custom
Then choose one of the following path types:
· Straight line
· Curved arc
· Bezier curve



Loft wizard: Page 3
Select how the new shape affects existing models.
· Choose Stand alone if you want the new shape to exist apart from other shapes and 

models.
· Choose Add material if you want the new shape to be added to a model.
· Choose Remove material if you want the new shape to behave like a hole shape—

remove material from a model.



Sweep wizard: Page 1
Choose how you want the new shape to be oriented. 
· Choose Along the surface if you clicked the Sweep Shape tool on an existing shape 

and you want to orient the new shape on its surface.
· Choose Away from the surface if you don’t want to orient the new shape on the 

surface of an existing shape.



Sweep wizard: Page 2
Choose one of the following path types:
· Straight line
· Circular arc
· Bezier curve



Sweep wizard: Page 3
Select how the new shape affects existing models.
· Choose Stand alone if you want the new shape to exist apart from other shapes and 

models.
· Choose Add material if you want the new shape to be added to a model.
· Choose Remove material if you want the new shape to behave like a hole shape—

remove material from a model.



Spin wizard: Page 1
Choose how you want the new shape to be oriented. 
· Choose Along the surface if you clicked the Spin Shape tool on an existing shape and 

you want to orient the new shape on its surface.
· Choose Away from the surface if you don’t want to orient the new shape on the 

surface of an existing shape.



Spin wizard: Page 2
Select how the new shape affects existing models.
· Choose Stand alone if you want the new shape to exist apart from other shapes and 

models.
· Choose Add material if you want the new shape to be added to a model.
· Choose Remove material if you want the new shape to behave like a hole shape—

remove material from a model.



Orientation
Origin. Enter three coordinates in these fields to specify the starting point of the image. In 
general, this should be the center point of the object. If you’re working with decals, use 
these fields to specify the location of the lower left corner of the decal.
Projection direction. Use these fields to specify which direction the slide projector is 
pointing.
Up direction. Enter 1 for the axis that orients the image up and down. Enter 0 in the other 
fields.



Dimensions
Choose a dimension, such as Custom Size, from the drop down list.



Dots per inch
Enter the number of dots per inch you want in an animation frame, such as 150.



Output image size
See the size of the output image in pixels, such as 320 by 200.



Animation: Size
Units. Select the units of measurement you want to use, such as pixels.
Width. Enter the width of the animation frame in the units you selected.
Height. Enter the height of the animation frame in the units you selected.



Match aspect ratio of page
Check this box if you want to maintain the aspect ratio of the image as it appears on the 
page.



Split image between multiple files
If the animation file is large, use this option to split the image and reduce the memory you 
need during export. Check to see what TriSpectives recommends, then enter the number of 
files to use for this image.



Key frame frequency
A key is a critical moment in an animated sequence. Each key occurs at a particular time 
after the start of the animation. In addition, every key has a set of associated conditions that
define the state of the animation at that moment. Select how often you want the key frames 
to appear, such as 4. 



Rendering style
Wireframe. Choose this option to display models as wireframe drawings. A wireframe is a 
hollow form with a grid of lines for the surface. Wireframes have no surface covering, color, 
or texture.
Facet shading. Choose this option to display models with a single color on each facet. 
Models are approximated as objects composed of flat surfaces called facets for display.
Smooth shading. Select this button to display models as solid with smooth, evenly shaded 
surfaces.
Show textures. Check this box if you want surface textures to appear on the image. This 
option only applies to images that have textures, and only when the smooth shading option 
is active.
Realistic shading. Choose this option to display models in naturalistic lighting. The shading
along the surfaces is continuous and fine-grained. Use this drawing style to produce the 
most convincing results. When you choose realistic shading, the next three options become 
available.
· Shadows. Choose this button if you want to display shadows.
· RayTracing. Choose this option if you want high-quality rendering that displays 

reflections and refracted light.
· Antialiasing. Select this option if you want high-quality rendering with smooth edges.
Draw Edges. Choose this option to overdraw all edges with a solid color. This makes model 
edges prominent, even if you’ve selected other rendering options.
Allow Simplification. Choose this option to draw with lower-quality graphics techniques 
during periods of high interactivity. For example, when you’re using Orbit Camera, 
TriSpectives may need a long time to redraw each image. If you allow simplification, 
TriSpectives draws the intermediate images in wireframe, allowing faster feedback. Once the
demand is reduced, TriSpectives draws in the selected rendering style.



Compressor type
Select the type of compressor you want to use, such as Cinepak or Indeo 3.0.



Camera tab
Projection. Choose how you want the camera to view the objects in an embedded scene. 
These options are similar to the camera options for a regular scene or page. 
· Orthographic: Choose this option to display the contents of the embedded scene using 

an orthographic projection. This method shows the correct dimensions of an object with 
no illusion of depth.

· Fit to sizebox: Choose this option if you want to fit the contents of the embedded scene 
in its sizebox.

· Preserve length: Choose this option to display the items in the embedded scene using 
their actual sizes.

· Scale: Enter a scale value for displaying the contents of the embedded page.
· Perspective: Choose this option to view the objects from a perspective. Enter the field of 

view angle to use for the perspective.
Position. Enter the length, width, and height to set the position of the camera relative to 
the embedded scene.
Look At point. Enter the length, width, and height to set the orientation of the camera 
relative to the scene.
Up Direction. Use these fields to specify the angle for orienting the camera up and down. 
Enter a non-zero value for the axis you want to point up. Enter zero in the other fields.
TriSpectives computes some values on this property sheet from formulas. If you’re interested
in the underlying formula, you can change the display to see variables, constants, and 
calculations that produce a particular number.    
Show Formulas 



Orthographic
Orthographic projection is the two-dimensional graphic representation of an object formed 
by the perpendicular intersections of lines drawn from points on the object to a plane of 
projection.



VRML tip
To cut the exported file size by seven percent, save with a Unix end-of-line character.



Image export tip
If you can’t read the image into another application, try changing the compression scheme 
and color depth. 



End of line
Choose the type of computer you’ll use with the exported file. Your choices are PC, Unix, and 
Macintosh.



Convert to grayscale
Check this box to convert the exported file as a grayscale image.



Use RLE compression
Check this box to compress the file in the RLE format.



Size scale
Type a value to scale the exported image. For example, type 0.5 to make the exported 
image half as large as the original image in TriSpectives.



Rotate 90 degrees
Check this box to rotate the exported image 90 degrees.



Center on 8.5 x 11
Check this box to center the exported image on 8.5-in. x 11-in. paper.



Storage depth
Choose the option that requires the least storage space and maintains full colors in the 
image. Your choices are Minimize storage, 24 bits (full color), or 8 bits.



Interlaced
Check this box to interlace the image data, which makes it load progressively on the Web. In 
other words, the image quality improves with time.



Sorted colormap
Check this box to sort the colormap according to which colors are used most frequently in 
the exported image.



Quality
Choose the type of image quality you want. The higher the quality, the more storage space 
the file requires. Your choices are Draft, Low, Medium, High, and Highest. Medium quality 
creates AVI’s suitable for 1x CD ROMS. High quality creates 2x CD ROM speed, and highest 
creates 4x.



File type
Choose the type of operating system you’ll use with the exported file. Your choices are 
Microsoft Windows and OS/2. In general, use Microsoft Windows.



Export: Units
Enter the unit of measurement for the exported file, such as inches or centimeters.



Export: Width
If necessary, enter the height of the exported image.



Export: Height
If necessary, enter the height of the exported image.



Match aspect ratio of the page
Click this check box to make the aspect ratio of the exported image match that of the page.



Export: Options
Click this button to open a new dialog of image export options. These options differ 
depending on the file format you choose. See the individual help topics for information on 
the options in these dialogs.



Compression
Choose the type of data compression you want. Your choices are LZW, Packbits, or no 
compression.



Extrude wizard: Page 1
Choose how you want the new shape to be oriented. 
· Choose Along the surface if you clicked the Extrude Shape tool on an existing shape 

and you want to orient the new shape on its surface.
· Choose Away from the surface if you don’t want to orient the new shape on the 

surface of an existing shape.



Extrude wizard: Page 2
Choose the Next button to select how the new shape affects existing models.
· Choose Stand alone if you want the new shape to exist apart from other shapes and 

models.
· Choose Add material if you want the new shape to be added to a model.
· Choose Remove material if you want the new shape to behave like a hole shape—

remove material from a model.



Make all polygons convex
Choose this option to make all polygons convex, though this increases the model size.



Minimize output
Choose this option to decrease the model size by deleting comments, info nodes, and 
indentation characters, though this degrades readability.



Output material file
Check this box if you want to create a material file.



Tessellate
Use this option to tessellate complex faces. This keeps the line lengths short so you can edit 
them with most text editors.



Smoothing tip
Rendering is faster if you set the scene's Rendering option to Facet Shading.



DXF import tip
If you don't like the way the meshes are fully smoothed when imported, import the model, 
then export it to a temporary file. This creates all 3DFACE entities. Then import the 
temporary file with the smoothing angle you want.



Image width
Enter the width of the image on the surface of the model.



Image height
Enter the height of the image on the surface of the model.



Width offset
Use this field to shift the projected image horizontally. Enter the horizontal distance between
the new center of the image and the point where you dropped it on the model. For example, 
if an image is 100 units wide and you want to shift it horizontally by half that amount, enter 
50.



Rotation
Use this option to rotate the image. Enter the angle of rotation for the projected image. The 
angle is relative to the orientation of the original image.



Slide projector origin
Use these fields to specify the location of the slide projector.



Projection direction
Use these fields to specify which direction the slide projector is pointing.



Spherical mapping: Horiz. ratio
Enter the number of times you want to repeat the image horizontally around the sphere. In 
general, use a whole number to avoid seams in the image.



Spherical mapping: Vert. ratio
Enter the number of times you want to repeat the image vertically around the sphere. In 
general, use a whole number to avoid seams in the image.



Spherical mapping: Horiz. angle
Use this control to shift the field horizontally. To shift the image by a percentage of its width, 
enter the corresponding fraction of 360°. For example, to shift the image horizontally by half
its width, enter 180.



Spherical mapping: Vert. angle
Use this control to shift the field vertically, similar to the latitude lines on a globe. To move 
some feature from the south pole to the equator, for example, enter 90 degrees.



Export: Rendering style
Select the style of rendering you want. More realistic styles take more time to create. Press 
Esc during image export to cancel a rendering.



Notes on ACIS
TriSpectives imports models from ACIS 1.7, which creates accurate solid models. If you’re 
using ACIS 1.7, you can create solids such as primitives (block, sphere, cylinder, torus, etc.), 
sweep bodies, and loft bodies. You can combine these solids using Boolean operations. You 
can also create topological entities, such as faces and edges.
ACIS 1.7 lets you analyze a model’s volume, center of geometry, surface area, and moment 
of inertia. You can also perform constant radius blends and chamfers and variable radius 
blends. Transfer *.SAT files you create in ACIS to TriSpectives.
The geometric size of an ACIS model should range from 1000 to .0001 in the system internal
units.



Insert object: File
Enter the name of the file you want to embed in the TriSpectives document.
 



 How to...
Work with files
How to open files 
How to save files using the Save As command 
How to export a file 
How to import a model file

Work with catalogs and WorkBooks
How to create a WorkBook 
How to open a WorkBook 
How to print a WorkBook 
How to name a document in your WorkBook 
How to create and edit catalogs 
How to open a catalog set 

Work with pages and scenes
How to create a scene or page 
How to insert a page on the scene 
How to work with embedded scenes 
How to create a simple technical illustration 
How to create a collage with models and scenes
How to use a text box 

Create and edit shapes
How to create a shape 
How to add color and texture 
How to create a text shape 
How to edit a shape 
How to create a custom shape:
· Using extrusion 
· Using spinning 
· Using sweeping 
· Using lofting 

Manipulate shapes
How to copy a shape 
How to size and position shapes:
· Using the TriBall tool 



· Using the Move From-To tool 
· Using SmartSnap 

Build and work with models
How to build a model 
How to combine shapes to create a model 
How to work with groups of models
How to create holes in your models 
How to select models 
How to select parts of a model 
How to use the camera tools to view your model 

Change effects
How to use lighting effects 
How to cast shadows 
How to change the scale of a texture 

Animate objects
How to use SmartMotions 
How to use the SmartMotion Editor 
How to use the Group Segment 

Use advanced features
How to insert an object 
How to use annotation dimensions 
How to create an advanced technical illustration 
How to use SmartDimensions 



 How to open files      
 

1. From the File menu, choose Open.
2. Find the drive or folder where your file is stored. 

If you have Windows 95, you can enter the name of the drive or folder in the Look in 
field, or select the drive or folder from the list. Use the Up One Level button for 
navigation. Use the List or Details button to change the view of the drives and folders in 
the list.

3. You can show only files of a certain type by entering or selecting an extension in the Files
of type field. For example, to list only WorkBook files, select *.tsb.

4. Select or enter the name of the file you want to open in the File Name field.
5. Choose the Open or OK button to open the file.



 How to save files using the Save As command      
 

1. From the File menu, choose Save As.
2. To save the file in a different location, enter the name of the drive or folder in the Save in

field, or select the drive or folder from the list. Use the Up One Level button for 
navigation. Use the Create New Folder button to create a new folder for this file. Use the 
List or Details button to change the view of the drives and folders in the list.

3. Enter the name of the file you want to use in the File Name field.
4. If you want to change the file type, enter or select an extension in the Save as type field.
5. Choose the Save button to save the file.



 How to export a file      
 

1. From the File menu, choose Export Image, Export Animation, Export Model, or Export 2D.
2. Enter or select the name of the drive or folder to which you want to export the file.

Use the Up One Level button for navigation. Use the Create New Folder button to create 
a new folder for this file. Use the List or Details button to change the view of the drives 
and folders in the list.

3. Enter the name of the file you want to export in the File Name field.
4. Select the type of file you’re exporting, such as .tif.
5. Choose the Save button.

See also:

Export 2D Geometry dialog box 
Export Animation dialog box 
Export Image File dialog box 
Exported Image Size dialog box 
Export Model File dialog box 



 How to import a model file
You can import models created in other applications, such as 3D Studio, ACIS 1.7, AutoCAD, 
and Wavefront, to TriSpectives. See the individual topics listed below for complete 
instructions on inserting a model. In general, be aware of the following limitations:
· TriSpectives retrieves only model information within an inserted file. No camera, light, 

background, or animation information affects the scene.
· TriSpectives places all objects in a file into one clip art shape. If you want to manipulate 

objects individually, import each object separately.
· Hierarchy within a model is not preserved.
· Texture mapping information in a model is not preserved.
· Some file formats do not specify the units used to create the geometry. In this case, 

when models are inserted, TriSpectives asumes the geometry was created using its own 
internal, universal unit of length, the centimeter. If this is not the correct unit of measure,
you can use the handles to re-scale the model to the appropriate size. For example, if a 
model in another system is 24 inches long, but has been inserted into TriSpectives at 24 
centimeters, which equals 9.488 inches, you can scale the shape back to its original size 
by right-clicking the length handle of the imported shape and multiplying the displayed 
value by 2.54 (the centimeter-to-inch conversion factor).

When TriSpectives reads various file formats, it massages data. For example, it may smooth 
and edge surfaces so that you can edit curved sections in a group. Reconstructing these 
surfaces may take some time, particularly with large models.
See also:
3D Studio Import 
AutoCAD DXF Read dialog box 
Raw Triangle Read dialog box 
Stereolithography Read dialog box 
TriSpectives and the outside world
Wavefront OBJ Import 
VRML Import 



 How to print a WorkBook      
 

1. From the File menu, choose Print.
2. Check the printer settings, including the name, status, type, location, and any 

comments. To change these settings, choose the Properties button. Then use the tabs in 
the Windows 95 printer Properties sheet to find the settings you want to change.

3. Select the pages you want to print: all, a range, or the highlighted selection.
4. To print to a file rather than a printer, check the Print to File box.
5. Enter or select the number of copies you want to print.
6. Choose OK.



 How to create and edit catalogs
To create a catalog: 
1. From the Catalogs menu, choose New. You see a new, blank catalog.
2. To add a shape or model to your new catalog, drag it from the scene or page and drop it 

in the catalog.
3. To add a scene or page to your new catalog, drag the document tab and drop it in the 

catalog.

 
To edit items in a catalog: 
1. Double-click the shape, texture, or other item you want to edit. 
2. You then see a property sheet or model you can edit.

For example, if you double-click a texture, you can select properties such as color, finish, 
and reflection.

To save a catalog: 
1. Click the tab of the catalog you want to save.
2. From the Catalogs menu, choose Save As.
3. Enter a name for your catalog in the File name field, and then choose Save.

See also: Catalog Sets dialog box 



 How to open a catalog set      
 

1. From the Catalogs menu, choose Catalog Sets.
2. From the list of Catalog Sets, select the one you want.
3. To open the catalog set and use it in your current WorkBook, choose the Open button.
4. To edit the selected catalog set, choose the Edit button. You see a list of catalogs in the 

selected set. Use the edit buttons to customize the catalog set by reorganizing, adding, 
or removing catalogs in the list.

5. Choose the Remove button to delete the selected catalog set.



 How to create a scene or page
To create a scene:
1. When you’re working in an open WorkBook, choose Scene from the Insert menu.
2. On the Insert Scene dialog box, choose As New Scene in WorkBook. You can now start 

building a model in the new scene.
When you insert a scene, you create a new document called, for example, Doc-2. To 
change this name, see How to name your documents .
See How to create a shape and Working with models for more information.

To create a page:
1. While you’re working in an open WorkBook, choose Page from the Insert menu.
2. On the Insert Page dialog box, choose As New Page in WorkBook. You can now assemble 

your final image. 
When you insert a page, you create a new document called, for example, Doc-2. To 
change this name, see How to name your documents .
See Creating a collage with models and scenes for more information.



 How to insert a page on the scene
In most cases, the page and the scene are separate areas for different kinds of work. 
Combining them, however, can create striking results. For example, you might create an 
advertisement on the 3D page and then place the page on top of a model of your product.
To insert a blank page into a 3D scene:
1. While working in a 3D scene, choose Page from the Insert menu.
2. On the Insert Page dialog box, select In current scene. Then choose OK.

TriSpectives inserts a page in the 3D scene. Although the page is part of the scene, you 
can work with it as if it were a separate document.

To create an illustration on a page within a scene:
1. Double-click the page. TriSpectives displays the full page in a new window.
2. You can switch between the window with the page and the one with the 3D scene. To see

the scene, choose the name of its document from the Window menu. To see the page, 
choose Embedded Page from the Location option in the Window menu. This technique 
helps you evaluate the progress of your illustration by looking at it in the context of the 
3D scene.

3. Add models, text, and other elements to the page to create an illustration.
4. When you’re done working on the page, choose Close from the File menu.

TriSpectives returns to the 3D scene, which now contains a page with your illustration.
In addition to creating a new page using the above technique, you can use an existing 
document.
To add an existing page to a 3D scene:
1. Open the WorkBook that contains the page you want to add to the scene.
2. Drag the tab for the document with the page and drop it in a catalog.
3. Close the WorkBook.
4. Open the WorkBook with the 3D scene to which you want to add the page.
5. Drag the icon for the page from the catalog and drop it in the scene.
See also:
How to create a collage with models and scenes 
How to work with embedded scenes 



 How to work with embedded scenes
An embedded scene is similar to the standard 3D scene you use to build models. 
TriSpectives lets you embed scenes on the page to create a layered effect. For example, you 
might place a scene with a car model on top of a scene with a bridge.
To add an embedded scene to a page:
1. From the Insert menu, choose Scene. TriSpectives displays the Insert Scene dialog box.
2. On the Insert Scene dialog box, choose On Current Page. TriSpectives displays a 

bounding box around the embedded scene.
3. To work in the scene, double-click in the bounding box. TriSpectives displays a new 

window for the 3D scene. At this point, you can drag a model into the scene from a 
catalog or build a new model.

4. You can switch back and forth between the window with the page and the one with the 
3D scene. To see the page, choose the name of its document from the Window menu. To 
see the scene, choose Embedded Scene from the Location option in the Window menu.

5. When you’re done working in the embedded scene, return to the page by choosing Close 
on the File menu.

Instead of creating a new scene within the page, you can embed an existing scene and its 
contents.
To add an existing scene to a 3D page:
1. Open the WorkBook that contains the scene.
2. Drag the tab for the document with the scene and drop it in a catalog.
3. Close the WorkBook.
4. Open the WorkBook with the 3D page.
5. Drag the icon for the scene from the catalog and drop it on the page.



 How to create a simple technical illustration
A technical illustration shows detailed information about a product, machine part, or other 
object. You can use hidden line drawings, annotation dimensions, and embedded scenes for 
creating technical illustrations.
The process of making a technical illustration involves both the scene and the page. You 
may go back and forth between the two and experiment with various settings until you get 
the results you want. The final illustration is an embedded scene within the page. 
To create a technical illustration:
1. Build a model in the 3D scene.
2. Use the Look At tool on the Camera toolbar to select the surface of the model that will 

appear at the front of the illustration.
3. Attach annotation dimensions to the model. You can set the dimensions to display 

horizontal or vertical measurement.
4. Save the scene in a catalog. Drag its tab and drop it in the catalog.
5. Insert a page document in your WorkBook.
6. Drag the scene you saved in step 4 from its catalog and drop it on the page.
7. To display the property sheet for the embedded scene, right-click in the scene and 

choose Embedded Page Properties.
8. Select the following options on the Drawing Style tab of the Embedded Page Properties 

sheet:
· Hidden Line
· Make Background Transparent
· Show Dimensions

9. Check the Line Settings button to set options for line styles and drawing quality. Then 
choose OK.

10. While you’re still working in the Embedded Scene Properties sheet, select the Camera tab
and choose the Orthographic option under Projection.

11. Choose OK. Your model appears as a hidden-line drawing on the page.
For more information, see How to create an advanced technical illustration. Advanced 
technical illustrations are available in TriSpectives only.



 How to create an advanced technical illustration
A technical illustration is used to show a prototype product or component in exhaustive 
detail, including all its physical dimensions. For example, engineering drawings are an 
example of technical illustration. The Professional version of TriSpectives includes templates 
that will assist you in either creating advanced technical illustrations in standard forms or 
learning how to create your own customized technical illustrations.
TriSpectives Professional includes a catalog named    Techilus    which contains several 
technical illustration templates. The name of the template tells you what the template is set 
up to do for you. Each name has the form    XY-n    or    XY-n(w/iso).
The first character (X) is a letter indicating the size of U.S. standard paper, A size through E 
size.
The second character (Y) is either L or P to indicate either Landscape or Portrait orientation, 
respectively.
The third character (n) is a number telling the number of views in the template.
If the n views include one isometric view, the “(w/iso)” is appended;    if this suffix does not 
appear, then all the views are true views.
To create a technical illustration using a template:
1. irst create a model which you wish to illustrate. Include any annotation dimensions you 

wish to appear in the technical illustration. Note that only those dimensions which are 
parallel to the page for a particular view will be displayed in that view.

2. Save the model (not the scene) in a catalog by dragging the model to it.
3. You must have a WorkBook open to create a technical illustration.
4. Open the WorkBook Browser either by selecting the WorkBook Browser tool in the 

Selection toolbar or by selecting WorkBook Browser from the View menu.
5. Open the Techilus catalog, select the template you want, drag it to the WorkBook 

Browser to the title of the WorkBook, and—wen the title of the WorkBook is highlighted—
drop the template.

6. A new page is automatically created in the WorkBook with the technical illustration sheet
shown in Whole view. You will see the frame of an empty embedded scene on the page 
as well as a template for a title block for the drawing.

7. Double click the embedded scene to bring up a full view of the embedded scene. It will 
be in orthographic projection (not perspective).

8. Open the catalog containing the model you created in step 1 and drop the model into the
embedded scene.

9. Use the Fit Scene tool from the Camera toolbar to just fill the view with the model. You 
may also use the Pan Camera tool, but you should not use any of the other camera tools 
on this scene.

10. At this point, you may wish to use the TriBall to adjust the position of your model within 
the scene to obtain the master view you wish to have in the illustration. However, when 
you dropped your model into this scene, its anchor point axes were already aligned so 
that the forward and sideways axes are parallel to the scene grid and the up axis is 
perpendicular to the scene grid.

11. Close the embedded scene either with the View menu or the File menu. This returns you 
to the page with your illustration sheet.

12. Right-click in the background of the embedded scene and choose the Embedded Scene 
Properties sheet. You will want to do some or all of the following in this dialog box, 



perhaps by going back and forth between it and the page:
In the Camera page, you set the scale of your drawing. This is given by a ratio of the 
paper dimensions on the sheet to the real dimensions of the model. For example, if you 
wish the drawing to be at a scale of 1” = 1’-0”, your scale would be 1/12 = 0.08333.
In the Drawing style page, you establish the text size of the annotation dimensions in 
user units. For example, if your length units set in the Options command of the Tools 
menu is in inches, you would enter 0.25 in the Text size box to obtain 1/4” lettering in 
your dimensions.
Also in the Drawing style page, you will want to uncheck the Draw page border option to 
remove the frame that was initially placed about the master view on the sheet as a 
visual cue for you.
In the Variables page there is a table of values which controls the spacing of the various 
views in your drawing. These values represent spacing between the adjacent views.

13. You may wish to edit your drawing further by, for example, copying a view in a blank 
portion of the sheet to create a view of a detail. You can use all of the tools on this new 
view that you would normally invoke in adjusting an embedded scene on a page, e.g., 
those camera tools which are still active.

14. You can finish your drawing by adding appropriate text:
Double click on each box of the title block of the illustration to insert or edit the text. You can
employ the standard tools of the Text toolbar to change the size and style of the text.
You can add text and notes to the page in the usual way for an embedded scene. This text is
also controlled by the Text toolbar.
For further information about simple technical illustration, annotation dimensions, and 
hidden-line drawings, see other portions of this Help and Chapter 6 of the TriSpectives User 
Guide. You can also learn more about creating custom technical illustrations by exploring 
more thoroughly the templates from the    Techilus    catalog.



 How to create a collage with models and scenes
To add models to a collage:
1. Open the catalog that contains the models you want to include in the collage.
2. To insert a new page in the WorkBook, choose Page from the Insert menu. Then choose 

As New Page in WorkBook from the Insert Page dialog box.
3. If you want a colored or textured background, drag an item from an appropriate catalog 

and drop it on the blank page.
4. Drag a model from a catalog onto the new page.

You can also drag a model from another document. To see both documents side by side, 
choose Tile from the Window menu.

5. If you like, use the 3D Shapes tools to adjust the model.
To add scenes to a collage:
1. Start with a blank page in the WorkBook.
2. To add a scene to the page, choose Scene from the Insert menu. Then choose On Current

Page from the Insert Scene dialog box.
3. You see a bounding box surrounding the embedded scene. To resize the box, drag a 

corner.
4. Double-click within the bounding box to see a blank scene.
5. Drag a model, shape, text, or other object into the new scene.
6. Use the Camera tools to change the image in the scene. For example, use the Zoom 

Camera tool to make a model appear larger. To return to the page, select the page name 
from the Window menu.



 How to create a text shape      
 

1. Drag an item from the Text catalog and drop it in the scene. You see a shape with generic
text and an edit box. 

2. Use the edit box to change the contents and format of the 3D text. The edit box behaves 
like a word processor. Add, delete, and change text using the keyboard and the Text 
Tools.

3. When you’re done editing the text, click in the scene outside the edit box.
3D text is like any other IntelliShape. You can change the size of the text by pulling a shape 
handle. You can also modify other settings using the Text Properties sheet.



 How to create a custom shape using extrusion      
 

Extrusion pulls a 2D cross-section outward along a perpendicular axis. For example, you can 
extrude a square to get a cube. 
To create a custom shape using extrusion:
1. Choose the Extrude Shape tool on the 3D Shapes toolbar.
2. Click in the 3D scene.

TriSpectives displays the Extrude Shape wizard.
3. Choose Finish on the wizard.

TriSpectives displays a 2D drawing grid in the scene. You also see the Edit Cross-Section 
dialog box.

4. Draw a 2D figure using the Line, Circle, and other drawing tools.
5. When you’re done drawing, choose Finish Shape on the Edit Cross-Section dialog box.

TriSpectives extends your 2D figure into 3D.



 How to create a custom shape using spinning      

Use spinning to create a custom shape by rotating a 2D cross-section around an axis. The 
process is very much like extrusion.
To create a custom shape through spinning:
1. Choose the Spin Shape tool on the 3D Shapes toolbar.
2. Click in the 3D scene to see the Spin shape wizard.
3. Choose Finish on the wizard to see a 2D grid with a rotation axis.

Note the position of your drawing relative to the axis. For example, when you create a 
torus, the size of its hole depends on the distance between the original circle and the 
axis of rotation.

4. Draw a 2D figure using the 2D drawing tools.
5. When you’re done drawing, choose Finish Shape on the Edit Cross-Section dialog box.

When you spin a 2D cross-section, the resulting 3D shape has a handle that doesn’t 
appear on other shapes. It has a square tip, which lets you adjust the angle of rotation 
for the spinning operation. By dragging the handle, you can remove part of the shape.



 How to create a custom shape using sweeping      

Sweeping involves extending a 2D cross-section into the third dimension along a path. The 
path can be a line, a series of line segments, a curve, or anything else you can create with 
the 2D drawing tools.
To create a custom shape through sweeping:
1. Choose the Sweep Shape tool from the 3D Shapes toolbar.
2. Click in the 3D scene to see the Sweep Shape wizard.
3. Choose Finish on the wizard to see a 2D drawing grid with a default path.
4. Use the 2D drawing tools to create a cross-section.
5. Choose Finish Shape on the Edit Cross-Section dialog box. TriSpectives displays a second 

grid along the path.
6. Use the 2D drawing tools to create a path.
7. Choose Finish Shape on the Edit Sweep Path dialog box.

TriSpectives moves the cross-section along your path to create the final shape.



 How to create a custom shape using lofting      

When you create a custom shape by extruding, spinning, or sweeping, you use a single 2D 
cross-section. With lofting, you can define as many cross-sections as necessary. You place 
these cross-sections along a straight or curved path and TriSpectives blends them to create 
the final shape.
To create a custom shape through lofting:
1. Choose the Loft Shape tool from the 3D Shapes toolbar.
2. Click in the 3D scene to see the Loft Shape wizard.
3. In the Cross-Sections field, enter the number of 2D cross-sections you want to use to 

create the 3D shape. Then choose Next to see page 2 of the wizard.
4. Choose one of the following cross-section types:

· Rectangles
· Circles
· Custom
Choose one of the following path types:
· Straight line
· Curved arc
· Bezier curve

5. Choose Next to see page 3 of the Loft Shape wizard. Like the other custom shape 
wizards, this page gives you the opportunity to create holes, stand-alone shapes, and so 
forth.

6. Choose Finish.
7. If you want to create custom cross-sections, draw them using the 2D drawing tools.

This process is the same as it is with the other custom shape techniques. You draw as 
many cross-sections as you specified in step 3. 
If you’re creating custom cross-sections, choose Finish Shape on the Edit Loft Cross 
Section dialog box.
If you choose circles or rectangles for the cross-section, the resulting shape looks like a 
standard block or cylinder. In this case, you can create a custom 3D shape by editing its 
component cross-sections.

To edit the cross-sections in a loft shape:
1. From the Selection toolbar, choose the Edit IntelliShapes tool. 
2. Right-click the shape to see its pop-up menu.
3. Choose Edit Cross-Sections on the pop-up menu.

TriSpectives displays the cross-sections that define the shape. Each one has a button. 
Click the button for the cross-section you want to edit.

4. TriSpectives displays red handles that let you drag and resize the cross-section. Edit the 
2D cross-section by dragging its handles.

5. When the components of the shape are in their correct form, click in the scene outside 
the shape.



 How to size and position shapes
Shapes 
Every IntelliShape—whether it’s part of a model or on its own—has a number of controls for 
sizing and positioning.
To see the controls for a shape:
1 From the Selection toolbar, , select the Edit IntelliShapes tool.
2 Click the shape.
When you select a shape using this method, you see a number of red handles and other 
controls.

Handles: Each surface of an IntelliShape has a red sizing handle. Drag a handle in or out to 
move one surface and make the shape bigger or smaller.
Sizebox: The sizebox encloses the shape and defines its boundaries. You can change the 
dimensions of the sizebox by editing the property sheet for the shape.
Anchor. The blue anchor shows where one shape joins another. You can use the anchor as a
reference point when you drag a shape across others in a model.
See also:
Positioning models and shapes 
How to use the TriBall tool 
How to use the Move To-From tool 
How to use SmartSnap 



 How to use the TriBall tool
To move, copy, and link shapes with the TriBall:
· To move a shape, drag a handle or other tool on the TriBall using the left mouse button.
· To copy or link a shape, use the right mouse button to drag. When you release the 

button, you see a pop-up menu.
Choose Copy Here to make a copy of the shape at the current location.
Choose Link Here to make a copy of the shape that’s linked to the original one. When you
change one shape, you change the other in the same way.

To position a shape precisely:
· To move a shape, drag a handle or other tool on the TriBall using the left mouse button. 

You can then place the TriBall’s handles, planes, and axes anywhere you want. You’re 
moving the coordinate system of the shape.
Center point handle: Drag this handle to reposition the center of the TriBall at a new 
point in the shape. This point becomes the new center of rotation.
Rotation handles: Drag one to rotate the TriBall. This positions the controls on the 
surface of the TriBall.

See also: How to use the Move From-To tool 



 How to use the Move From-To tool
This tool provides a quick way to position and align two objects. Like the TriBall, it combines 
movement and rotation functions in one tool. The TriBall works with a single object, however.
To align one object with another using the Move From-To Tool:
1. Select the Move From-To Tool from the 3D Shapes toolbar.
2. Click a point on the object you want to move. Drag a line from its point of origin on the 

initial object and drop it on another object.
TriSpectives joins the two objects so that start point of the line matches the end point.
If necessary, repeat this step to align corresponding edges on the two objects.

3. Drag an edge from the initial object and drop it on an edge of the second object. 
TriSpectives aligns the two edges, retaining the point alignment.
If necessary, repeat step 2 to align corresponding surfaces on the two objects.

The idea behind the Move From-To tool is that you can move an object into any position 
relative to another object by applying successive constraints. With the three drag-and-drop 
operations¾one each for a point, line, and surface¾ you remove a degree of freedom until 
the initial object doesn’t have anywhere to go. With a little practice, you can easily position 
two objects exactly the way you want.
See also: How to use the TriBall tool 



 How to use SmartSnap
As you drag a shape across the surfaces of a model, TriSpectives can provide visual 
feedback about your current location. For example, when you line up one shape with the 
edge of another, TriSpectives highlights the edge with a green line. 
This technique is called SmartSnap. The following instructions show how to use SmartSnap 
to find the correct location for a shape.
To place a shape using SmartSnap:
1. From the Selection toolbar, choose the Edit IntelliShapes tool.
2. Hold down the Shift key to enable SmartSnap.
3. Drag the shape in the direction of the edge, center point, or other location you want.
4. When you see the green highlight, drop the shape.
See also:
How to use the TriBall tool 
How to use the Move From-To tool 



 How to build a model
Models

Assemble a model from basic geometric forms called IntelliShapes, such as those illustrated 
below.

To build a model, you drag IntelliShapes from the Shapes catalog and drop them in the 3D 
scene. Since the shapes are intelligent, they know how to join to form a model. For example,
here’s a model composed of two shapes:

You can also use items in the Shapes catalog, such as H Sphere and H Block, to cut out a 
shape or create a hole in your model:

Once you have the shapes in place, you can add colors, textures, lighting, and animation 
effects. You can find these items in the catalogs. Drag these textures into the 3D scene and 
drop them on the surfaces of your model:



Look in the Showcase catalog for completed models that show off what you can do with 
TriSpectives.



 How to combine shapes to create a model
Shapes 
When you drop one shape on top of another, you create: 
· A single model composed of two shapes. This lets you work with all the components 

in the model at once. For instance, you can round off all the edges of the model or make 
the entire thing transparent.

· Two models, each consisting of a single shape. This lets you apply model properties
such as transparency and bumpiness to the independent shapes. For example, you might
use one shape for a window frame and another for the glass in the window. You can make
the glass transparent and leave the frame opaque.

You can get the results you want by setting up the proper conditions before you drop one 
shape on another.
To create a single model from two shapes:
1. Drag the first shape from a catalog and drop it in the scene.
2. From the Selection toolbar, choose the Edit IntelliShapes tool.
3. Drag the second shape from the catalog and drop it on the first one.
Instead of choosing the Edit IntelliShapes tool in step 2, you can select the first shape so 
that its sizebox and handles appear. If you don’t take either action, the two shapes become 
independent models.



 How to create holes in your models
Suppose you want to build a model engine with empty spaces for the valves. To create a 
valve-shaped hole¾or an empty space of any kind¾in a solid object, you create a negative 
model.
To create a negative model:
1. Build the model you want to appear as an empty space in another object.

For example, build the model of the valve that you want to appear as a hole within an 
engine. At this stage, the valve is a solid object like most models.

2. Drag the model and drop it in a catalog.
3. Double-click the catalog entry for the model to edit it in a 3D scene.
4. Select the model in the 3D scene.
5. From the Shape menu, choose Set Operations.
6. On the Set Operations dialog box, choose Remove Material and click OK.
7. From the Shape menu, choose Move Anchor.
8. Click the existing anchor on the model.

TriSpectives reorients the anchor so it points in the opposite direction. This step is 
necessary because you want the model to enter the object you drop it on. Without 
changing the anchor, the model would appear on top of the target object.

9. Close the 3D scene.
At this point, the model in the catalog is a negative one. When you drop it on another 
object, it removes a hole in the shape of the original model.



 How to use the camera tools
1. Select a camera tool, such as Orbit Camera.
2. Move the pointer close to the model you want to view.
3. Drag the pointer:

Orbit tool: Drag the hand pointer in any direction to have the camera circle the model.
Pan tool: Drag the four-pointed arrow in any direction to move your view back and forth 
in front of the model.
Zoom tool: Drag the magnifying glass up to zoom in, and down to zoom out.
Fit Scene tool: When you choose the Fit Scene tool, the pointer changes to a box with 
arrows. Click anywhere in the scene to make the model fill your field of view.
Look At tool: When you choose the Look At tool, the pointer changes to a pointing 
finger. Click the surface you want to examine directly. 

 
Window Zoom tool: Choose this tool, then drag a rectangular window in the scene. 

TriSpectives zooms the display to fill this window.

 



 How to use lighting effects
To see the light sources:
1. In a scene, right-click the gray background to see the Scene pop-up menu.
2. From the pop-up menu, choose Scene Properties.
3. From the Scene Properties sheet, choose the Show tab.
4. Check the Lights box.
5. Choose OK to return to see your model and light sources. If you don’t see all your lights, 

use the Dolly camera tool to move back.
To add light sources to a model:
1. From the Insert menu, choose Lights.
2. Click in the scene where you want the light to appear.
3. Choose whether you want a directional or positional light source. Directional sources are 

like the sun, a great distance from the model. Positional light sources are like spot lights.
To adjust a light source:
1. Right-click the light source to see its pop-up menu. If you’re working with models, select 

the light first, then right-click it.
2. From the pop-up menu, choose Light Properties.
3. Choose the Light tab, then select a color for the light.
4. Click OK to return to the scene.
To change the direction of a light:
· For directional lights, drag the light source to a new location.
· For positional lights, select the light and use the TriBall.
See also: How to cast shadows



 How to cast shadows      
 

Light sources may cast shadows for additional realism, to emphasize the structure of your 
model, or for dramatic effect.
To display shadows for your model:
1. Right-click in the scene to see the Scene pop-up menu.
2. From the pop-up menu, choose Scene Properties.
3. On the property sheet, choose the Rendering tab.
4. Choose the Realistic shading option.
5. Choose the Shadows checkbox.
6. Choose OK on the property sheet.
To turn off shadowing for a single light:
1. Right-click a light source to see its pop-up menu.
2. From the pop-up menu, clear the Cast Shadows option.



 How to change the scale of a texture
Once you apply a texture to a model, you may want to change its scale. For example, the 
grains in a marble texture may be too large, or the fibers in a cloth texture too small.
To change the scale of a texture on a model:
1. Right-click the model to see its pop-up menu.
2. From the pop-up menu, choose Style Properties.
3. On the property sheet, select the Color tab.
4. Check to be sure Box Normal is selected.
5. Choose the Settings button to see Box Projection settings.
6. Enter a new value in the Height or Width field. If the texture is too big, decrease the 

value.    If it’s too small, increase the value.
7. Choose OK to accept the new projection settings.
8. Choose OK to accept the settings on the property sheet.
You can also control the scale of textures automatically when you drop them on a shape 
from a catalog or when you apply them to a shape using the style properties. This is helpful, 
for example, when you are working on small models and the textures in the surface finish 
catalogs are relatively large. Instead of individually rescaling the surface finishes by 
changing the style properties, you can set a single scale.
To automatically control the scale of textures to apply to a model:

1. From the Tools menu, choose Options.
2. Select the Models and tab. The default texture scale in the Texture Scale box is 100%, 

which means that you apply a texture at its original size.
3. Change the scale to a value appropriate for your model. For example, change the scale 

to 25% to apply a texture 25% of its original size.
4. Choose OK to accept the new automatic texture scale.
You can also make sure the size of the textures change whenever you resize your model. 
To rescale textures and models at the same time:

1. Select the model you want to work with.
2. Right-click the model, and then choose Model Properties from the pop-up menu.
3. Choose the Sizebox tab. Make sure the Aspect Locks option is set to All.
4. Choose OK on the Model Properties sheet.
5. From the Shape menu, choose Reset Sizebox.
6. Scale the model using a sizebox handle.



 How to insert an object      
 

1. From the Insert menu, choose Object.
2. Choose whether you want to create a link to a new object, or create a link from a file.
3. Choose the object type, such as a bitmap image or a Microsoft Excel chart.
4. To display the object as an icon, check the Display as Icon box.



 How to use annotation dimensions        
 

To add an annotation dimension to the 3D scene:
1. Drag a tool from the Dims catalog and drop it in the scene. The annotation dimension 

appears as a line or arc with arrows at either end.
2. Drag one arrow and drop it on the point where you want to begin the measurement.
3. Drag the free arrow and drop it on a point or surface.
4. If you’re using the Radial tool, drop the arrow anywhere on one face of a shape or model. 

TriSpectives measures the distance or angle between the point you set in step 2 and the 
plane defined by the surface you choose in this step.

Since annotation dimensions are primarily for display instead of modeling, they behave 
differently from positioning tools such as the TriBall and the scene grid. You can reorient 
them to display measurements along the horizontal or vertical screen axis. This is typically 
useful after you have chosen a direct view by first, changing the scene view to orthographic 
by activating the Scene Properties sheet, selecting the Camera tab, and deactivating 
Perspective view; and second, by using the Look At tool to select a true view of one surface. 
Choose the orientation that provides the clearest information.
To reorient an annotation dimension:
1. Right-click the dimension to see its pop-up menu.
2. Choose Horizontal or Vertical from the pop-up menu.
You can also add a label to an annotation dimension. Use this feature to clarify the purpose 
or meaning of a measurement.
To add a label to an annotation dimension:
1. Right-click the dimension to see its pop-up menu.
2. Choose Annotation Dimension Properties from the menu.
3. Choose the Annotation tab on the Annotation Properties sheet.
4. Enter a label in the Prefix text field, the Postfix text field, or both.

The text in the Prefix field appears before the value in the annotation dimension. The 
text in the Postfix field appears after the value.



 How to use SmartDimensions      
 

If you’re using TriSpectives Professional, you can use SmartDimensions to position your 
shapes and models.
To activate SmartDimensions:
1. Right-click a shape to see its pop-up menu.
2. From the pop-up menu, choose Add SmartDimensions.
3. Check or change the settings on the Add SmartDimensions dialog box, and then choose 

OK.
To set the value of a SmartDimension:
1. Right-click the value of a SmartDimension (the number inside the line) to see its pop-up 

menu.
2. From the pop-up menu, choose Edit This SmartDimension.
3. In the Edit SmartDimension dialog box, enter a new value, and then choose OK.
To add SmartDimensions to a shape:
1. From the Selection toolbar, select the Edit IntelliShapes tool.
2. Right-click the shape to see its pop-up menu.
3. Choose Add SmartDimensions from the pop-up menu. You see the Add SmartDimensions 

dialog box. 
4. On the dialog box, select Angle or Distance measurement. Enter the number of 

SmartDimensions you want. Use the field with the label How Many Should Be Added?
5. Choose OK.
When you first create a SmartDimension, one end is on the shape and one end is free. 
Before you can use the SmartDimension, you need to move the ends into position. 
To position the ends of a SmartDimension:
1. Drag the free end of the SmartDimension and drop it on the feature of interest.

Drag the end by its arrowhead. For example, if you want to measure or set the distance 
between the corner of the block and the corner of the slab in the previous illustration, 
drag the free end of the SmartDimension to the corner of the slab. Let SmartSnap help 
you. As you drag, TriSpectives highlights corners, center points, and other key spots.

2. Drag the other end of the SmartDimension and drop it at the appropriate position on the 
shape of origin.

3. Once the ends of the SmartDimension are in place, you can use two methods to move 
the shape into position: 
Measurement. Drag the shape into position. As you drag, the current distance or angle 
value appears in the SmartDimension. Drop the shape when the measurement is correct.
Direct entry. Right-click the numeric measurement and choose Edit This 
SmartDimension from the resulting pop-up value. Enter the correct distance or angle in 
the dialog box that appears. 



 Answers to common questions
1000 3D models
All shapes option
Apply button
Apply Last
Attachment point
Background
Blend
Blending failure
Bump height
Bumps
Camera tab
Camera view
Cap height
Capping
Catalogs
Color
Decal
Dolly Camera
Drag a shape over a model
Edit Cross-Sections
Edit Match Points
Embedded Scene
Embedded Scene Properties
Evaluate a model
Export a model
Exported image size
Export model command
Export scene
Facet model
Handle
Highlighting
Improper shape detected
IntelliShape
IntelliShape mode
IntelliShape model
IntelliShape model, modify



IntelliShape properties
Invisible IntelliShape
Fit to scene
Grayed out 
Group
Loft shape
Lofting cross-sections
Lofting options
Look At tool
Match points
Model on a page
Model in a scene
Model mode
Model properties
Move decal
Orbit Camera
Orthographic view
Perspective option
Printing
Print Preview
Ray tracing
Realistic shading
Redo command
Reflected background
Reflection image
Reflection map
Resizing behavior
Scaling
Scene
Scene Properties
Select a model
Shape Edit mode
Shelling
Show edges
Simplification
Sizebox
Sizebox tab



SmartRender
Spotlight
Stop printing
Style, edit
Style Properties
Sweep length
Sweep path
Sweep profile
Sweep shape
Taper
Taper angle
Taper failure
Target Camera
Texture, can  ’  t see  
Textures
Texture settings, change
Texture, too bright
Translucent
Transparent
TriBall tool
Undo command
Walk Camera
Walk Camera, moving beyond scene boundaries
Walk Camera, too sensitive or sluggish
Wireframe
WorkBook Browser
Zoom Camera



 Question 1
Q:    I have resized portions of an IntelliShape model that contains other IntelliShapes—such 
as holes    and small solids—and now I can no longer see one or more of the other 
IntelliShapes. How do I select them?
A1:    You have probably made the an IntelliShape component of the model larger than the 
no-longer-visible IntelliShapes so these are “lost inside” the solid. Use the WorkBook Browser 
to select the invisible IntelliShape so you can use their sizing handles to readjust the size as 
necessary. Load the WorkBook Browser either by clicking its tool on the Selection toolbar or 
by going to the View menu and selecting WorkBook Browser. You can also use the 
IntelliShape properties page from the WorkBook Browser to modify the shape. Note that 
IntelliShapes which are invisible within a model are shown as colorless icons in the WorkBook
Browser.
A2:    To avoid “losing” a hole or other IntelliShape (or to avoid losing a desired connection 
between two “positive” IntelliShapes), you can insert an attachment point at the location on 
the parent IntelliShape where the two should remain joined.



 Question 2
Q:    Why is Export Model command of the Edit menu grayed out when I am trying to export a
model?
A1:    To export a model, you need to be in Model mode. To make sure that you are in Model 
mode, look at the Selection toolbar and see that that neither of the Edit IntelliShapes tool or 
Edit Surfaces and Edges tool is selected; if one is selected, click on that toolbar button to 
deselect it. Alternatively, you can enter Model mode by selecting the Shape Edit Mode... 
command of the Edit menu and selecting the All Shapes option. If you wish to export more 
than one model to a file, make a Group and export it.
A2:    To export a model, you need to have a model selected. To select a model, first click with
the left mouse button on the scene background where no shapes or models are present to 
make sure you have nothing selected. Now select the model you want to export. The model 
will appear with either a white or blue highlight.



 Question 3
Q:    How do I obtain an orthographic view of my model when working in a scene?
A:    To get an orthographic view you need to adjust you camera settings. Click the right 
mouse button on the scene background, select Scene Properties , and select the Camera 
tab. By default the Perspective option is turned on. Select the checkbox next to Perspective 
to turn off perspective viewing.



 Question 4
Q:    Where are the 1000 3D models?
A:    The 1000 3D models are available in one of two locations depending on the installation 
options you chose. 
If you selected Custom installation and installed the 3D models catalog to your hard drive, 
the 1000 3D models will be located in the \Catalogs\3Dmodels directory under the directory 
to which you installed TriSpectives. Go to the Catalogs menu and select open. A dialog box 
appears. Select the Catalogs    directory. Within that directory select the catalog you would 
like to view and click OK. The catalog will load. You may now drag and drop any of the 
models in the loaded catalog onto your scene or page.
If you selected the Typical or Compact installation option, to get to the 1000 3D models you 
will need the TriSpectives CD-ROM in your CD-ROM drive. Go to the Catalogs menu and 
select open. A dialog box appears. Select your CD-ROM drive, then select the Catalogs    
directory. Within that directory select the 3Dmodels directory. This directory contains the 3D 
models catalogs. Select the catalog you would like to view and click OK. The catalog will 
load. You may now drag and drop any of the models in the loaded catalog onto your scene or
page. 
Q:    Are the 1000 3D models available as individual files?
A:      The 1000 3D models are available only in the catalogs. If you want a WorkBook of a 
specific model, simply load the catalog which contains the model, drag and drop the desired 
model into a new WorkBook, and save the WorkBook.



 Question 5
Q:    If I want to distribute a model that has textures on it, do I need to include separate 
texture files along with the WorkBook?
A:    No. If you want to save a model that has texture mapping information, do the following:   
Go to the Tools menu and select Options. Under the General tab check the option “Copy 
image data to WorkBook file on save.”    The WorkBook will store all the texture information 
and files for the model within the saved WorkBook for easier distribution.



 Question 6
Q:    Why don’t I get any highlighting of faces, edges, center points, etc. while I drag a shape 
over a model?
A1:    If the model is a facet model, you will not see any highlighting. You will need to re-load 
the model after you have entered the Options... command of the Tools menu and changed 
the “IntelliShape Model drop result” in the Models page.
A2:    If the model is an IntelliShape model and don’t receive any highlighting, try evaluating 
the model. Continue to click on the model until you reach the IntelliShape mode level. When 
you are prompted to evaluate the model, click “Yes.”    You should then get highlighting when 
you drag a shape over the model.



 Question 7
Q:    When I use a handle to resize a shape, it doesn’t behave as I would like. Sometimes I 
want the center of the shape to remain fixed as I resize, and other times I want the far side 
of the shape 
to remain fixed. How do I do this?
A:    Change the Resizing behavior for the shape. Right-click on the IntelliShape, select 
IntelliShape Properties, and select the Sizebox tab.



 Question 8
Q:    After I create a complex IntelliShape model and turn on its sizebox and handles, I can 
resize it by pulling the handle. However, the model handles no longer resize the entire 
model after I edit the model by resizing one of its component IntelliShapes or adding new 
IntelliShapes. How do I correct this?
A1:    While in Model mode, right-click on the model and select the Model Properties option. 
In the Sizebox page, be sure that the “Permit reset of the sizebox” option is checked.
A2:    When you are finished editing the model, be sure that you are in Model mode and use 
the Reset Sizebox command of the Shape menu while the model is selected.



 Question 9
Q:    I dropped a model in a scene and can't see it. What do I do?
A1:    To make an invisible model in a scene visible, try using the Fit to Scene tool of the 
Camera toolbar.
A2:    You may have accidentally deleted it. Try using the Undo tool in the Standard toolbar. (If
this does not work, then you will probably want to use the Redo tool.)



 Question 10
Q:    I dropped a model on a page and can't see it (or can see only its anchor point). What do 
I do?
A:    Your model may be too small or too large to be seen on the page. Try adjusting the 
scaling in the Options... command of the Tools menu by selecting the Models tab and 
entering a new scaling value. Then try dropping the model again on the page. (First delete 
the previous model with the WorkBook Browser.)



 Question 11
Q:    I am having trouble adjusting my camera view so that the top of the model is at the top 
of the screen in my scene. How can I do this?
A1:    Select the Walk Camera and simply click once in the scene. The best up direction is 
chosen by the tool.
A2:    You can use Orbit Camera, by orbiting around the edges of the scene, to change which 
way is up.
A3:    Use the Camera tab on the Scene Properties sheet (obtained by right-clicking in the 
scene background) and adjust the up direction by hand.



 Question 12
Q:    I applied a texture to my model (or dropped in a model with a texture) but can’t see the 
effect I expected. What should I do?
A:    Many of the provided models and textures have bumps on them, which are only visible 
with the more realistic rendering styles. Try turning on Realistic shading by right-clicking on 
the scene background, selecting Scene Properties , choosing the Rendering tab, and clicking 
Realistic shading.



 Question 13
Q:    Bumps don't seem to appear on my model. Why?
A1:    You need to turn on Realistic shading to see bumps. Right click on the background, 
bring up the Scene Properties , select the Rendering tab, and select Realistic shading.
A2:    Try increasing the bump height to a larger value. 
A3: Both the model and each surface in the model may have style properties. By default, the
style of the individual surfaces takes precedence over the style of the model. If you want the
opposite to be true—which may be necessary to see the expected effect of applying bumps 
to the model as a whole—right-click on the model, pick the Style Properties command, go to 
the Finish page, and check “Replace surface styles.”



 Question 14
Q:    I edit the style (color, texture, etc.) but don't see any effect. What should I do?
A:    Both the model and each surface in the model may have style properties. By default, the
style of the individual surfaces takes precedence over the style of the model. If you want the
opposite to be true -- which may be necessary to see the expected effect of a style change 
on the model as a whole -- right-click on the model, pick the Style Properties command, go 
to the Finish page, and check “Replace surface styles.”



 Question 15
Q:    I added a decal image using the Style Properties, but can't see it. What do I do?
A:    Use the Move Decal command in the Tools menu to quickly position the decal where you 
want it. Turn on this command, then click where you want the center of decal on the surface.
You may also want to turn off simplification (right click on the background, bring up the 
Scene Properties, select the Rendering tab, and turn off “Allow simplification”) so that you 
immediately show the decal's new position. 
Q:    I have applied a decal but it is of the wrong size or orientation. What do I do?
A:    Right-click on the surface or model, select Style Properties, and change the Decal 
settings.



 Question 16
Q:    I added a reflection image using the Style Properties, but can't see it. What do I do?
A:    You need to go to the Finish tab of Style Properties (right-click on the shape) and 
increase the Reflection intensity, typically to about 100. You will also probably want to 
decrease the diffuse intensity. (Look at the Metals catalog, which has many reflection 
mapping examples.)



 Question 17
Q:    I've made my object totally transparent, and now I can't find it. What do I do?
A:    To see an invisible model which is invisible because it is totally transparent, use either 
the show edges    rendering option or the wireframe rendering method. Right-click on the 
background, bring up the Scene Properties, select the Rendering Tab, and select either of 
these options.



 Question 18
Q:    I change my texture settings and hit the Apply button, but do not see any changes. 
What do I do?
A:    For more elaborate style settings, you'll need to turn off simplification for the Apply 
button to do anything serious. When you apply with simplification on, only a simplified 
rendering is performed. Right-click on the background, choose Scene Properties, select the 
Rendering tab, and click to un-check the Allow simplification option.



 Question 19
Q:    When I exported an image of my scene, the left and right edges of the scene were cut 
off. How do I remedy this?
A:    The rule for exporting scenes is that the top-to-bottom view of the scene is preserved. 
Since your exported image size was narrower than your scene, the left and right edges got 
clipped. Either resize your scene or zoom out a bit and try again.



 Question 20
Q:    When I ray trace an object, my scene's background does not get reflected. Why?
A1:    The background image has no 3D location to it (for example, when you orbit the 
camera the background does not move), so ray tracing does not pick it up. If you want the 
background image to affect the scene, put the background image itself on a wall or slab and 
put this wall properly into your view.
A2:    You can “fake” the reflection of a background by attaching the image as a reflection 
map onto the reflective object using the Styles property sheet.



 Question 21
Q:    When I look through a translucent glass ray traced object, my scene's background 
image is not visible. Why?
A: The background image has no 3D location to it (for example, when you orbit the camera 
the background does not move), so ray tracing does not pick it up. If you want the 
background image to be seen through the translucent object, put the background image 
itself on a wall or slab and put this wall properly into your view.



 Question 22
Q:    I turned a spotlight on, but it does not appear to affect anything. What should I do?
A1:    Too simple a rendering may be the problem. Try turning on Realistic shading by right-
clicking on the scene background, selecting Scene Properties, choosing the Rendering tab, 
and clicking Realistic shading.
A2:    The spotlight may not be pointing at anything. Activate the Look At tool from the    
Camera toolbar and click on the spotlight in order to see the scene from the spotlight's 
current perspective (this also works for directional lights). Then, if necessary, use the TriBall 
to change the spotlight's direction.



 Question 23
Q:    I have tried the Walk Camera tool but my scene seems to quickly move beyond the 
scene's boundaries. How do I overcome this?
A:    The nature of the Walk Camera tool is to walk along a particular ground plane. So, 
wherever you start when you turn on this tool defines which way is up and what plane you'll 
move in. If you're looking at a room at about the height of a person, all your movements will 
keep you at that height (even if you use the Shift key to tilt your head up and down to view 
the environment). If you start from higher up, you'll act more like an airplane flying over the 
model. One quick way to get to ground level is to use the Look At Camera tool and click on a
wall at the height you'd like your camera to be.



 Question 24
Q:    The sensitivity of the Dolly Camera and Walk Camera tools are sometimes too sensitive 
or too sluggish. How can I adjust these?
A:    These tools use the distance from you to whatever you last Fit, Looked At, or Targeted 
with the Camera tools. So try doing a Target Camera on what is at the center of the scene 
and you should find the sensitivity more reasonable. In addition, the Walk Camera tool turns 
your head relative to the field of view. Use the Zoom Camera tool to zoom out to get a wider 
field of view and a faster turning motion.



 Question 25
Q:    I put texture on an object and it’s too bright, how do I make it darker?
A:    Turn down the diffuse mix in the Finish page of the Style Properties menu.



 Question 26
Q:    My embedded scene is not screen-aligned (i.e., the edges of the scene are not parallel 
to the edges of the page or screen). How do I make it screen-aligned?
A:    Right-click on the embedded scene to bring up the Embedded Scene Properties dialog 
box, select the Position tab, set "by this angle" in the Orientation section to 0, and click OK.



 Question 27
Q:    How do I abort print preview?
A:    Print preview may be aborted by pressing ESC. 
Q:    How do I stop printing quickly?
A:    Printing may be aborted most quickly by pressing ESC. This is faster than clicking on the 
'cancel' button.



 Question 28
Q:    What can I do if TriSpectives tells me it is unable to generate a sweep shape?
A1:    Reposition the sweep profile to be centered on the sweep path.
A2:    Make the sweep path less curved.
A3:    Reduce the size of the sweet profile.
Q:    What can I do if a sweep creates a shape with broken surfaces?
A:    Try modifying either the sweep profile or the sweep path slightly to resolve the problem.



 Question 29
Q:    If the cross-sections of a lofted shape are not connected as I expected, how do I change 
the connectivity?
A1:    You can edit the match points by right-clicking on the lofted shape while in IntelliShape 
mode and selecting the Edit Match Points command from the pop-up menu. However, you 
will be limited to moving the match points to locations of key points which already exist in 
the cross-section and which have been automatically generated by TriSpectives.
A2:    You can manually generate key points on lofting cross-sections by first right-clicking on 
the lofted shape while in IntelliShape mode and selecting the IntelliShape Properties 
command and the Cross-Section tab; change the cross-section matching option to manual. 
Then you can Edit Cross-Sections one by one to insert your own key points by splitting the 
curves at the desired locations. Finally, you can move the match points to your desired 
manual locations via the Edit Match Points command.



 Question 30
Q:    After modifying an IntelliShape model, the resulting model differs from what I expected. 
How can I modify the outcome?
A:    You can affect the order in which the component IntelliShapes are considered in the 
modeling process by using the Apply Last command. Right-click on an IntelliShape and 
select the Apply Last command to make the shape be the last one applied to the model. For 
instance, if you want all the material within a hole shape to be removed, just use the Apply 
Last command on the hole IntelliShape.



 Question 31
Q:    TriSpectives tells me that an “Improper Shape (was) Detected” during an IntelliShape 
model update. What should I do?
A:    One shape has been ignored but not deleted in the model update. Try a slight 
modification to the shape’s geometry or position to overcome this Boolean operation failure. 
You can use the WorkBook Browser to modify or delete the shape.



 Question 32
Q:    What can I do if modeling options    such as blending, tapering, chamfering, capping, 
shelling, etc. are not available for one of my lofting shapes?
A:    When TriSpectives detects that a lofted shape has inaccurate geometry, it disables all 
such modeling capability for that shape. Try modifying the lofting cross-sections or match 
points to construct a more accurate model.



 Question 33
Q:    What can I do if I encounter a failure in tapering the side faces of a sweep shape?
A1:    Try modifying the original sweep profile to avoid non-smooth Bezier curves.
A2:    Try reducing the sweep length if possible.
A3:    Reduce the taper angle.



 Question 34
Q:    What can I do in the rare event of failure of tapering or capping of the end section of a 
swept shape?
A1:    Try reducing taper angle or cap height.
A2:    Try modifying the sweep profile curve to make sure the side faces intersect with the 
tapering or capping surface.



 Question 35
Q:    What can I try when I encounter the occasional failure of shelling?
A1:    Try reducing the shelling thickness because a excessive guessed thickness on the first 
try of shelling often causes problems.
A2:    Try reducing the taper angle of any tapered sides.



 Question 36
Q:    How do I avoid the occasional blending failure?
A1:    Try to use an appropriate blending radius, especially avoiding too large a radius.
A2:    If failure occurs, try blending intersecting edges in a different sequence.

Q:    I created an edge blend, and it failed to generate. I created another one, and it created 
successfully. Whenever I modify the model, the system keeps telling me that a blend of 
selected edges failed even though the blend has been created successfully. What’s up?
A:    The first edge blend you attempted to create is still in your model. Creation of the 
second blend doesn’t replace the first one. You can use the WorkBook Browser to delete the 
first edge blend.



 Question 37
Q:    Since clicking anywhere in TriSpectives stops SmartRender, I cannot iconify TriSpectives 
without stopping SmartRender. How do I work in other applications while SmartRender is 
running?
A:    First, move TriSpectives so that the status bar is at the lower left corner of your screen. 
Then wait for SmartRender to start. You can now switch to the other application to work on 
it. The TriSpectives status bar will update as SmartRender runs. When SmartRender is 
complete, click on TriSpectives to see final image. Note: clicking anywhere on TriSpectives 
before    SmartRender has finished will abort SmartRender, and TriSpectives will then be 
ready for interactive use.



 Question 38
Q:    I specified blend all intersection edges to an IntelliShape, why does TriSpectives 
sometimes only blend some or none of the intersection edges?
A:    Specifying blend all intersection edges to an IntelliShape causes TriSpectives blends all 
intersection edges which are created when applying the IntelliShape to a model by Boolean 
operation. Intersection edges which are created when applying other shapes onto this 
IntelliShape are NOT blended by the blend-all-intersection option specified on this 
IntelliShape. Since TriSpectives rearranges the sequence of shapes during model 
modification, the order of the shapes may not be treated in the same order as how you 
created the model. However, once blends on intersections edges have been created, 
TriSpectives maintains the relative sequence between the shapes adjacent to the blends. 
Therefore, the blends won’t disappear.

 




